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		  Introduction	

1	 Introduction
Sartorius offers scalable freeze-thaw solutions using patented technologies 
for the handling, storage, and transport of biopharmaceuticals, including 
tools for process development, pilot scale operation, and commercial scale 
production. The benchtop system configurations are designed to reproduce 
the controlled freeze-thaw processes that occur in the large–volume, 
production-scale Celsius® and Cryovessel processes. Cryovessel is a 
stainless steel product line, and Celsius® is a single-use product line. Both 
systems use the Cryopilot A chiller and Cryomixer Jr. shaker.

1.1	 Cryovessel
The bench-scale system for Cryovessel is called the Cryowedge. The 
Cryowedge module duplicates a small section of the Cryovessel by 
matching the heat exchange surface geometry, freeze path length, and 
material of construction. 

Product volume requirements for feasibility studies can be further reduced 
by the use of the Cryocassette. These are 30 mL and 100 mL stainless steel 
containers that can be fitted into the Cryowedge in polymeric sleeves. 

1.2	 Celsius®

The bench-scale system for Celsius® is called the S3 Module; S3 stands 
for Scale-down, and Stability Studies. The S3 Module models the FT16 and 
FT100 Freeze-Thaw Modules by matching the freeze path length. 

The Celsius® S3 Benchtop System produces similar freeze-thaw times 
allowing for scalable freeze-thaw tests and stability studies. 

1.3	 References
Refer to the following documents for more information about the 
components of your benchtop freeze-thaw system:

	— Huber Unistat 705 Operating Instructions 
	— Huber Unistat 705 Electrical Schematics
	— Dow Syltherm HF Product Information
	— Dow Syltherm HF Material Safety Data Sheet (MSDS)
	— DuPont Suva 507 Material Safety Data Sheet (MSDS)
	— DuPont Suva 23 Material Safety Data Sheet (MSDS)

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   5_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   5 01.04.2022   09:52:1101.04.2022   09:52:11



6	 Operating Instructions Celsius® S3 Benchtop System

	 Safety

2	 Safety
Carefully follow all instructions to prevent serious injury or death to 
personnel and damage to equipment. Any use of the system components 
in applications for which they were not intended voids the units’ warranties 
and releases Sartorius Stedim Biotech from any and all liability.

The following symbols indicate important information:

 WARNING 
Potentially hazardous situations that, if not avoided, could result in death 
or serious injury.

 CAUTION
Potential for minor personnel safety hazards or of potential damage to 
equipment or property.

NOTE
Information that is important but not safety-related.

2.1	 General Precautions
	t Ensure that company safety policies are followed at all times. 
	t Disconnect power and follow proper lock-out|tag-out procedures 

when performing maintenance inside system components.
	t Do not stretch the Cryohoses in order to attach them to the chiller or the 

application. Instead, move the chiller or application in order to arrange 
the hoses in a relaxed position. Allow adequate slack to prevent kinks.

	t System components are heavy. Follow proper lifting and rigging 
techniques. 

2.2	 Heat Transfer Fluid
The system uses Dow Syltherm HF silicone heat transfer fluid (HTF). Do not 
use any other heat transfer fluid. 

There are several hazards associated with use of HTF:
	— Temperatures as low as –75°C and as high as 250°C can cause severe 

injury to skin, eyes, and other soft tissue. Use appropriate personal 
protective equipment when working with HTF or near exposed hot or 
cold equipment surfaces.

	— Syltherm HF has a closed-cup flash point of 63°C (145°F) per ASTM D92. 
According to NFPA and OSHA, it is classified as a Class IIIA combustible 
liquid. Follow proper handling and storage procedures.

	— Syltherm HF has a low surface tension and it can be difficult to avoid 
spills when filling or draining the system. Once spilled it is extremely 
slippery. Use absorbent material such as polypropylene pads to keep 
the bench and floor free of spilled HTF.

	— Waste HTF and absorbent must be disposed of as hazardous waste. 
Refer to the product information and MSDS for more information. 
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2.3	 Cryopilot A
Only qualified personnel may service the refrigeration equipment. The 
Cryopilot A uses R-507 and R-23, which are hydrofluorocarbon (HFC) 
refrigerants. These refrigerants are subject to environmental regulations 
and must not be vented to the atmosphere. 

	t Refer to the MSDS for more information.

2.4	 Cryomixer Jr.
	t During operation, keep hands clear of the top cover plate.
	t Do not exceed the maximum recommended agitation speed listed in the 

System Installation section.
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3	 System Components

3.1	 Cryopilot A
The Cryopilot A is a recirculating chiller that controls the temperature of a 
heat transfer fluid (HTF) to a temperature setpoint. 

A cascade refrigeration system cools the HTF when its actual temperature is 
above the temperature setpoint. The main components of the refrigeration 
system are a high temperature compressor, a low temperature compressor, 
a condenser, an automated expansion valve and an evaporator. The 
refrigerants used in the high and low stages are R23 and R507, respectively. 
The refrigerant condenser is air-cooled.

A pair of electrical resistance heaters heats the HTF when its actual tempe-
rature is below the temperature setpoint. A 1500 W large heater is used for 
large temperature changes and a 100 W fine heater is used for small tempe-
rature changes. This dual heater arrangement provides for precise control of 
HTF supply temperature.

A variable speed pump circulates the HTF through the evaporator, the hea-
ters and the external application. For Cryowedge applications, the HTF 
flows through the jacket and the core heat exchanger area. For S³ Module 
applications, the HTF flows through the walls adjacent to the Celsius® Pak 
clamps. An expansion reservoir simplifies priming the system and allows for 
HTF expansion and contraction.

The Cryopilot A is microprocessor controlled. The controller user interface 
has several pushbuttons, a rotary encoder, an LCD display with touch 
screen, and a system diagram with status LEDs. 

The following are key specifications for the Cryopilot A:

Electrical Power Supply

NOTE: The Cryopilot A is delivered without a plug. Due to the variation in 
local electrical receptacles, the customer must supply the plug.

North America 208 VAC, 60 Hz, 1~, 20 A

Europe 230 VAC, 50 Hz, 1~, 15.6 A

Fluid Temperature Range -75°C to 250°C 

Dimensions (W x D x H) 425 x 400 x 720 mm
(16.7” x 15.7” x 28.3”)

Weight 90 kg (198 lbs)
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3.2	 Computer
The Cryopilot A is controlled and monitored using Cryopilot software on 
a computer. The Cryopilot software controls and monitors the benchtop 
system components including chiller, mixer, and thermocouples. See 
Chapter „5 Cryopilot Software“, page 20 for minimum system 
requirements and additional information. 

Computers purchased from Sartorius as part of a benchtop system have the 
following specifications:

	— Laptop form factor
	— Operating System: Microsoft Windows 10 Professional, 64-bit
	— Microsoft Excel
	— Adobe Acrobat
	— Cryopilot software pre-installed

3.3	 Cryowedge Module
Cryowedge module names correspond to the volume of production scale 
Cryovessels. For example, a Cryowedge 125 (20”) is meant to simulate a 
125L Cryovessel. 

Working volume 350 – 4000 mL, depending on the size 
of the Cryowedge.

Materials of construction

Body 316L stainless steel

Gaskets silicone

Cover transparent polycarbonate

Connections HTF in, HTF out with quick-disconnect 
couplings

Weight, empty

Cryowedge 20 (12”) 15 kg (32 lbs)

Cryowedge 125 (20”) 21 kg (46 lbs)

Cryowedge 300 (30”) 44 kg (97 lbs)

Cryowedge 300 (34”) 49 kg (108 lbs)

Size equivalence

Cryowedge 20 (12”) Cryovessel 20 L – 40 L

Cryowedge 125 (20”) Cryovessel 60 L – 150 L

�Cryowedge 300 (30”) Cryovessel 200 L – 300 L

Cryowedge 300 (34”) Cryovessel 300 L
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3.4	 Cryocassette
The Cryocassette minimizes the amount of product used within the 
Cryowedge. The Cryowedge can then be filled with buffer while the 
Cryocassette is filled with product. The design of the Cryocassette 
maintains the freezing and thawing characteristics of the Cryowedge to 
ensure scalability to the production Cryovessels. The Cryocassette also 
serves as a scalable stability container. 

Working volume 	— 10 – 100 mL, depending on the size of 
the cassette

	— Available in 30 mL and 100 mL sizes

Materials of construction

Body 316L stainless steel

Boat 	— polypropylene (30 mL) or 
	— polyethylene (100 mL)

Sterilization Customer autoclavable

Finish 10 µ-in Ra, EP

3.5	 Celsius® S³ Module
The Celsius® S³ Module provides the capability to model Celsius® FT100 and 
FT16 systems with as little as 20 mL of product. The configuration of the 
heat transfer surfaces within the module provide the same bi-directional 
heat flux as seen in the FT100 system utilizing frame and Celsius® Pak 
designs. 

Capacity 1 – 10 product samples

Working volume 20 mL to 1 L, depending on size of 
Celsius® Paks

Materials of construction

Shell 302-304 stainless steel Shell

Base 6061-T6 aluminum

Shell frame cover 5052 aluminum

End plates Rigid PVC foam sheet

Internal shell insulation Silicone foam rubber

HTF connection end cover Delrin

Cover Transparent PVC

HTF piping maximum design 
pressure

4.1 barg (60 psig)

Connections HTF in, HTF out with installed quick-
disconnect couplings; drain

Weight Approximately 18 kg (40 lbs)

Fig. 1:  Stainless Steel Cryocassettes

Fig. 2:  Celsius® S³ Module

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   10_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   10 01.04.2022   09:52:1201.04.2022   09:52:12



		  Operating Instructions Celsius® S3 Benchtop System	 11

		  System Components	

3.6	 Celsius® Paks
All Celsius® Paks, regardless of size, have the same material of construction 
and the same freeze and thaw path length as shown in Figure 3. 

Since Celsius® Paks are single-use, the need for cleaning is eliminated.

	— Available in 30 mL and 100 mL sizes
	— Ready to use, single-use collapsible container
	— Pre-sterilized (25 – 45 kGy gamma radiation)
	— RF sealing compatible
	— Designed to allow for sterile temperature measurement
	— Celsius® Paks overwrap pouches are available. The use of an overwrap is 

recommended when conducting studies at higher temperatures (room 
temperature and above).

Materials of Construction (30 mL and 100 mL Celsius® Pak)

Product contact layer EVAM (ethylene vinyl acetate copolymer, 
monomaterial)

Gas and moisture 
barrier layer

EVA | EVOH | EVA

External robust, 
handling layer

EVA

Fill and drain ports EVA

Extension tubing C-Flex®*

LuerLock® Polycarbonate or Polypropylene (C-Flex® 
option)

Double barb elbow or union Polypropylene (C-Flex® option)

�Thermowell Pt-cured silicone

3.7	 Cryomixer Jr.
The Cryomixer Jr. is a reciprocating mixer that is positioned below the Cryo-
wedge or S³ Module in order to ensure homogeneity of the thawed product. 
The reciprocating motion starts automatically when activated by the 
Cryopilot software. The Cryomixer Jr. is used for both Cryowedge and 
S³ Module agitation applications. 

Specifications

Stroke 1” (25 mm), reciprocating

Electrical Power Supply

North America 115 V, 60 Hz, 1~

Europe 230 V, 50 Hz, 1~

Dimensions (W x D x H) 505 x 585 x 120 mm (20” x 23” x 5”)

Weight 24 kg (52 lbs)

* �C-Flex® is a registered trademark of Saint-Gobain Performance 
Plastics Corporation.

Fig. 3:  Comparison Between 30 mL and 16.6 L 
Celsius® Paks

Frozen 16.6 L 
Celsius® Pak

8.4 cm
8.4 cm

Fig. 4:  Cryomixer Jr.
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3.8	 Cryohose
All systems use two Cryohoses for the supply and return of HTF from the 
Cryopilot A unit. These hoses are stainless steel with surrounding insulation.

3.9	 Cryowrap
Cryowrap is a neoprene sleeve that, when wrapped around Cryohose 
connections, prevents frost build up during Cryowedge or S³ module 
freezing. 

3.10	 Data Acquisition Device
The data acquisition device is compact module used to digitize thermocouple 
signals for monitoring by the computer. The data acquisition device has 
a breakout cable with receptacles for up to 16 T-type thermocouples.
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4	 System Installation
This chapter will guide you through the setup of the benchtop system.

4.1	 Tools | Equipment Required for Installation
The following tools are needed to set up the Benchtop Freeze-Thaw 
System:

	— Assortment of cross head and flat head screw drivers
	— Vise grip wrench with a minimum 6” (15 cm) handle
	— Assortment of box or crescent wrenches
	— Absorbent material such as polypropylene pads for cleaning up any 

spilled HTF
	— Multimeter suitable for measurement of supply voltage

4.2	 System Component Inventory
When all the equipment containers are unpacked, confirm that the 
following parts are available for installation:

	— Cryopilot A
	— Cryowedge or S³ Module
	— Cryomixer Jr.
	— (2) Cryohoses
	— (4) Cryowraps
	— T-Type thermocouples (up to 10 depending on system)
	— USB to Cryomixer Jr. cable
	— Computer with Cryopilot Software 
	— National Instruments USB-9213 data acquisition device
	— USB to Unistat cable
	— Dow Syltherm HF heat transfer fluid (~19 L or 5 gallons)
	— Safety Siphon
	— Cryowedge insulated cover (Cryowedge only)
	— Three Cryocassettes (Cryowedge only)
	— (10) Celsius® Paks (S³ Module only)
	— (10) Thermocouple holders (S³ Module only)
	— Clamp release tool (S³ Module only)
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4.3	 Selecting a Location
Install the system on dry, level surface such as a lab bench or table that sup-
ports a total weight of ~400 lbs (~180 kg). The space required for a typical 
benchtop system is approximately 188 cm (74”) wide by 76 cm (30”) deep. 
See Figure 5 for proper arrangement and required clearance. The Cryopilot 
A is air-cooled and requires adequate ventilation. Since the Cryomixer Jr. 
oscillates back and forth, avoid use of wheeled carts.

8 cm min. clearance

15
 c

m
 m

in
.

cl
ea

ra
nc

e

S3 Module or
Cryowedge 

Cryomixer Jr.

Cryopilot A

Laptop 
computer

Required depth 76 cm (ref)

188 cm (ref)

71
 c

m

Data 
acquisition
device 

46 cm min.

Fig. 5:  Space Requirements

4.4	 Cryowedge and Cryohose Installation

 CAUTION
Do not stretch or kink the Cryohoses in order to attach them to the Cryo-
wedge. This may cause leaking. Allow adequate slack.

 CAUTION
Apply adequate counter torque when tightening the Cryopilot A union 
fittings in order to avoid damage to the piping inside.

	t Place the Cryowedge in the insulated cover provided, making sure that 
the heat transfer fluid (HTF) inlet and outlet connections are exposed.

	t Place the insulated Cryowedge on top of the Cryomixer Jr. Position the 
Cryowedge such that the motion of the Cryomixer Jr. will allow for mixing 
along the length of a Cryocassette or from the point of the Cryowedge 
(equivalent to the position of the core heat exchanger of a Cryovessel) 
to the outer wall (equivalent to the position of the jacket of a Cryovessel).

	t Slide two Cryowraps onto each hose. 
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NOTE 
The quick disconnects are factory assembled onto the adapters and hoses. 
If it becomes necessary to break and then remake connections having 
tapered threaded fittings, use a thread sealant such as Loctite 567.

Cryowedge Cryopilot A

_” sanitary flange* 

Mx 1 union16

Female ⅜” 
quick 
disconnect

Male ⅜”
quick 
disconnect

Adapter*

Insulated hose
1.5 m

M24x 1.5 union

Adapter

M16x 1 union

Adapter

Fig. 6:  Cryohose Installation for Cryowedge

	t Connect the port labeled “Thermofluid out” on the Cryopilot A to the 
inlet port of the Cryowedge as shown in Figure 6. The inlet port on the 
Cryowedge is on the outer wall, which is equivalent to the position of the 
jacket on a Cryovessel.

	t Connect the port labeled “Thermofluid in” on the Cryopilot A to the 
outlet port of the Cryowedge as shown in Figure 6. The outlet port on 
the Cryowedge is at the point, which is equivalent to the position of 
the core heat exchanger on a Cryovessel.

	t Verify that all hoses are connected properly.

4.5	 S³ Module and Cryohose Installation
 

 CAUTION 
Do not stretch or kink the Cryohoses in order to attach them to the S³ Module. 
This may cause leaking. Allow adequate slack.

 CAUTION
Apply adequate counter torque when tightening the Cryopilot A union 
fittings in order to avoid damage to the piping inside.
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	t Place the S³ Module on top of the Cryomixer Jr. as shown in Figure 7 so 
that the motion of the Cryomixer Jr. will allow for mixing along the length 
of a Celsius® Pak.

Pos. Description

1 Outlet Port

2 Inlet Port

3 Mounting Knobs

	t Secure the S³ Module to the Cryomixer Jr. plate by tightening the four 
mounting knobs at the bottom of the module. 

	t Slide two Cryowraps onto each hose.

NOTE
The quick disconnects are factory assembled onto the S³ and hoses. If it 
becomes necessary to break and then remake connections having tapered 
threaded fittings, use a thread sealant such as Loctite 567.

S3 Module Cryopilot A

Adapter M16x 1 union

M24x 1.5 unionM16x 1 union

Female ⅜” 
quick 
disconnect

Male ⅜”
quick 
disconnect

Insulated hose
1.5 m

Adapter

Fig. 8:  Cryohose Installation for S³ Module

	t Connect the port labeled “Thermofluid out” on the Cryopilot A to the 
inlet port of the S³ Module. The inlet port is the lower of the two quick-
disconnect ports on the S³. 

	t Connect the port labeled “Thermofluid in” on the Cryopilot A to the 
outlet port of the S³ Module. The outlet port is the upper of the two 
quick-disconnect ports on the S³.

	t Verify that all hoses are connected properly.

1
2

3

Fig. 7:  S³ Module Positioning
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4.6	 Cryopilot A Setup

 WARNING
All wiring should be performed by a qualified electrician.

	t Ensure that the main Cryopilot A power switch is in the “OFF” or “0” 
position. The switch is red and yellow and is located on the back of the 
Cryopilot A as shown in Figure 9. 

	t Have a qualified electrician install a plug (not provided) on the power 
cord of the Cryopilot A. The plug must match the receptacle and must 
be rated for the line voltage and current. Refer to Chapter „3 System 
Components“, page 8 for electrical supply specifications.

	t Plug the Cryopilot A unit into the electrical supply. 
	t Turn the main Cryopilot A power switch to the “ON” position.
	t Verify that all LEDs light momentarily, and that the rectangular LCD 

display is illuminated. If not, verify that power is available to the Cryopilot 
A unit. If power is available to the Cryopilot A unit, but the controller 
does not come on, please contact Customer Service (see page 45). 

4.7	 Heat Transfer Fluid Fill
It is recommended that about 19 L (5 gallons) of HTF are on hand for the 
setup of the benchtop system. Dow Syltherm HF is used as a heat transfer 
fluid because of its low freezing point and low viscosity over a wide 
temperature range. For additional information, refer to the Dow Syltherm 
HF Material Safety Data Sheet.

NOTE 
Dow Syltherm HF is the only approved heat transfer fluid for use in this system.

	t Ensure that the drain valve is closed by turning clockwise to the vertical 
position and closing the lower sealing screw on the side of the 
Cryopilot A as shown in Figure 10.

Fig. 9:  Cryopilot A Main Power Switch
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1 2 3

Fig. 10:  Cryopilot A HTF Drain Valve and Sealing Screws

Pos. Description

1 Main drain port sealing screw HTF Drain Valve

2 HTF Drain Valve

3 Sight glass Drain sealing screw HTF Drain Valve

	t Remove the fill port cap located on top of the Cryopilot A, behind the 
sight glass. 

	t Elevate the container of Syltherm HF above the Cryopilot A.
	t Insert the tube end of the Safety Siphon into the Cryopilot A and the 

valve end into the container of Syltherm HF. Submerge the red valve end 
in the Syltherm HF and wiggle it up and down to start the siphon. To stop 
the flow of HTF, lift the red valve end out of the Syltherm HF. Fill the 
Cryopilot A unit to the 2L mark on the sight glass. 

	t Start a manual air purge (press Start, Start air purge, 30s interval, OK). 
Add more HTF as needed so that the sight glass level stabilizes at 2L. 

	t Verify that there are no leaks in the hose connections.
	t Stop the pump (press Stop, Air purge off).
	t Secure the Cryowraps over the exposed metal surfaces at each end of 

the two hoses.

4.8	 Cryomixer Jr. Setup
	t Plug the Cryomixer Jr. into the electrical supply.
	t Set the manual operation knob on the front of the Cryomixer Jr. to the 

“O” position.
	t Place the Manual | Automatic switch on the back of the Cryomixer Jr. to 

the manual position (down) as shown in Figure 11.
	t Turn the speed knob to the fully counterclockwise (0 RPM) position.
	t Turn the manual operation knob to the “I” position.
	t Slowly turn the speed knob in the clockwise direction until the proper 

RPM is achieved and record displayed RPM as read on the LCD display 
on the Cryomixer Jr. The standard settings are listed below:

	— CW20 and CW125 Cryowedges: 45 RPM
	— CW300 (30”) and CW300 (34”) Cryowedges: 35 RPM
	— S³ Module: 120 RPM

Fig. 11:  Rear of Cryomixer Jr.
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NOTE 
Mixer speed settings may vary according to customer product 
characterization. Contact Sartorius to discuss variations from the above 
recommendations.

	t Place the Manual | Automatic switch on the back of the Cryomixer Jr. to 
the automatic position (up).

4.9	 Computer Setup
	t Plug the computer and display into the electrical supply. It is 

recommended that you use a surge protector (not included).
	t Turn on the computer and display. Answer the questions in the Windows 

“first boot” setup dialogs. It may be necessary to obtain some information 
from your Information Technology (IT) department. 

 CAUTION
Computers supplied by Sartorius do not have antivirus software installed. It 
is recommended that you install antivirus software according to your 
company’s policy.

4.10	 Data Acquisition Setup
	t Connect the National Instruments USB-9213 to the computer with a 

USB cable.
	t Connect one end of the USB to Cryomixer Jr. cable to the receptacle at 

the rear of the Cryomixer Jr. Plug the other end into a USB port on the 
computer.

	t For S³ Modules, plug the bundle of male thermocouple connectors 
extending from the S³ Module into the thermocouple breakout cable. 
Plug connector 1 into receptacle 1, connector 2 into receptacle 2, and 
so on. Plug the Celsius® Pak thermocouples into the receptacle strip 
located within the S³ hood enclosure area. 

	t Connect one end of the USB to Unistat cable to a USB port on the 
computer and the other end to the serial port on the underside of the 
ComBox as shown in Figure 12. The ComBox is located at the rear of 
the Cryopilot A. 

Fig. 12:  Cryopilot A Serial Port
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5	 Cryopilot Software

5.1	 Overview
The benchtop system is controlled and monitored by Cryopilot software, 
which is a graphical application for computers with Microsoft Windows. The 
Cryopilot software provides users with flexible execution of freeze and thaw 
operations.

The following diagram illustrates the relationships between system 
components. The Cryopilot software interfaces with the Cryopilot A chiller 
and the Cryomixer Jr. shaker via USB, and with up to 16 thermocouples 
through a National Instruments data acquisition device.  

Fig. 13:  Cryopilot System

5.2	 System Requirements
Cryopilot software is factory-installed on computers ordered from Sartorius 
as part of a benchtop system. Alternately it is available on USB flash drive for 
systems that meet the following requirements: 

	— Operating System: Microsoft Windows 7 Professional, 32 bit with Service 
Pack 1 or Microsoft Windows 10 Professional, 64 bit. 

	— Data Acquisition Device: National Instruments USB-9213.  

Cryopilot software is packaged with an installer that will automatically install 
the Cryopilot software and all required third-party drivers on your computer. 
You must have administrative privileges to install Cryopilot. 
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5.3	 Components
By default, Cryopilot software is installed in C:\Program Files\Sartorius 
Stedim Biotech\Cryopilot 5 for 32-bit operating systems and in C:\Program 
Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 for 64-bit operating 
systems. This will hereafter be called the installation directory. The following 
is a description of the files and folders contained in the installation directory:

Component Description

Profiles/ Directory for standard profile files 
supplied with Cryopilot .

BouncyCastle.Crypto.dll Support library

Cryopilot.chm Help file

Cryopilot.exe The executable for Cryopilot software. 
Shortcuts to this file are placed on the 
desktop and in the Start menu.

Cryopilot.exe.config Settings file

ICSharpCode.SharpZipLib.dll Support library

libftdi.dll Support library

log4net.dll Support library

NationalInstruments.Common.dll Support library

Add NationalInstruments.
NiLmClientDLL.dll 

Support library

Add NationalInstruments.
MStudioCLM.dll 

Support library

NationalInstruments.DAQmx.dll Support library

NPlot.dll Support library

unins000.dat Uninstaller support file

unins000.exe Uninstaller

In addition to the files in the installation directory, the Cryopilot installer 
creates a folder named Cryopilot in each user’s My Documents folder. This 
will hereafter be called the user directory. The following is a description of 
the files and folders contained in the user directory:

Component Description

Data/ �Default directory for data files saved by users. 
Users may opt to store files elsewhere on the computer 
or on a network drive.

Custom 
Profiles/

�Default directory for custom profiles saved by users. 
Users may opt to store files elsewhere on the computer 
or on a network drive.

Files that are subject to change but common to all users are stored in 
C:\ProgramData\Sartorius Stedim Biotech\Cryopilot 5. 

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   21_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   21 01.04.2022   09:52:1501.04.2022   09:52:15



22	 Operating Instructions Celsius® S3 Benchtop System

	 Cryopilot Software

Component Description

log.txt File used for troubleshooting software

settings.xml Settings file

The Cryopilot installer also installs several additional libraries: Microsoft 
.NET Framework 4.6.1, National Instruments NI-DAQmx, and USB drivers. 

5.4	 Installation
To install Cryopilot software, insert the USB flash drive and double-click on 
mysetup.exe.  Setup requires administrative privileges; contact your system 
administrator if you do not have sufficient privileges.

The default settings are generally adequate.  

Once the setup process is complete, you will be prompted to restart your 
computer.

NOTE
It is critical that the computer be configured so that it does not suspend or 
power down while a freeze|thaw process is running.  

For Windows 7 or Windows 10, go to Control Panel > System and Security > 
Power Options. Select High performance profile. Click Change plan settings, 
then Change advanced power settings.  Set Hard disk > Turn off hard disk 
after to 0 (never). Set USB settings > USB selective suspend setting to 
Disabled. Click OK, then close the Control Panel window. 
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5.5	 User Interface

5.5.1	 Main Window
The main window is the primary screen used in the Cryopilot software. This 
window contains menu items to interact with the program, a chart to graphically 
display process data, and a legend to select the traces to display on the chart.

6

1
2
3

4

5

7

8

9

Fig. 14:  Main Window

Pos. Control Description

1 Title bar Displays the name of the application and 
the name of the current data file, if any

2 Menu bar Contains menus for performing common 
tasks

3 Toolbar Contains buttons for performing common 
tasks

4 Chart Displays a plot of temperature vs. elapsed 
time

5 Status bar Shows the status of the equipment as 
Online or Offline

6 �Elapsed time indicator Shows how much time has elapsed since 
the process started

7 HTF Setpoint legend 
item

Displays the heat transfer fluid (HTF) 
setpoint

8 HTF Supply legend item Displays the actual HTF temperature

9 Product N legend item Displays the temperature of the Nth 
type T thermocouple.
Up to 16 thermocouples may be 
monitored, depending  on hardware.
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5.5.2	 Start Process Dialog
The Start Process dialog prompts the user for information that will be used 
during the process.
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7

8

9

1011

Fig. 15:  Start Process Dialog

Pos. Control Description

1 Chart title �The title shown at the top of the chart. The 
default is “Temperature vs. Elapsed Time”.

2 Data filename �The complete file name where data for this 
process will be saved. The default is [User 
Directory]\Data\[date code].cpd, where [date 
code] is a numeric string composed of year, 
month, day, hour, minute, second. 

3 Profile type 
selector

�Gives three options: None, for no profile; 
Standard, for a Sartorius supplied standard 
profile, or Custom, for a user-supplied profile. 

4 Profile filename The complete file name where the custom 
profile can be found

5 Description A field for entry of additional information about 
the process.

6 Data filename 
selector

Opens a dialog to select a folder and filename 
where the data for this process will be saved.
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Pos. Control Description

7 Application 
selector

Gives six options when Standard profile type is 
selected: 

	— S³ 30mL – for S³ systems with ten 30mL 
Celsius® Paks

	— S³ 100mL – for S³ systems with ten 100mL 
Celsius® Paks

	— Cryowedge 12” 
	— Cryowedge 24” 
	— Cryowedge 30”
	— Cryowedge 34”

8 Process selector Gives three options when Standard profile type 
is selected:

	— Freeze – performs freeze only
	— Thaw – performs thaw only
	— Freeze and Thaw – performs freeze followed 

by thaw

9 Profile filename 
selector

Opens a dialog to select a folder and filename 
where the custom profile can be found.

10 Cancel button Ignores the information and closes the dialog 
without starting the process.

11 OK button Accepts the information, closes the dialog, and 
starts the process.
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5.5.3	 Options Dialog
Cryopilot software may be configured using the Cryopilot Configuration 
dialog. From the main window, select the Tools > Options menu item.

1

6532 4

7

Fig. 16:  Options Dialog – Certificate Tab

Pos. Control Description

1 Certificates list �Displays a list of available digital certificates. 
For each certificate the list shows who issued 
the certificate, to whom the certificate was 
issued, the friendly name, and the expiration 
date.

2 Create button �Creates a new self-signed certificate and installs 
it in the Trusted Root Certification Authorities 
folder. 

3 View button Views additional details for the selected 
certificate.

4 Manage button �Opens the Microsoft Management Console for 
additional certificate management tasks such as 
certificate renewal and deletion.

5 OK button Accepts the changes and closes the dialog.

6 Cancel button Discards the changes and closes the dialog.

7 Hardware tab Switches to the hardware tab.
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1

65

7

2

3

4

Fig. 17:  Options Dialog – Hardware Tab

Pos. Control Description

1 Data acquisition 
device selector

The “None” option configures the application 
for no data acquisition. If a compatible National 
Instruments data acquisition device is 
detected, it will be automatically selected.

2 Chiller selector �Selecting the “None” option configures the 
application for no chiller. Selecting the “Huber 
Unistat” option configures the application to 
collect data from a Huber chiller equipped with 
a Unistat controller, such as a Cryopilot A.

3 COM port selector Shows a list of available serial (COM) ports.

4 Shaker selector �The “None” option configures the application 
for no shaker. If a USB to Cryomixer Jr. cable is 
detected, it will be automatically selected.

5 OK button Accepts the changes and closes the dialog.

6 Cancel button Discards the changes and closes the dialog.

7 Certificates tab Switches to the Certificates tab.
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5.6	 Getting Started
Before a profile can be started the software must be configured. Make sure 
that the data acquisition device (DAQ) and chiller are connected and 
powered up. Then select the Tools > Options menu item to display the 
Options dialog.

5.6.1	 Selecting a Digital Certificate
First, a digital certificate must be selected. Cryopilot uses a digital certificate 
to guarantee the authenticity and integrity of saved data files. The Certifica-
tes tab shows a list of available certificates. It is ideal to use a certificate 
issued by a trusted certification authority (CA). If your information techno-
logy (IT) organization already has a digital certificate infrastructure establis-
hed then they may be able to provide a certificate for use with Cryopilot. 

In the event that you do not have a certificate to use with Cryopilot, you can 
create what is known as a self-signed certificate. “Self-signed” means that 
the person who creates the certificate also vouches for its legitimacy. For 
Click the Create button, and then click the Yes button on the dialog that 
appears. The newly created certificate will be shown in the list of available 
certificates.

5.6.2	 Configuring Hardware
Next, the hardware must be selected. The Hardware tab contains settings 
for common hardware configurations. The most common arrangement 
consists of a data acquisition device (DAQ), a chiller, and a shaker. In most 
cases the hardware will be detected automatically.

If you will not be running any processes and will only be using Cryopilot to 
review data files, then select “None” for all Data Acquisition, Chiller, and 
Shaker.

To save the options, click OK. 

5.6.3	 Program Flow
When Cryopilot software is launched, a splash screen appears briefly and 
then the main window is displayed. 

At this point the software is idle and will not do anything until the user starts 
a process. 

To start a process, select the Process > Start menu item or click the Start 
Process button on the toolbar. The Start Process dialog will be displayed. 
Once the user clicks OK, the software attempts to connect to the data 
acquisition device, the shaker, and the chiller, if configured. If any of these 
devices is configured but not connected then the user is prompted to check 
connections and retry or cancel.

Once a process is started, the temperature chart and the legend are recon-
figured to display the appropriate plots, communications are established 
with the chiller, and the data acquisition device (DAQ) is initialized. Once in-
itialization is complete, the initialization message disappears and first set of 
data points is plotted. Subsequent data points are displayed at the sampling 
interval, which is fixed at 15 seconds.
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When configured to use a chiller, the Cryopilot software uses a serial link to 
send commands to and receive responses from the chiller. 

During a process, the connection status is displayed in the lower left corner 
of the main window. A green “Online” message indicates a good connection 
with the data acquisition device and the chiller. A red “Offline” message in-
dicates that something is wrong with the connection. 

The Stop Process button ends data acquisition and turns off the chiller and 
mixer. The user may then review the data. The data file must be closed befo-
re the user can start another process.

5.6.4	 Reviewing Data
Cryopilot can open and display files saved in Cryopilot 4 and Cryopilot 5. 
Note that files created by Cryopilot 4 are supported for review purposes 
only. All new data files are saved in Cryopilot 5 format so that data integrity 
and authenticity can be verified via digital signature.

Only one data file can be open at a time.

To open a data file, do one of the following:
	t Click the Open button on the toolbar
	t Open the File menu and click Open
	t Use the keyboard shortcut Ctrl+O

Using the Open Data File dialog, select the file you wish to open. Be sure to 
select the type of file in the “Files of type” dropdown. 

Cryopilot 5 uses digital signatures to prove that the data has not been 
modified since it was originally saved. If the integrity and authenticity of the 
data file cannot be verified by means of a digital signature then you will be 
notified and prompted to continue or cancel. There are two common cases 
where this notification will appear:

	— When opening a Cryopilot 4 data file. Cryopilot 4 files do not contain a 
digital signature.

	— If the certificate used to sign the data file is not trusted. 

Once the data file is loaded, the chart will be populated with the data from 
the data file, and the data on the chart can be explored just as if the data 
was coming from a live process.

By right-clicking on the chart and clicking on the Review item, you can scroll 
right and left on the chart and verify the values for each trace at a given 
point in time. As the review line is scrolled right or left, the legend is updated 
to show the timestamp and trace values for that point in time.
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5.6.5	 Using the Chart
The chart is a graphical display of temperature vs. elapsed time for a run. 
Elapsed time is displayed on the X axis in units of hours and temperature is 
displayed on the Y axis in units of degrees C. A legend is provided to identify 
and show the current value for each plot. 

Panning and Zooming

By default, chart scales are automatically adjusted to fit the available data. 
This auto-scaling feature may be turned on or off using the Auto Sscale item 
X and Autoscale Y options on the pop-up menu obtained by right-clicking 
on the chart. 

The scale extents can be changed directly by dragging the X and Y axes. The 
chart display can be panned by dragging the chart with the left mouse button 
held down. When changing scale or panning the chart, Auto Scale will be 
turned off. Double-click the chart to turn Auto Scale back on.

Legend

The legend identifies each of the plots on the chart.  Each plot has a legend 
item showing its name, color, units, and current value. To hide a plot, 
double-click its legend item; it will appear dimmed. To show the plot, 
double-click the legend item again. This can be useful when trying to look 
at data files with many plots lying on top of each other.

Review Mode

Review mode allows the user to review data at any point during the process. 
Review mode is turned on and off using the pop-up menu shown in 
Figure 18. When in review mode, a vertical line is displayed on the chart, and 
the elapsed time and legend items display values that correspond to that 
location on the chart. 

5.6.6	 Exporting Data
Cryopilot provides two different methods to export data. It can export an 
image of the current chart view or it can export raw data for viewing in a 
spreadsheet application.

Export Chart

To export the chart, select the Edit > Copy > Chart menu item. The chart is 
copied to the Windows clipboard as a bitmap image. The chart may be 
pasted to other applications by selecting Edit>Paste or pressing Ctrl+V. This 
option is useful where a quick snapshot of the data is needed, for example in 
a slide presentation. Use the Copy>Data option if the data must be further 
analyzed.

Fig. 18:  Chart Pop-up Menu
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Export Data

To export the data, select the Edit > Copy > Data menu item. The raw data is 
copied to the Windows clipboard in tab-delimited format. The data may be 
pasted to spreadsheet applications such as Microsoft Excel or OpenOffice 
Calc by selecting the destination cell and selecting Edit>Paste or pressing 
Ctrl+V.

5.6.7	 Printing
Cryopilot can create a report for the open data file. The report is a snapshot 
of the current chart view including the title and legend. The report may be 
previewed on-screen or sent to a printer. If you have a PDF print driver such 
as Adobe Acrobat installed on your computer, you can save the report to a 
PDF file on disk.

To print a report, do one of the following:
	t Click the Print button on the toolbar 
	t Open the File menu and click Print
	t Use the keyboard shortcut Ctrl+P.

The Print dialog will appear, prompting you to select the destination printer 
and the number of copies. Other settings such as margins and paper size 
may be set in Page Setup. Click OK to send the report to the selected 
printer.

5.6.8	 Profiles
Cryopilot software controls the chiller and the mixer by following a profile. 
A profile is a recipe with instructions to change the chiller temperature 
setpoint and the mixer mode setpoint (on|off) as a function of time. 
Cryopilot software is supplied with a set of standard profiles that are suitable 
for many S³ Module and Cryowedge applications. 

It may be necessary to create a new profile to suit a specific application. 
When designing a new profile, there are several factors to consider:

	— Which operations are to be performed – freeze, thaw, or both?
	— Are multiple freeze and thaw cycles required?
	— What is the initial temperature of the material to be frozen or thawed? 

If this is variable, an equilibration step at the beginning of the profile can 
improve reproducibility.

	— Should the equipment remain running or turn off after the freeze or thaw 
is complete?

Adjustment of the freeze and thaw rates is performed empirically. If a lower 
endpoint is desired for a freeze, it may be necessary to increase the duration 
of the final setpoint or reduce the the temperature adjusted. When trying to 
thaw quickly without overshoot, use a high temperature setpoint for a short 
duration and then lower the temperature setpoint before the target 
temperature is exceeded.
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Profile Editing

Profiles may be created and edited manually with text editors (e.g. Microsoft 
Notepad) or spreadsheet programs (e.g. Microsoft Excel). When using a text 
editor, always use the tab key to separate columns; do not use the space 
key. For a new line, use the Return or Enter key after entering the status for 
the Mixer.

If you use a standard profile as a starting point, be sure to save it with a new 
file name and then make changes. 

Last Step Behavior

By default, once the Cryopilot software executes the last step of a profile it 
will leave the chiller and mixer as-is until the user stops the profile by pressing 
the STOP button. In some cases it is useful to turn the chiller and mixer off 
at a certain elapsed time. This is down by placing a TURN CHILLER OFF 
instruction after the STOP instruction. Note that this cannot be done using 
the Cryopilot profile editor; it must be done manually with a text editor or 
spreadsheet application. For example, the following profile will turn the 
chiller and mixer off at 311 minutes: 

0	 –40	 OFF
310.00	 –60	 OFF
STOP
311.00	 TURN CHILLER OFF

The TURN CHILLER OFF instruction will be visible in the Cryopilot profile 
editor, but will have no temperature associated with it.

File Format

Profiles are stored on disk as tab-delimited data files. The character enco-
ding is ASCII and the file format is case-insensitive. All lines found before 
the START token are a description of the file. This means that the descripti-
on cannot contain the word “start”. Between the START token and the opti-
onal STOP token, each line represents a step in the profile. The start time 
identifies when the step should start; it has units of elapsed minutes and is 
expressed in decimal notation. The start time of the first step must be 0, and 
start times for successive steps must increase monotonically. Note that the 
start time for each step references the profile start time, so three 30-minute 
steps would have start times of 0, 30, and 60. The chiller setpoint has units 
of °C and is expressed in decimal notation. If a STOP token is present, the 
next line may be a TURN CHILLER OFF token. 

Fig. 19:  A profile in Microsoft Notepad.
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The following syntax is used to describe the file format:
\n	� Newline character, here defined as CRLF
\s	� Zero or more whitespace characters
\t	 Tab character
<variable>	 Variable element
[FOO]	 Optional element
OFF|ON	� Enumerated value, element must be one or the other
...	� Indicates repeating structure

Format:
[<description>\n]
START\s\n
<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n
.
.
.
[STOP\n
[<start time>\tTURN CHILLER OFF]]

Example (implied \n):
This is a test profile with three steps.
START
0	 –20	 OFF
30	 –60	 ON
200	 10	 OFF

5.6.9	 Data Files
During a run, the Cryopilot software monitors the benchtop system 
components and records key process values in a data file on the computer. 

Cryopilot 5 software can open data files created by Cryopilot 4 as well as 
data files created by Cryopilot 5. However, all new data files saved by 
Cryopilot 5 will be saved in Cryopilot 5 format. This data file contains the 
following process values:

	— Chiller heat transfer fluid temperature setpoint and actual heat transfer 
fluid temperature 

	— Chiller mode setpoint (On|Off)
	— Mixer mode setpoint (On|Off) 
	— Temperature measured by up to 14 Type T thermocouples 

By default, Cryopilot 5 data files have a .cpd file extension. A Cryopilot data 
file is a ZIP file containing two files:

	— data.txt, which is a tab-delimited data file 
	— data.txt.p7s, which is a digital signature in PCKS#7 format. 

Spreadsheet programs such as Microsoft Excel can import the tab-delimi-
ted data file, but it is easier to transfer the data using the File > Copy > Data 
menu item. Do not attempt to open the data file for a run in progress as the 
spreadsheet application may lock the file, thus preventing the Cryopilot 
software from writing additional data.
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File Format

The data.txt file and the results of the File > Copy > Data command both 
contain tab-delimited text. The character encoding is ASCII and the file 
format is case-insensitive. The first line must contain the creator and version 
as specified below. All temperature values have units of °C.

The following syntax is used to describe the file format:
\n	 Newline character, here defined as CRLF
\s	 Zero or more whitespace characters
\t	 Tab character
<variable>	 Variable element
[FOO]	 Optional element
OFF|ON	 Enumerated value, element must be one or the other
...	 Indicates repeating structure

Note that times are specified as Universal Coordinated Time (UCT), which 
may differ from local time depending on your time zone. 

Where no data is available, the file will contain the symbol “NaN” (Not a 
Number).

Format:
Cryopilot 5.0\n
METADATA\n
Title\t<title>\n
Process Start\t<timestamp format=yyyy-MM-dd HH:mm:ssZ>\n
Computer\t<computer name>\n
User\t<user name>\n
Description\t<description>\n
START\n
Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply 
Temperature Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\
tProduct Temperature 1(C)\tProduct Temperature 2(C)\t...Product 
Temperature n(C)\n
<timestamp format=yyyy-MM-dd HH:mm:ssZ>\t<elapsedhours 
format=0.000000>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n
.
.
.
.
.
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Example with four thermocouples (implied \n):

Cryopilot 5.0
METADATA
Title	 Temperature vs. Elapsed Time
Process Start	 2009-03-03 21:49:22Z
Computer	 DEMO_LAPTOP
User	 DEMO_LAPTOP\Administrator
Description	
START
Date/Time(UTC)	 Elapsed Time(h)	 Chiller Status	 HTF Supply Temperature  
Setpoint(C)	 HTF Supply Temperature(C)	 Mixer Status	Product 1  
Temperature(C)	 Product 2 Temperature(C)	 Product 3 Temperature(C)	  
Product 4 Temperature(C)
2009-03-03 21:49:31Z	 0.002500	 On	 0.0	 21.0	 On	 22.8	 25.4	 NaN	 NaN
2009-03-03 21:49:46Z	 0.006667	 On	 0.0	 20.7	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:01Z	 0.010833	 On	 0.0	 20.3	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:16Z	 0.015000	 On	 0.0	 20.0	 On	 22.8	 25.2	 NaN	 NaN
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5.6.10	 Diagnostics | Troubleshooting
Error and status messages are displayed in the message area at the lower 
right hand corner of the main window. This section describes common errors 
and what may be done in response.

Chiller

In the event of problems with the chiller, the following steps may be helpful:
	t Check both ends of the cable between the computer and the chiller. 
	t Check the chiller’s error log. For more information, refer to the Huber 

Unistat 705 Operating Instructions.
	t Check that the chiller communication settings are configured properly. 

The Cryopilot A should be set to use baud rate 9600 and protocol RS-232. 
For more information, refer to the Huber Unistat 705 Operation 
Instructions.

	t As a last resort, exit the Cryopilot software, cycle power to the chiller, 
and restart the Cryopilot software. Try to ascertain the cause of the 
problem before starting another run. Make sure that the settings in the 
Options dialog are correct.

If a power failure occurs during a run the chiller may get disconnected or the 
data from the chiller may be corrupted. The presence of NaN (not a number) 
in the temperature fields of the data file is another indication of a chiller 
error. 

Shaker

If the shaker does not move when it should, the following may be helpful:
	t Check the cable between the computer and the shaker.
	t Verify that the mode switch at the rear of the mixer is in the Auto position.
	t Verify that the speed setting is correct.

Data Acquisition – Device | Thermocouples

The following are common errors related to the data acquisition hardware or 
the thermocouples:

	— A sensor does not respond to changes in temperature as the other 
sensors do. 

Should one of the above occur, the following hints may be helpful:
	t Verify that the sensor in question is plugged in to the proper receptacle 

in the thermocouple breakout cable attached to the data acquisition 
device. 

	t Be sure that each sensor is properly located and secured. A small error in 
location can cause large deviations compared to other sensors. 

	t Check connections between the computer and the data acquisition 
device.

	t A sensor may be damaged. Check the sensor with a calibrated reader 
(e.g. Fluke 725) capable of measuring Type T thermocouples. 
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5.6.11	 21 CFR Part 11
Cryopilot 5 software has been designed to facilitate compliance with the 
requirements of 21 CFR Part 11. 

Digital signatures are used to prove that the authenticity and integrity of 
Cryopilot 5 data files, even on open (i.e. untrusted) systems. The terms 
“digital signature” and “electronic signature” should not be confused. A 
digital signature is a cryptographic method, whereas an electronic signature 
is an electronic equivalent of a handwritten signature with legal implications. 
References to electronic signatures in 21 CFR Part 11 do not apply to the 
digital signatures used in Cryopilot 5 data files.

Some general notes about implementation:
	— Cryopilot 5 relies on the operating system for account management, 

authentication, and authorization functions. 
	— The digital signature algorithm used by Cryopilot 5 is SHA-1 with RSA; 

it is written in PKCS#7 format.
	— The file system is treated as an untrusted system. 
	— When a process is stopped, the data file is closed and cannot be opened 

again for modification. Any alteration of the data by other means, 
whether accidental or malicious, will be detected by the digital signature 
mechanism.

	— Once data is exported from Cryopilot (e.g. to a spreadsheet), its 
authenticity and integrity can no longer be ensured.
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6	 System Operation

6.1	 Preparing for a Run

6.1.1	 Cryowedge
To prepare the Cryowedge for use:
	t Remove the upper half of the Cryowedge insulated cover.
	t Remove the wing nuts holding the transparent cover and set aside.
	t Remove the transparent cover. Fill the Cryowedge with the test solution 

using a graduated cylinder. Standard volumes for each size Cryowedge 
are as follows:

Cryowedge Size Volume (mL)

CW20 (12 inch) 350

CW125 (20 inch) 650

CW300 (30 inch) 3000

CW300 (34 inch) 4000

	t Replace the transparent cover.
	t Replace the wing nuts and tighten them hand tight. Do not over-torque 

or strip the threads.
	t Replace the upper half of the Cryowedge insulated cover.
	t Ensure that the Cryomixer Jr. cable is plugged into the Cryomixer Jr. and 

the computer.
	t Ensure that at least six thermo-couples are plugged into the data 

acquisition device, starting with position 1.
	t Place five of the thermocouples through the pre-drilled holes in the 

transparent cover. Secure the thermocouples ?” below the surface of the 
test solution using plastic spacers or cut pieces of silicon tubing.

	t Place the remaining thermocouple on the top of the transparent cover 
as a reference temperature at the outer surface of the Cryowedge.

	t Record the number and position of each thermocouple for later reference.

6.1.2	 S³ Module 
Celsius® Paks are delivered presterilized by gamma irradiation. They are sup-
plied with female Luer fittings and caps on 2 fill|drain ports. A variant with C-
Flex® tubing extensions is also available for sterile filling. All Celsius® Paks 
have a closed silicone/EVA thermowell for insertion of a thermocouple 
probe. 

In order to obtain consistent results, always load the S³ Module with the 
same number of Celsius® Paks. Ensure that each Celsius® Pak is filled to the 
same volume. The thermocouple should be placed at the same depth every 
time.

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   38_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   38 01.04.2022   09:52:1701.04.2022   09:52:17



		  Operating Instructions Celsius® S3 Benchtop System	 39

		  System Operation	

The standard freeze profiles provided with the Cryopilot software are desig-
ned for 10 Celsius® Paks, either 30 or 100 mL, filled to nominal volume. 
Place thermocouples at a minimum depth of 1 cm below the liquid surface 
of Celsius® Paks. Blank Celsius® Paks should be filled with sample buffer. Do 
not use deionized water in blanks as it typically supercools. If you use fewer 
than 10 Celsius® Paks, the freeze completes more rapidly and the profile 
does not transfer directly to a larger scale.

Step by step procedure for Celsius® Pak prep, filling and loading:

	t Prepare sample and|or buffer for filling Celsius® Paks.
	t Insert label in label holder at the bottom of Celsius® Pak. A label with 

dimensions of ~2 x 5 cm fits entirely within the label holder. It is 
recommended to use waterproof material and ink for the label. Do not 
write on the Celsius® Paks as the solvents used in the ink may penetrate 
the Celsius® Pak and contaminate the product.

	t Use a syringe or peristaltic pump to fill Celsius® Paks with sample or 
buffer through one of the fill|empty ports. Connect the syringe or pump 
via a male Luer® fitting or welded with the optional C-Flex® line.

	t Fill Celsius® Paks with a maximum volume of 30 mL for the 30 mL 
Celsius® Pak or 100 mL for the 100 mL Celsius® Pak. 

 CAUTION 
Do not overfill Celsius® Paks or purge all air from the top of the Celsius® 
Paks as this will cause sample and ice expansion into port tubing.

	t Close the fill tube with the supplied Luer® cap or pinch clamp.
	t Wipe any excess moisture from all surfaces inside the S³ Module, prior to 

starting a freeze.

Celsius® Paks are held in the S³ Module by a spring clamp mechanism that 
holds the Celsius® Pak and acts as an active heat transfer surface. Perform 
the following steps for loading the S³ Module:

	t Attach thermocouple holder to Celsius® Pak by aligning the female Luer 
lock on thermocouple holder with the male Luer lock on the top of the 
thermowell. After fastening the Luer lock to the thermowell, note that 
the front of the thermocouple holder should face the same direction as 
the front label of the Celsius® Pak.

	t Measure 1 cm from the end of the thermocouple and place a mark at this 
point for placement of thermocouple within the Celsius® Pak. 

	t Slowly unscrew the thermocouple locking collar, taking care to collect 
the two small o-rings within the locking collar. Place the locking collar 
and two o-rings over the end of the thermocouple and screw down the 
locking nut just far enough to ensure that it will not fall off the thermo-
couple holder.Fig. 20:  Thermocouple Holder Attached to 

Celsius® Pak
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	t Lower the thermocouple into thermowell. Never push hard enough to 
pierce through the end of the thermowell. For accurate thermal monito-
ring, always place the thermocouples 1 cm below the surface of the liquid 
in the Celsius® Pak by ensuring that the mark on the thermocouple 
meets the liquid surface. 

	t Tighten the locking collar to secure the thermocouple in place within the 
thermowell.

	t Stand facing the left side of the S³ Module; insert a Celsius® Pak between 
the clamp mechanisms, starting at slot 10; the slot furthest from the HTF 
supply and return. Open the mechanism by placing the clamp release 
tool over the 2 guide pegs on the 2 stainless steel pinch blocks for the 
slot and pressing down.

	t While pressing the clamp release tool down, Slide each of the sides of 
the Celsius® Pak down between a black block and a stainless steel pinch 
block of the clamping mechanism. Position the top of the Celsius® Pak so 
it is even with the top of the stationary black metal bar of the clamp me-
chanism. Note that the Celsius® Pak must face left in order to fit properly 
into the S³ Module.

	t Withdraw the clamp release tool. The Celsius® Pak will be held tightly on 
each side between two metal blocks, one black and one stainless steel. 
Connect the male thermocouple plugs to the corresponding thermo-
couple receptacle strip.

Fig. 21:  Thermocouple 1 cm below Liquid Level 
Surface

Fig. 22:  Opening the Pinch Clamp Mechanism

Fig. 23:  Thermocouple Holder and Celsius® Pak 
Installation
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Fig. 24:  Celsius® Pak Placement and Thermocouple Connection

	t Repeat this procedure from slot 9 to 1. Figure contains a diagram of the 
final placement of all Celsius® Paks and thermocouples.

NOTE 
For reproducibility, load the S³ Module with the same number of Celsius® Paks, 
fill each Celsius® Pak with the same amount of sample or buffer and place 
the thermocouples in the thermowells 1 cm below the surface of the liquid. 
All freeze profiles developed at Sartorius Stedim Biotech perform correctly 
only with a fully loaded system (10 Celsius® Paks). For that reason, results 
achieved with the freeze profiles provided with the installation software are 
directly scalable to 16.6 Liters. Changing the number of Celsius® Paks affects 
the scalability of these profiles.

	t Diagram the position and number of each thermocouple in a lab 
notebook or in accordance with company policy.

	t Close and lock the cover of the S³ Module.

Thermocouple Receptacle Strip

Filled Celsius® Pak Slot Position
HTF  
Inlet

HTF  
Outlet

Fig. 25:  Thermocouple and Celsius® Pak placement in S³ Module.
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6.2	 Running a Profile

NOTE
When thawing with the S³ Module, ensure that the 4 S³ Module mounting 
knobs are tight and that the module is held securely on the Cryomixer Jr. plate.

 CAUTION
Never exceed a value of 120 RPM for the Cryomixer Jr.

	t Double click the Cryopilot software icon to initialize the Cryopilot 
Software.

	t Select the Process > Start menu item to display the Start Process dialog.
	t Provide a file name for the data file where time and temperature data will 

be stored for the new process. 
	t Select the Standard profile type and select your application and desired 

operation (freeze, thaw, or freeze and thaw).  Alternately, select a custom 
profile.

	t Click the OK button to start the process.
	t Verify that the chiller responds to the commands from the software.  The 

status indicator in the lower left hand corner should read “Online”. There 
will be a 2-5 minute delay before the compressor starts and temperature 
regulation commences.

	t Allow the profile to run to the end of the programmed time.
	t Select the Process > Stop menu item to stop the process.  
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6.3	 Removing Frozen Celsius® Paks from the 
S³ Module

In some cases it is desirable to remove Celsius® Paks from the S³ Module 
while they are still frozen.

	t Remove the transparent top cover of the S³ Module. 

NOTE
If the unit is left open for an extended period of time while maintained at 
low temperature, frost builds up on the clamps, Celsius® Paks and thermo-
couple holders making Celsius® Pak removal difficult. Once the unit is open, 
quickly remove the frozen Celsius® Paks and then replace the hood.

	t Remove the thermocouples from the Celsius® Paks. If a thermocouple 
does not readily pull out, gently twist until it pulls free. Remove the 
thermocouple holder from each slot. If condensation builds up on the 
surfaces of the clamps, it forms an ‘ice bond’ between the thermocouple 
holders and the black metal cooling blocks. This makes removal of the 
thermocouple holders nearly impossible. Wipe excess moisture from all 
surfaces prior to starting a freeze. 

	t Remove the frozen Celsius® Paks from the S³ Module using the clamp 
release tool to slide the Celsius® Paks up and out. Place in an insulated 
transport container.

	t In the freezer, store frozen Celsius® Paks in a protective container at the 
desired temperature. If performing stability tests or formulation studies, 
it is best to use a controlled freezer with thermal monitoring.

6.4	 Dispensing Thawed Samples from the S³ 
Module

	t Remove thermocouples and thermocouples holders. 
	t Remove the thawed Celsius® Paks from the S³ Module.
	t Invert each Celsius® Pak three times to ensure uniform product mixture.
	t Remove desired amount of sample from Celsius® Pak via the unused 

fill|empty port. This can be done by syringe, pump, or gravity drain.
	t Discard used Celsius® Paks. Since Celsius®s Paks are sometimes 

deformed during freezing and thawing, upon reuse they do not fit as well 
between the clamping mechanisms. This can cause prolonged freezing 
and thawing due to poor heat transfer.
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7	 System Maintenance
Maintenance may be performed by the end-user or by Sartorius Stedim 
Biotech. Contact the Sartorius Stedim Biotech Service Department to 
establish a Preventive Maintenance Contract.

In the event of a problem, first check the error code section of the 
Huber Unistat 705 Operating Instructions. If you are unable to remedy 
the situation, call Customer Service (see page 45). 

7.1	 Cleaning
Exposed equipment surfaces are generally compatible with spray and wipe 
with isopropyl alcohol. Stainless steel surfaces may optionally be cleaned 
with stainless steel polish.

The internal cabinet of the S3 contains many parts made of anodized 
aluminum which is incompatible with basic solutions such as sodium 
hydroxide (NaOH) or oxidizers. These materials should not be used for 
cleaning the internal cabinet. Rather, isopropyl alcohol or other non 
oxidizing cleaning solutions are recommended if cleaning is necessary.

7.2	 Changing the Heat Transfer Fluid
Change the heat transfer fluid if it becomes visibly contaminated with water 
or particulate, or if you notice a decline in heat transfer efficiency (i.e. when 
the unit does not reach or maintain set point temperature). Always change 
out the entire amount of HTF. If there is no improvement in heat transfer 
efficiency after changing the HTF, call Customer Service (see page 45). 

To change the HTF, use the following procedure:
	t Verify that the system HTF drain valve located on the front of the unit is 

closed. The slot in the screw cap is vertically aligned when closed. See 
„Fig. 10: Cryopilot A HTF Drain Valve and Sealing Screws“, page 18. 

	t Remove the sealing screw in the protruding stainless tube on the left 
side of the unit and connect a piece of flexible tubing over the end of 
tube. Attach securely with a hose clamp.

	t Put the far end of the tubing in a container that will hold at least 12 L 
(3 gallons) of HTF.

	t Open the HTF drain valve by turning counter-clockwise until the slot is 
horizontally aligned.

	t If possible, attempt to lift Cryowedge or S3 module to drain residual HTF 
from the application module back down into the Cryopilot A.

	t When HTF stops flowing, close the HTF drain valve, remove the tubing 
from the sealing screw tube, and replace the sealing screw.

	t Fill the Cryopilot A system with new HTF according to the procedure in 
Chapter „4.7 Heat Transfer Fluid Fill“, page 17.
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8	 Information and Instructions 
on Disposal and Repairs

Packaging that is no longer required must be disposed of at the local waste 
disposal facility. The packaging is made of environmentally friendly materials 
that can be used as secondary raw materials. 

The equipment, including accessories and batteries, does not belong in 
your regular household waste. EU legislation requires its Member States to 
collect electrical and electronic equipment and dispose of it separately 
from other unsorted municipal waste with the aim of recycling it.

In Germany and many other countries, Sartorius takes care of the return and 
legally compliant disposal of its electrical and electronic equipment on its 
own. These products may not be placed with the household waste or 
brought to collection centers run by local public disposal operations – not 
even by small commercial operators.

For disposal in Germany and in the other Member States of the European 
Economic Area (EEA), please contact our service technicians on location or 
our Service Center in Goettingen, Germany:

Sartorius Stedim Biotech GmbH 
August-Spindler-Strasse 11 
37079 Goettingen, Germany

In countries that are not members of the European Economic Area (EEA) or 
where no Sartorius affiliates, subsidiaries, dealer, or distributors are located, 
please contact your local authorities or a commercial disposal operator. 

Prior to disposal and|or scrapping of the equipment, any batteries should be 
removed and disposed of in local collection boxes.

Sartorius, its affiliates, subsidiaries, dealers, and distributors will not take 
back equipment contaminated with hazardous materials (ABC contaminati-
on) – either for repair or disposal. Please refer to the accompanying manual 
or visit our Internet website (www.sartorius.com) for comprehensive infor-
mation that includes our service addresses to contact if you plan to send 
your equipment in for repairs or proper disposal.

Contact Information

24 Hour Customer Service  
+1 866 424 5600  
(toll free North America only) 
+1 707 747 5614  
(outside North America)
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Is the certificate 
up to date? 
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1	 Einleitung
Sartorius bietet skalierbare Gefrier-Auftaulösungen unter Verwendung 
patentierter Technologien zur Handhabung, Lagerung und Beförderung 
von Biopharmazeutika, einschließlich der Instrumente für die Prozess
entwicklung, der Durchführung im Pilotumfang und der kommerziellen 
Produktion. Die Konfigurationen des Benchtop-Systems sind für die 
Reproduktion der kontrollierten Gefrier-Auftauprozesse, die bei 
großvolumigen Celsius®- und Cryovessel-Prozessen in einer Produktions
umgebung auftreten, konzipiert. Cryovessel ist eine Produktreihe aus 
Edelstahl; Celsius® ist eine Produktreihe für den Einmalgebrauch. Beide 
Systeme nutzen den Kühler Cryopilot A und den Schüttler Cryomixer Jr.

1.1	 Cryovessel
Das Benchtop-System für Cryovessel heißt Cryowedge. Das Cryowedge-
Modul bildet durch den Abgleich der Wärmeübertragungsfläche des 
Gefrierweges und des Konstruktionsmaterials einen kleinen Cryovessel-
Bereich ab.

Die Produktionsvolumenanforderungen für Machbarkeitsstudien lassen 
sich durch die Verwendung der Cryocassette weiter reduzieren. Dabei 
handelt es sich um Edelstahlbehälter mit einem Fassungsvermögen von 
30 mL und 100 mL, die sich in Polymermanschetten in den Cryowedge 
einsetzen lassen.

1.2	 Celsius®

Das Benchtop-System für Celsius® ist das S3-Modul; S3 steht für „Scale-
down“ (Abwärtsskalieren) und Stabilitätsstudien. Das S3-Modul modelliert 
die Gefrier-Auftau-Module FT16 und FT100 durch den Abgleich des 
Gefrierweges. Das Gefrier-Auftau-System Celsius® S3 generiert ähnliche 
Gefrier-Auftau-Zeiten und ermöglicht somit skalierbare Gefrier-Auftau-
Tests und Stabilitätsstudien. 

1.3	 Referenzen
Weitere Informationen zu den Komponenten Ihres Benchtop-Gefrier-
Auftausystems finden Sie in den folgenden Dokumenten:

	— Gebrauchsanweisung für den Huber Unistat 705
	— Elektrische Schaltpläne für den Huber Unistat 705
	— Produktinformationen zu Dow Syltherm HF
	— Materialsicherheitsdatenblatt (MSDS) zum Dow Syltherm HF
	— Materialsicherheitsdatenblatt (MSDS) zum DuPont Suva 507
	— Materialsicherheitsdatenblatt (MSDS) zum DuPont Suva 23
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2	 Sicherheit
Beachten Sie sorgfältig alle Anweisungen, um schwere Verletzungen der 
Mitarbeiter, ggf. sogar mit Todesfolge und Schäden an den Geräten zu ver-
meiden. Durch jegliche Nutzung der Systemkomponenten in nicht 
bestimmungsgemäßen Anwendungen erlöschen die Garantien der Geräte. 
In einem solchen Fall übernimmt Sartorius keine Haftung.

Die folgenden Symbole zeigen wichtige Informationen an:

 ACHTUNG
Potenziell gefährliche Situationen, die, wenn sie nicht vermieden werden, 
zum Tod führen oder schwere Verletzungen nach sich ziehen können.

 VORSICHT
Potenzielle geringere Sicherheitsrisiken für die Mitarbeiter oder potenzielle 
Schäden an Geräten oder Eigentum.

HINWEIS
Wichtige, jedoch nicht sicherheitsbezogene Informationen.

2.1	 Allgemeine Vorsichtsmaßnahmen
	t Stellen Sie sicher, dass die unternehmenseigenen Sicherheitsrichtlinien 

jederzeit befolgt werden. 
	t Bei der Durchführung von Wartungsarbeiten schalten Sie das Gerät aus 

und beachten Sie in den Systemkomponenten die korrekten 
Einschaltsicherungs- | Abschaltverfahren.

	t Dehnen Sie die Cryohoses nicht, um sie am Kühler oder an der Anlage 
anschließen zu können. Bewegen Sie statt dessen den Kühler oder die 
Anlage, um die Schläuche im ungestrafften Zustand anbringen zu 
können. Sorgen Sie für ein ausreichendes Spiel, um Abknickungen zu 
vermeiden.

	t Die Systemkomponenten sind schwer. Beachten Sie die korrekten Hebe- 
und Montageverfahren. 
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2.2	 Das Wärmeträgermedium
Das System nutzt das Dow Syltherm HF-Silikon-Wärmeträgermedium 
(HTF – heat transfer fluid). Verwenden Sie kein anderes 
Wärmeträgermedium. 

Mit der Anwendung von HTF sind eine Reihe von Risiken verbunden:
	— Temperaturen von bis zu -75 °C und 250 °C können schwere 

Verletzungen der Haut, der Augen und an anderem Weichgewebe 
verursachen. Tragen Sie bei der Arbeit mit HTF oder in der Nähe von 
heißen oder kalten Geräteoberflächen geeignete persönliche 
Schutzkleidung.

	— Syltherm HF hat einen „Closed-Cup“-Flammpunkt (bei geschlossenem 
Tiegel) von 63 °C gemäß ASTM D92. Es ist gemäß NFPA und OSHA als 
brennbare Flüssigkeit der Klasse IIIA definiert. Befolgen Sie die 
korrekten Verfahren zur Handhabung und Lagerung.

	— Syltherm HF hat eine geringe Oberflächenspannung und es kann sich 
als schwierig erweisen, Spritzer beim Befüllen oder Ablassen des 
Systems zu vermeiden. Verspritzte | verschüttete Flüssigkeit ist äußerst 
rutschig. Verwenden Sie ein absorbierendes Material, wie Polypropylen-
Pads, um Tisch und Boden frei von verspritztem | verschüttetem HTF zu 
halten.

	— HTF-Abfallstoffe und Absorptionsmittel müssen als Sondermüll entsorgt 
werden. Weitere Informationen finden Sie in den Produktinformationen 
und MSDS.

2.3	 Cryopilot A
Die Kühlgeräte dürfen nur von qualifizierten Fachkräften gewartet werden. 
Der Cryopilot A nutzt den teilhalogenierten Fluorkohlenwasserstoff 
(Hydrofluorocarbonat) (H-FKW) R-507 und R-23 als Kältemittel. Diese 
Kältemittel unterliegen Umweltschutzvorschriften und dürfen nicht in die 
Atmosphäre abgelassen werden.

	t Weitere Informationen finden Sie in den MSDS.

2.4	 Cryomixer Jr.
	t Halten Sie Ihre Hände während des Betriebs fern von der oberen 

Abdeckplatte.
	t Überschreiten Sie nicht die im Abschnitt Systeminstallation empfohlene 

Höchstgeschwindigkeit des Mixers.
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3	 Systemkomponenten

3.1	 Cryopilot A
Der Cryopilot A ist ein Umwälzkühler, der die Temperatur eines 
Wärmeträgermediums (HTF) auf einen Temperatursollwert regelt.

Das Kaskadenkühl-System kühlt das HTF, wenn die Isttemperatur über dem 
Temperatursollwert liegt. Die Hauptkomponenten des Kühlsystems sind ein 
Hochtemperaturkompressor, ein Niedertemperaturkompressor, ein 
Kondensator, ein automatisches Ausdehnungsventil und ein Verdampfer. 
Die in den hohen und niedrigen Stufen verwendeten Kältemittel sind 
jeweils R23 und R507. Der Kältemittelkondensator ist luftgekühlt.

Ein Paar elektrische Widerstandsheizelemente heizen das HTF auf, wenn 
die Ist-Temperatur unter dem Temperatursollwert liegt. Ein großes 
1500-W-Heizelement wird für große Temperaturänderungen eingesetzt, 
ein kleines 100-W-Heizelement für kleine Temperaturänderungen. Diese 
Doppelinstallation der Heizelemente liefert eine präzise Regelung der 
HTF-Versorgungstemperatur.

Eine drehzahlveränderliche Pumpe zirkuliert das HTF durch Verdampfer, 
Heizelemente und durch die externe Anlage. Bei Cryowedge-Anlagen fließt 
das HTF durch den Mantel- und den inneren Wärmeaustauschbereich. Bei 
S3-Modul-Anlagen fließt das HTF durch die Wände neben den Celsius® Pak-
Klemmen. Ein Ausdehnungsbehälter vereinfacht das Befüllen des Systems 
und ermöglicht die Expansion und die Kontraktion des HTF.

Der Cryopilot A ist mikroprozessorgesteuert. Die Controller-Benutzerober-
fläche verfügt über eine Reihe von Druckknöpfen, einen Sollwertgeber für 
die Drehzahl, eine LCD-Anzeige mit Touchscreen sowie ein Netzschema 
mit Status-LEDs. 

Nachfolgend finden Sie die Hauptspezifikationen des Cryopilot A:

Stromversorgung

HINWEIS: Der Cryopilot A wird ohne Stecker geliefert. Auf Grund der 
Variationen bei den lokalen Steckdosen muss der Kunde den Stecker 
konfektionieren. 

Nordamerika 208 VAC, 60 Hz, 1~, 20 A

Europa 230 VAC, 50 Hz, 1~, 15,6 A

Fluid-Temperaturbereich -75 °C bis 250 °C

Maße (B x T x H) 425 x 400 x 720 mm

Gewicht 90 kg
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3.2	 Computer
Der Cryopilot A wird mithilfe der Cryopilot-Software auf einem Computer 
gesteuert und kontrolliert. Die Cryopilot-Software steuert und kontrolliert 
die Benchtop-Systemkomponenten, einschließlich Kühler, Mischer und 
Thermoelementen. Angaben zu den Mindestsystemvoraussetzungen und 
zusätzliche Informationen erhalten Sie im Kapitel „5 Cryopilot-Software”, 
Seite 65.

Computer, die von Sartorius als Teil eines Benchtop-Systems gekauft 
wurden, haben folgende technische Daten:

	— Laptop-Formfaktor
	— Betriebssystem: Microsoft Windows 10 Professional, 64-Bit
	— Microsoft Excel
	— Adobe Acrobat
	— Vorinstallierte Cryopilot-Software

3.3	 Cryowedge-Modul
Die Cryowedge-Modulnamen entsprechen dem Volumen von Produktions-
Cryovessel-Einheiten. Ein Cryowedge 125 simuliert beispielsweise ein 
125-l-Cryovessel.

Betriebsvolumen 350 – 4000 mL, je nach Cryowedge-Größe

Konstruktionsmaterialien

Gehäuse 316 L Edelstahl

Dichtungen Silikon

Abdeckung transparentes Polycarbonat

Anschlüsse HTF-Eingang, HTF-Ausgang mit 
Schnellkupplungen

Gewicht, leer

Cryowedge 20 (12”) 15 kg 

Cryowedge 125 (20”) 21 kg

Cryowedge 300 (30”) 44 kg 

Cryowedge 300 (34”) 49 kg 

Größenäquivalent

Cryowedge 20 (12”) Cryovessel 20 L – 40 L

Cryowedge 125 (20”) Cryovessel 60 L – 150 L

�Cryowedge 300 (30”) Cryovessel 200 L – 300 L

Cryowedge 300 (34”) Cryovessel 300 L
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3.4	 Cryocassette
Die Cryocassette minimiert die Menge an verwendetem Produkt im 
Cryowedge. Der Cryowedge kann dann mit Pufferlösung gefüllt werden, 
während die Cryocassette mit Produkt gefüllt wird. Durch die Konstruktion 
der Cryocassette werden die Gefrier- und Auftaueigenschaften der 
Cryowedge-Einheit bewahrt, um eine Skalierbarkeit gegenüber den 
Produktions-Cryovessel-Einheiten zu gewährleisten. Die Cryocassette 
dient zudem als Behälter mit einer skalierbaren Stabilität. 

Betriebsvolumen 	— 10 – 100 mL, je nach Kassettengröße.
	— Erhältlich in den Größen 30 mL und 100 mL

Konstruktionsmaterialien

Gehäuse 316 L Edelstahl

Schiffchen 	— Polypropylen (30 mL) oder
	— Polyethylen (100 mL)

Sterilisierung Vom Kunden autoklavierbar

Oberfläche 10 µ-in Ra, EP

3.5	 Celsius® S3-Modul
Das Gefrier-Auftau-Modul S3-Modul liefert die Möglichkeit der 
Modellierung von Celsius® FT100- und FT16-Systemen mit nur 20 mL 
Produkt. Die Konfiguration der Wärmeaustauschflächen innerhalb des 
Moduls bietet denselben bidirektionalen Wärmefluss wie beim 
FT100- System, wenn Rahmen- und Celsius® Paks verwendet werden. 

Kapazität 1 – 10 Produktproben

Betriebsvolumen 20 mL bis 1 L, je nach Größe der 
Celsius® Paks

Konstruktionsmaterialien

Mantel 302-304 Edelstahlmantel

Sockel  6061-T6 Aluminium

Mantelrahmenabdeckung 5052 Aluminium

Abschlussplatten Starre PVC-Schaumplatte

Mantelinnenisolierung Silikonschaumstoff

Abschlussabdeckung für 
den HTF-Anschluss

Delrin

Abdeckung Transparentes PVC

Max. Betriebsdruck der 
HTF-Leitungen

4,1 barg

Anschlüsse HTF-Eingang, HTF-Ausgang mit 
Schnellkupplungen; Ablass

Gewicht Etwa 18 kg

Abb. 1:  Cryocassette-Einheiten aus Edelstahl

Abb. 2:  Celsius® S3-Gefrier-Auftau-Modul
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3.6	 Celsius® Paks
Alle Celsius® Paks haben ungeachtet ihrer Größe dasselbe Konstruktions-
material und dieselbe Gefrier- und Abtauwegstecke, wie in Abbildung 3 
dargestellt.

Da Celsius® Paks Artikel für den Einmalgebrauch sind, entfällt die 
Notwendigkeit einer Reinigung.

	— Erhältlich in den Größen 30 mL und 100 mL
	— Gebrauchsfertiger faltbarer Behälter für den Einmalgebrauch
	— Vorsterilisiert (Gammastrahlung von 25 – 45 kGy)
	— Kompatibel mit der RF-Dichtung
	— Sterile Temperaturmessung möglich
	— Es sind Celsius® Paks-Überziehbeutel erhältlich. Die Verwendung eines 

Überziehbeutels wird für Studien bei höheren Temperaturen (Raumtem-
peratur und höher) empfohlen.

30 mL und 100 mL Celsius® Pak-Konstruktionsmaterialien

Produkt-Kontaktschicht EVAM (Ethylenvinylacetatcopolymer, 
Monomaterial)

Gas- und Feuchtigkeits-
barriereschicht

EVA | EVOH | EVA

Externe robuste 
Handhabungsschicht

EVA

�Füll- und Ablassanschlüsse EVA

Verlängerungsleitungen C-Flex®*

LuerLock® Polycarbonat oder Polypropylen 
(optional C-Flex®)

Doppeltüllen-Winkel- oder 
Anschlussstück 

Polypropylen (optional C-Flex®)

�Schutzrohr Pt-gehärtetes Silikon

* �C-Flex® is a registered trademark of Saint-Gobain Performance 
Plastics Corporation

Abb. 3:  Vergleich zwischen den Celsius® Paks 
mit einem Fassungsvermögen von 30 mL und 
16,6 L

Frozen 16.6 L 
Celsius® Pak

8.4 cm
8.4 cm
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3.7	 Cryomixer Jr.
Der Cryomixer Jr. ist ein Hubkolbenmischer, der unter dem Cryowedge oder 
dem S3‑Modul aufgestellt wird, um so die Homogenität des aufgetauten 
Produkts zu gewährleisten. Die Hubkolbenbewegung beginnt automatisch 
bei Aktivierung der Cryopilot-Software. Der Cryomixer Jr. wird sowohl für 
Agitationsanlagen des Cryowedges als auch des S3-Moduls verwendet. 

Technische Daten

Hub 25 mm, reziprok

Stromversorgung

Nordamerika 115 V, 60 Hz, 1~

Europa 230 V, 50 Hz, 1~

Maße (B x T x H) 505 x 585 x 120 mm

Gewicht 24 kg 

3.8	 Cryohose
Alle Systeme nutzen zwei Cryohoses für die Zufuhr und Rückleitung des 
HTF von der Cryopilot A-Einheit. Diese Leitungen bestehen aus Edelstahl 
mit einem Isolationsmantel.

3.9	 Cryowrap
Cryowrap ist eine Neoprenmanschette, die um die Cryohose-Anschlüsse 
gewickelt wird. Sie verhindert, dass sich beim Einfriervorgang des 
Cryowedges oder S3‑Moduls eine Eisschicht an den Anschlüssen bildet.

3.10	 Datenerfassungsgerät
Das Datenerfassungsgerät ist ein kompaktes Modul zur Digitalisierung von 
Thermoelementsignalen für die Überwachung durch den Computer. Das 
Datenerfassungsgerät verfügt über eine Kabelpeitsche mit Anschlüssen für 
bis zu 16 Thermoelementen vom T-Typ.

Abb. 4:  Cryomixer Jr.
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4	 Systeminstallation
Dieses Kapitel führt Sie durch die Konfiguration des Benchtop-Systems.

4.1	 Für die Installation benötigte 
Werkzeuge | Geräte

Folgende Werkzeuge werden für die Einrichtung des Benchtop-Gefrier-
Auftau-Systems benötigt:

	— Verschiedene Schraubendreher für Kreuzschlitz- und 
Senkkopfschrauben

	— Eine Klemmzange mit einem Griff von wenigstens 15 cm
	— Verschiedene Ring- oder Rollgabelschlüssel
	— Absorptionsmaterial, wie Polypropylen-Pads zum Aufwischen von 

verschüttetem | verspritztem HTF
	— Ein zum Messen der Versorgungsspannung geeignetes Multimeter

4.2	 Lieferumfang
Stellen Sie nach dem Auspacken aller Komponenten aus den Verpackungen 
sicher, dass die folgenden Komponenten für die Installation vorhanden sind:

	— Cryopilot A
	— Cryowedge oder S3-Modul
	— Cryomixer Jr.
	— (2) Cryohoses
	— (4) Cryowraps
	— Thermoelemente vom Typ T (je nach System bis zu 10 Stück)
	— Kabel, USB an Cryomixer Jr.
	— Computer mit Cryopilot-Software
	— Datenerfassungsgerät, National Instruments USB-9213
	— Kabel, USB an Unistat
	— Wärmeträgermedium Dow Syltherm HF (~19 L)
	— Sicherheitssiphon
	— Isolierte Cryowedge-Abdeckung (nur Cryowedge)
	— Drei Cryocassette-Einheiten (nur Cryowedge)
	— (10) Celsius® Paks (S3-Modul)
	— (10) Thermoelement-Halter (nur S3-Modul)
	— Klemmenwerkzeugschlüssel (nur S3-Modul)
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4.3	 Auswahl eines Standorts
Stellen Sie das System auf einer trockenen, ebenen Oberfläche, wie einem 
Labortisch oder einem Tisch, der ein Gesamtgewicht von ~180 kg trägt, auf. 
Ein typisches Benchtop-System benötigt etwa eine Standfläche von 188 cm 
Breite und 76 cm Tiefe. Die ordnungsgemäße Aufstellung und die benötig-
ten Freiräume sind in Abbildung 5 dargestellt. Der Cryopilot A ist luftge-
kühlt und benötigt eine ausreichende Belüftung. Stellen Sie das Gerät nicht 
auf Wagen mit Rädern auf, da der Cryomixer Jr. vor und zurück schwingt.

Freiraum von mindestens 8 cm

Fr
ei

ra
um

 v
on

m
in

de
st

en
s 1

5 
cmS3-Modul oder

Cryowedge 

Cryomixer Jr.

Cryopilot A
Laptop
Computer

Erforderliche Tiefe von 76 cm (Ref.)

188 cm (Ref.)

71
 c

m

Anschluss-
kasten 

Mind. 46 cm

Abb. 5:  Platzbedarf

4.4	 Montage von Cryowedge und Cryohose 
(Schlauchverbindung für 
Wärmeträgermedium HTF)

 VORSICHT
Dehnen Sie die Cryohoses nicht und knicken Sie sie nicht ab, um sie am 
Cryowedge anzuschließen. Dies kann zu Leckagen führen. Lassen Sie 
ausreichend Spiel.

 VORSICHT
Halten Sie beim Anziehen der Cryopilot A-Verbindungselemente mit einem 
geeigneten Gegendrehmoment gegen, um Schäden an der Leitungsinnen-
seite zu vermeiden.

	t Ummanteln Sie den Cryowedge mit der im Lieferumfang enthaltenen 
Isolierabdeckung. Stellen Sie sicher, dass die Ein- und Auslassanschlüsse 
für das Wärmetransferfluid (HTF) freiliegen.
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	t Platzieren Sie den isolierten Cryowedge auf den Cryomixer Jr. Richten 
Sie den Cryowedge so aus, dass die Bewegung des Cryomixer Jr. das 
Mischen entlang der gesamten Cryocassette-Länge oder ab dem Punkt 
des Cryowedges (entspricht der Position des inneren Cryovessel-
Wärmeaustauschers) bis zur Außenwand (entspricht der Position des 
Cryovessel-Mantels) gestattet.

	t Schieben Sie über jede Leitung zwei Cryowraps.

HINWEIS
Die Schnellkupplungen sind werkseitig an den Adaptern und Leitungen 
vormontiert. Wenn es erforderlich ist, Verbindungen zu lösen und neu anzu-
schließen mit konischen Gewinden, verwenden Sie ein Gewindedichtmittel, 
wie beispielsweise Loctite 567.

Cryowedge Cryopilot A

_”Sanitärflansch* M16x1
Anschlussstück 16

⅜"-Schnell- 
kupplung 
(Buchse)

⅜"-Schnell-
kupplung 
(Stecker)

Adapter*

Isolierter Schlauch,
1,5 m

Anschlussstück
M24x1,5

Adapter

Anschlussstück 
M16x1

Adapter

Abb. 6:  Montage der Schlauchverbindung Cryohose für den Cryowedge

	t Verbinden Sie den Anschluss „Thermofluid out“ (HTF-Auslass) am 
Cryopilot A mit dem Einlassanschluss am Cryowedge, wie in der 
Abbildung 6 dargestellt. Der Einlassanschluss am Cryowedge befindet 
sich an der Außenwand, diesentspricht der Position des Cryovessel-
Mantels.

	t Verbinden Sie den Anschluss „Thermofluid in“ (HTF-Einlass) am 
Cryopilot A mit dem Auslassanschluss am Cryowedge, wie in der 
Abbildung 6 dargestellt. Der Auslassanschluss am Cryowedge befindet 
sich an einem Punkt, der der Position des inneren Cryovessel-
Wärmeaustauschers entspricht.

	t Stellen Sie sicher, dass alle Leitungen korrekt angeschlossen sind.
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4.5	 Montage des S3-Moduls
 

 VORSICHT
Dehnen Sie die Cryohoses nicht und knicken Sie sie nicht ab, um sie am 
S3- Modul anzuschließen. Dies kann zu Leckagen führen. Lassen Sie 
ausreichend Spiel.

 VORSICHT
Halten Sie beim Anziehen der Cryopilot A-Verbindungselemente mit einem 
geeigneten Gegendrehmoment gegen, um Schäden an der Leitungsinnen-
seite zu vermeiden.

	t Stellen Sie das S3-Modul auf den Cryomixer Jr., wie in der Abbildung 7 
dargestellt, sodass die Bewegung des Cryomixer Jr. ein Mischen entlang 
der gesamten Celsius® Pak-Länge ermöglicht.

Pos. Beschreibung

1 Outlet Port

2 Inlet Port

3 Mounting Knobs

	t Fixieren Sie das S3-Modul an der Cryomixer Jr.-Platte. Ziehen Sie dazu 
die vier Montageknöpfe unten am Modul an.

	t Schieben Sie über jede Leitung zwei Cryowraps.

HINWEIS
Die Schnellkupplungen sind werkseitig am S3 und an den Leitungen 
vormontiert. Wenn es erforderlich ist, Verbindungen mit konischen 
Gewindeverbindungsstücken zu lösen und neu anzuschließen, verwenden 
Sie ein Gewindedichtmittel, wie beispielsweise Loctite 567.

S3 Module Cryopilot A

Adapter

Anschlussstück
M24x1,5

Anschlussstück 
M16x1

⅜"-Schnell-
kupplung
(Buchse)

⅜"-Schnell-
kupplung 
(Stecker)

Isolierter Schlauch,
1,5 m

Adapter

M16x1
Anschlussstück 16

Abb. 8:  Cryohose-Montage am S3-Modul

1
2

3

Abb. 7:  Positionierung des S3‑Moduls
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	t Verbinden Sie den Anschluss „Thermofluid out“ (Thermofluid-Auslass) 
am Cryopilot A mit dem Einlassanschluss des S3-Moduls. Bei dem 
Einlassanschluss handelt es sich um den unteren der beiden 
Schnellkupplungsanschlüsse am S3. 

	t Verbinden Sie den Anschluss „Thermofluid in“ (Thermofluid-Einlass) 
am Cryopilot A mit dem Auslassanschluss des S3-Moduls. Bei dem 
Auslassanschluss handelt es sich um den oberen der beiden 
Schnellkupplungsanschlüsse am S3.

	t Stellen Sie sicher, dass alle Leitungen korrekt angeschlossen sind.

4.6	 Konfiguration des Cryopilot A

 ACHTUNG
Alle Verdrahtungen und Verkabelungen sollten von einem fachkundigen 
Elektriker vorgenommen werden.

	t Stellen Sie sicher, dass der Cryopilot A-Hauptnetzschalter in der Stellung 
„OFF“ (Aus) oder „0“ steht. Der Schalter ist rot-gelb und befindet sich 
auf der Rückseite des Cryopilot A, wie in Abbildung 9 dargestellt. 

	t Lassen Sie sich von einem fachkundigen Elektriker einen Stecker (nicht 
im Lieferumfang enthalten) am Netzkabel des Cryopilot A konfektionie-
ren. Der Stecker muss zur Steckdose passen und auf die Netzspannung 
und den Netzstrom ausgelegt sein. Die technischen Angaben zur Strom-
versorgung finden Sie im Kapitel „3 Systemkomponenten”, Seite 52.

	t Schließen Sie die Cryopilot A-Einheit an der Stromversorgung an. 
	t Drehen Sie den Cryopilot A-Hauptnetzschalter in die Stellung „ON“ 

(Ein).
	t Stellen Sie sicher, dass alle LEDs kurz aufleuchten und dass die recht-

eckige LCD-Display aufleuchtet. Ist dies nicht der Fall, stellen Sie sicher, 
dass die Cryopilot A-Einheit mit Strom versorgt wird. Wird die Cryopilot 
A-Einheit mit Strom versorgt, der Controller wird jedoch nicht aktiviert, 
wenden Sie sich an den Kundendienst (siehe Seite 93). 

4.7	 Befüllung mit Wärmeträgermedium HTF
Es wird empfohlen, für die Konfiguration des Benchtop-Systems etwa 19 L 
HTF bereit zu halten. Als Wärmeträgermedium wird auf Grund seines 
niedrigen Gefrierpunktes und der geringen Viskosität über einen großen 
Temperaturbereich Dow Syltherm HF verwendet. Weitere Informationen 
finden Sie auf dem Materialsicherheitsdatenblatt (MSDS) zu Dow 
Syltherm HF.

HINWEIS
Dow Syltherm HF ist das einzige zulässige Wärmeträgermedium, das 
in diesem System verwendet werden darf.

Abb. 9:  Cryopilot A-Hauptnetzschalter
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	t Stellen Sie sicher, dass das Ablassventil geschlossen ist (drehen Sie es im 
Uhrzeigersinn in die senkrechte Stellung und verschließen Sie die untere 
Dichtschraube seitlich am Cryopilot A, wie in Abbildung 10 dargestellt).

1 2 3

Abb. 10:  HTF-Ablassventil und Dichtschrauben des Cryopilot A

Pos. Beschreibung

1 Hauptablass-HTF Ablass-Dichtschraube

2 HTF-Ablassventil

3 Sichtscheibe Ablauf, Dichtschraube

	t Entfernen Sie die Einfüllkappe oben auf dem Cryopilot A, hinter der 
Sichtscheibe. 

	t Heben Sie den Behälter mit Syltherm HF über die Höhe des Cryopilot A 
an.

	t Führen Sie das Schlauchende der Handpumpe in den Cryopilot A und 
das Ventilende in den Syltherm HF-Behälter ein. Tauchen Sie das rote 
Ventilende ins Syltherm HF ein und bewegen Sie es auf und ab, um die 
Handpumpe zu aktivieren. Um das HTF-Befüllen zu stoppen, heben Sie 
das rote Ventilende aus dem Syltherm HF. Befüllen Sie die Cryopilot A-
Einheit bis zur 2-l-Markierung des Schauglases. 

	t Starten Sie eine manuelle Luftspülung (drücken Sie „Start“, „Start Air 
Purge“ (Luftspülung starten), „30s interval“ (30-s-Intervall), „OK“). 
Geben Sie je nach Bedarf mehr HTF zu, bis sich das Schauglasniveau bei 
2 L stabilisiert.  

	t Stellen Sie sicher, dass in den Leitungsanschlüssen keine Leckagen 
vorhanden sind.

	t Stoppen Sie die Pumpe (drücken Sie „Stop“ (Stopp), „Air Purge Off“ 
(Luftspülung aus)).

	t Fixieren Sie die Cryowraps über den freiliegenden Metallflächen am 
Ende der beiden Leitungen.
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4.8	 Konfiguration des Cryomixer Jr.
	t Schließen Sie den Cryomixer Jr. an die Stromversorgung an.
	t Stellen Sie den Handbetriebsschalter an der Vorderseite des Cryomixer 

Jr. in die Stellung „O“.
	t Stellen Sie den Schalter „Manual | Automatic“ (Manuell | Automatisch) 

auf der Rückseite des Cryomixer Jr., wie in Abbildung 11 dargestellt, in die 
manuelle Stellung (nach unten).

	t Drehen Sie den Drehzahlknopf bis zum Anschlag entgegen dem 
Uhrzeigersinn (0 U/Min.).

	t Drehen Sie den Handbetriebschalter in die Stellung „I“.
	t Drehen Sie den Geschwindigkeitsknopf langsam im Uhrzeigersinn, bis 

die korrekte Drehzahl erreicht ist. Protokollieren Sie die angezeigte 
Drehzahl gemäß der LCD-Anzeige am Cryomixer Jr. Nachfolgend ist die 
Standardkonfiguration aufgeführt:

	— Die Cryowedges CW20 und CW125: 45 U/Min.
	— Die Cryowedges CW300 (30“) und CW300 (34“): 35 U/Min.
	— S3-Modul: 120 U/Min.

HINWEIS
Die Einstellungen der Mischerdrehzahl können je nach kundenspezifischer 
Produktcharakterisierung variieren. Wenden Sie sich zur Besprechung von 
Abweichungen von den oben aufgeführten Empfehlungen an Sartorius.

	t Stellen Sie den Schalter „Manual|Automatic“ (Manuell|Automatisch) auf 
der Rückseite des Cryomixer Jr., wie in Abbildung 11 dargestellt, in die 
automatische Stellung (nach oben).

4.9	 Computerkonfiguration
	t Schließen Sie den Computer und das Display an der Stromversorgung 

an. Es wird empfohlen, einen Überspannungsschutz (nicht im 
Lieferumfang enthalten) zu verwenden.

	t Schalten Sie Computer und Display ein. Beantworten Sie die Fragen in 
den Windows-Konfigurationsdialogfeldern zur „ersten Inbetriebnahme“. 
Möglicherweise müssen Sie dazu einige Daten bei Ihrer IT-Abteilung 
erfragen. 

 VORSICHT
Auf Computern von Sartorius ist keine Virenschutzsoftware installiert. Es 
wird empfohlen, eine Virenschutzsoftware gemäß den Richtlinien Ihres 
Unternehmens zu installieren.

Abb. 11:  Rückseite des Cryomixer Jr.
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4.10	 Konfiguration der Datenerfassung
	t Schließen Sie den National Instruments USB-9213 über ein USB-Kabel 

am Computer an.
	t Schließen Sie das USB-Kabel des Cryomixer Jr. mit dem einen Ende 

an der Buchse auf der Rückseite des Cryomixer Jr. an. Schließen Sie das 
andere Ende an einem USB-Anschluss am Computer an.

	t Bei S3-Modulen schließen Sie das Bündel aus Thermoelementsteckern, 
die vom S3-Modul kommen, an der Kabelpeitsche des Thermoelements 
an. Schließen Sie den Stecker 1 an die Buchse 1, den Stecker 2 an die 
Buchse 2 usw. an. Schließen Sie die Celsius® Pak-Thermoelemente an 
der Sammelleiste im Haubenabdeckungsbereich des S3-Moduls an.

	t Schließen Sie, wie in Abbildung 12 dargestellt, ein Ende des Kabels, USB 
an Unistat, an einem USB-Anschluss des Computers und das andere 
Ende an der seriellen Schnittstelle unterhalb der Combox an. Die 
Combox befindet sich auf der Rückseite des Cryopilot A. Abb. 12:  Serielle Schnittstelle des Cryopilot A
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5	 Cryopilot-Software

5.1	 Überblick
Das Benchtop-System wird von der Cryopilot-Software, einer grafischen 
Anwendung für Computer mit dem Betriebssystem Microsoft Windows, 
gesteuert und kontrolliert. Die Cryopilot-Software bietet den Benutzern die 
flexible Ausführung von Gefrier- und Auftauvorgängen.

Im folgenden Diagramm wird die Beziehung zwischen den System-
komponenten dargestellt. Die Cryopilot-Software wird über USB mit dem 
Cryopilot A-Kühler und dem Schüttler Cryomixer Jr. sowie über ein National 
Instruments-Datenerfassungsgerät mit bis zu 16 Thermoelementen 
verbunden.

Abb. 13:  Cryopilot-System

5.2	 Mindestsystemvoraussetzungen
Die Cryopilot-Software ist werkseitig als Teil eines Benchtop-Systems auf 
denbei Sartorius bestellten Computern installiert. Alternativ ist sie für 
Systeme, die folgende Voraussetzungen erfüllen, auf USB Flash Drive 
erhältlich: 

	— Betriebssystem: Microsoft Windows 7 Professional, 32-Bit mit Service 
Pack 1 oder Microsoft Windows 10 Professional, 64-Bit.

	— Datenerfassungsgerät: National Instruments USB-9213.

Die Cryopilot-Software ist mit einem Installationsprogramm ausgestattet, 
das die Cryopilot-Software und alle erforderlichen Treiber von Drittanbie-
tern auf Ihrem Computer installiert. Zur Installation von Cryopilot müssen 
Sie über Administratorrechte verfügen.
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5.3	 Komponenten
Die Cryopilot-Software wird standardmäßig in C:\Programme\Sartorius 
Stedim Biotech\Cryopilot 5 für ein 32-Bit Betriebssystem und in C:\
Program Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 für ein 64-Bit 
Bestriebssystem installiert – nachfolgend als Installationsverzeichnis 
bezeichnet. Nachfolgend finden Sie eine Beschreibung der Dateien und 
Ordner im Installationsverzeichnis:

Komponente Beschreibung

Profiles /(Profile) Verzeichnis für die Standardprofil-
dateien von Cryopilot.

BouncyCastle.Crypto.dll Support-Bibliothek

Cryopilot.chm Hilfedatei

Cryopilot.exe Die ausführbare Datei für die 
Cryopilot-Software. Die 
Verknüpfungen zu dieser Datei 
werden auf dem Desktop platziert 
und im Startmenü verankert.

Cryopilot.exe.config Konfigurationsdatei

ICSharpCode.SharpZipLib.dll Support-Bibliothek

libftdi.dll Support-Bibliothek

log4net.dll Support-Bibliothek

NationalInstruments.Common.dll Support-Bibliothek

Add NationalInstruments.
NiLmClientDLL.dll 

Support-Bibliothek

Add NationalInstruments.
MStudioCLM.dll 

Support-Bibliothek

NationalInstruments.DAQmx.dll Support-Bibliothek

NPlot.dll Support-Bibliothek

unins000.dat Deinstallations-Hilfedatei

unins000.exe Deinstallationsprogramm

Zusätzlich zu den Dateien im Installationsverzeichnis erstellt das Cryopilot-
Installationsprogramm einen Ordner „Cryopilot“ im Ordner „Meine 
Dokumente“ eines jeden Benutzers. Dieser wird nachfolgend als Benutzer-
verzeichnis bezeichnet. Nachfolgend finden Sie eine Beschreibung der 
Dateien und Ordner im Benutzerverzeichnis:
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Komponente Beschreibung

Data/ (Daten) �Standardverzeichnis für die von den Benutzern 
gespeicherten Dateien. Die Benutzer können Dateien 
auch an einem anderen Speicherort auf dem Computer 
oder auf einem Netzwerklaufwerk speichern.

CustomProfiles/
(Benutzer-
definierte Profile)

Standardverzeichnis für die von den Benutzern 
�gespeicherten benutzerdefinierten Profile. Die 
Benutzer können Dateien auch an einem anderen 
Speicherort auf dem Computer oder auf einem 
Netzwerklaufwerk speichern.

Dateien, die geändert werden können, die jedoch für alle Benutzer verfüg-
bar sind, sind in C:\Programme\Sartorius Stedim Biotech\Cryopilot 5 
gespeichert. 

Komponente Beschreibung

log.txt Datei, die zur Fehlerbehebung der Software

settings.xml Konfigurationsdatei

Das Cryopilot-Installationsprogramm installiert ferner mehrere zusätzliche 
Bibliotheken: Microsoft .NET Framework 4.6.1, National Instruments NI-
DAQmx und USB-Treiber.  

5.4	 Installation
Legen Sie zum Installieren der Cryopilot-Software die USB Flash Drive ein, 
und doppelklicken Sie auf „mysetup.exe“. Für die Installation sind 
Administratorrechte erforderlich. Wenden Sie sich an den System-
administrator, wenn Sie nicht über die erforderlichen Rechte verfügen.

Die Standardeinstellungen können normalerweise übernommen werden. 

Wenn der Installationsvorgang abgeschlossen ist, werden Sie zum Neustart 
des Computers aufgefordert.

HINWEIS
Es ist wichtig, dass der Computer konfiguriert wird, damit er nicht ange-
halten oder heruntergefahren wird, während ein Gefrier-| Auftauprozess 
ausgeführt wird.  

Windows 7 oder Windows 10: Rufen Sie „Systemsteuerung > System und 
Sicherheit > Energieoptionen“ auf. Wählen Sie „Höchstleistung“ aus. Klicken 
Sie auf „Energiesparplaneinstellungen ändern“, und klicken Sie dann auf 
„Erweiterte Energieeinstellungen ändern“. Legen Sie unter „Festplatte“ die 
Option „Festplatte ausschalten nach“ auf „Nie“ fest. Legen Sie unter „USB-
Einstellungen“ die Option „Einstellung für selektives USB-Energiesparen“ 
auf „Deaktiviert“ fest. Klicken Sie auf „OK“, und schließen Sie dann die 
Systemsteuerung. 
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5.5	 Benutzeroberfläche

5.5.1	 Hauptfenster
Das Hauptfenster ist der von der Cryopilot-Software hauptsächlich verwendete 
Bildschirm. Dieses Fenster umfasst Menüoptionen zur Interaktion mit dem 
Programm, ein Diagramm zur grafischen Anzeige von Prozessdaten sowie eine 
Legende zur Auswahl der Kurven, die im Diagramm angezeigt werden sollen.

6
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9

Abb. 14:  Hauptfenster

Pos. Steuerung Beschreibung

1 Titelleiste �Zeigt den Namen der Anwendung 
und den Namen der aktuellen Datei 
an, sofern zutreffend.

2 Menüleiste Enthält Menüs zur Durchführung 
allgemeiner Aufgaben.

3 Symbolleiste Enthält Schaltflächen zur 
Durchführung allgemeiner Aufgaben.

4 Statusleiste Zeigt den Status der Geräte an, 
entweder Online oder Offline.

5 Diagramm Zeigt eine Grafik der Temperatur in 
Relation zur abgelaufenen Zeit an.

6 �Anzeige der abgelaufenen 
Zeit

Zeigt an, wie viel Zeit seit 
Prozessbeginn vergangen ist.

7 Legendenpunkt HTF-Sollwert Zeigt den Sollwert des 
Wärmeträgermediums (HTF) an.

8 Legendenpunkt HTF-Zufuhr Zeigt die HTF-Isttemperatur an.

9 Legendenpunkt Produkt N Zeigt die Temperatur des N. Typ T-
Temperatursensors an. Je nach Hard-
ware können bis zu 16 Temperatur-
sensoren überwacht werden.
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5.5.2	 Das Dialogfeld „Start Process“ (Prozess starten)
Das Dialogfeld „Start Process“ (Prozess starten) fordert den Benutzer zur 
Eingabe von Informationen auf, die während des Prozesses verwendet 
werden.
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Abb. 15:  Das Dialogfeld „Start Process“ (Prozess starten)

Pos. Steuerung Beschreibung

1 Chart Title 
(Diagrammtitel)

�Titel, der oben im Diagramm angezeigt wird. 
Der Standard ist „Temperature vs. Elapsed 
Time“ (Temp-Zeit-Diagramm).

2 Data Filename 
(Dateiname)

�Der vollständige Dateiname, unter dem die 
Daten für diesen Prozess gespeichert werden. 
Der Standard ist [User Directory]\Data\[date 
code].cpd, wobei [date code] (Datencode) 
eine numerische Zeichenfolge bestehend aus 
Jahr, Monat, Tag, Stunde, Minute und 
Sekunde ist.

3 Wahlschalter Profile 
Type (Profiltyp)

�Bietet drei Optionen: None (Kein) – für kein 
Profil; Standard – für ein von Sartorius 
bereitgestelltes Standardprofil; oder Custom 
(Benutzerdefiniert) – für ein vom Benutzer 
erstelltes Profil.

4 Profile Filename 
(Profildateiname)

Der vollständige Dateiname, unter dem das 
benutzerdefinierte Profil zu finden ist.
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Pos. Steuerung Beschreibung

5 Description 
(Beschreibung)

Ein Feld zur Eingabe zusätzlicher 
Informationen zum Prozess.

6 Wahlschalter 
„Data Filename“ 
(Dateiname)

Öffnet ein Dialogfeld zur Auswahl eines 
Ordners und eines Dateinamens, in dem bzw. 
unter dem die Daten für diesen Prozess 
gespeichert werden.

7 Wahlschalter 
„Application“ 
(Anwendung)

Bietet sechs Optionen, wenn der Profiltyp 
„Standard“ ausgewählt ist: 

	— S3 30 mL – für S3-Modulsysteme mit zehn 
30-mL-Celsius® Paks – S3 100 mL – für 
S3-Modulsysteme mit zehn 100-mL-
Celsius® Paks

	— Cryowedge 12” 
	— Cryowedge 24” 
	— Cryowedge 30”
	— Cryowedge 34”

8 Wahlschalter 
„Process“ (Prozess)

Bietet drei Optionen, wenn der Profiltyp 
„Standard“ ausgewählt ist:

	—  Freeze (Einfrieren) – führt die Aktion „Nur 
einfrieren“ aus– Thaw (Auftauen) – führt 
die Aktion „Nur auftauen“ aus

	— �Freeze and Thaw (Einfrieren und Auftauen) 
– führt die Aktion „Einfrieren“ gefolgt von 
der Aktion „Auftauen“ aus

9 Wahlschalterselector 
„Profile Filenname“ 
(Profildateinamen) 

Öffnet ein Dialogfeld zur Auswahl eines 
Ordners und eines Dateinamens, in dem bzw. 
unter dem das benutzerdefinierte Profil zu 
finden ist.

10 Die Schaltfläche 
„Cancel“ 
(Abbrechen)

Verwirft die Daten und schließt das 
Dialogfeld, ohne den Prozess zu starten.

11 Die Schaltfläche 
„OK“

Übernimmt die Daten, schließt das Dialogfeld 
und startet den Prozess.
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5.5.3	 Das Dialogfeld „Options“ (Optionen)
Die Cryopilot-Software kann mithilfe des Dialogfelds „Cryopilot 
Configuration“ (Cryopilot-Konfiguration) konfiguriert werden. Wählen Sie 
im Hauptfenster die Menüoption „Tools“ (Extras) > „Options“ (Optionen).

1

6532 4

7

Abb. 16:  Dialogfeld „Options“ (Optionen) – Registerkarte „Zertifikat“

Pos. Steuerung Beschreibung

1 Zertifikatsliste �Zeigt eine Liste mit verfügbaren digitalen 
Zertifikaten an. Für jedes Zertifikat zeigt die 
Liste an, wer das Zertifikat ausgestellt hat, an 
wen das Zertifikat ausgestellt wurde, den 
Anzeigenamen sowie das Gültigkeitsdatum.

2 Schaltfläche 
„Create“ 
(Erstellen)

Erstellt ein selbst unterzeichnetes Zertifikat und 
installiert es im Ordner „Trusted Root 
Certification Authorities“ (Vertrauenswürdige 
Stammzertifizierungsstellen“).

3 Schaltfläche 
„View“ (Ansicht)

Zeigt weitere Einzelheiten für das ausgewählte 
Zertifikat an.

4 Schaltfläche 
„Manage“ 
(Verwalten)

Öffnet die Microsoft Management Console für 
weitere Zertifikatsverwaltungsaufgaben, wie 
das Erneuern und Löschen von Zertifikaten.

5 Schaltfläche „OK“ Übernimmt die Änderungen und schließt das 
Dialogfeld.

6 Schaltfläche 
„Cancel“ 
(Abbrechen)

Verwirft die Änderungen und schließt das 
Dialogfeld.

7 Registerkarte 
„Hardware“

Wechselt zur Registerkarte „Hardware“.
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1
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Abb. 17:  Options Dialog – Hardware Tab

Pos. Steuerung Beschreibung

1 Wahlschalter „Data 
Acquisition Device“ 
(Daten-
erfassungsgerät)

Die Option „None“ (Kein) konfiguriert die 
Anwendung auf „No Data Acquisition“ (Keine 
Datenerfassung). Wenn ein kompatibles 
National Instruments-Datenerfassungsgerät 
erkannt wird, wird es automatisch ausgewählt.

2 Wahlschalter 
„Chiller“ (Kühler)

�Durch Auswahl der Option „None“ (Kein) wird 
die Anwendung auf „Kein Kühler“ konfiguriert. 
 �Durch die Auswahl der Option „Huber 
Unistat“ wird die Anwendung auf die 
Datenerfassung von einem Huber-Kühler mit 
einem Unistat-Controller, wie einem 
Cryopilot A, konfiguriert.

3 Wahlschalter 
„COM Port“  
(COM-Anschluss)

Zeigt eine Liste der verfügbaren seriellen 
(COM-)Anschlüsse.

4 Wahlschalter 
„Shaker“ (Schüttler)

Die Option „None“ (Kein) konfiguriert die 
Anwendung auf „No Shaker“ (Kein Schüttler). 
Wenn ein Kabel, USB an Cryomixer, erkannt 
wird, wird es automatisch ausgewählt.

5 Schaltfläche „OK“ Übernimmt die Änderungen und schließt das 
Dialogfeld.
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Pos. Steuerung Beschreibung

6 Schaltfläche 
„Cancel“ 
(Abbrechen)

Verwirft die Änderungen und schließt das 
Dialogfeld.

7 Registerkarte 
„Certificates“ 
(Zertifikate)

Wechselt zur Registerkarte „Certificates“ 
(Zertifikate).

5.6	 Erste Schritte
Bevor ein Profil gestartet werden kann, muss die Software konfiguriert 
werden. Stellen Sie sicher, dass das Datenerfassungsgerät (DAQ) und der 
Kühler angeschlossen und hochgefahren sind. Wählen Sie dann die 
Menüoption „Tools“ (Extras) > „Options“ (Optionen), um das Dialogfeld 
„Options“ (Optionen) aufzurufen.

5.6.1	 Auswahl eines digitalen Zertifikats
Zunächst muss ein digitales Zertifikat ausgewählt werden. Cryopilot 
verwendet ein digitales Zertifikat zur Gewährleistung der Authentizität und 
Integrität der gespeicherten Dateien. Die Registerkarte „Certificates“ zeigt 
eine Liste der verfügbaren Zertifikate. Optimal ist die Verwendung eines von 
einer vertrauenswürdigen Zertifizierungsbehörde (Certification Authority, 
CA) ausgestellten Zertifikats. Wenn Ihre IT-Organisation bereits eine 
digitale Zertifikatinfrastruktur etabliert hat, kann sie möglicherweise ein 
Zertifikat für die Nutzung mit Cryopilot bereitstellen. 

Wenn Sie kein Zertifikat für die Nutzung mit Cryopilot haben, können Sie 
sich ein so genanntes „Self-Signed“-Zertifikat ausstellen. „Self-Signed“ 
bedeutet, dass die Person, die das Zertifikat ausstellt, auch für dessen 
Legitimität bürgt. Klicken Sie auf die Schaltfläche „Create“ (Erstellen) und 
dann im daraufhin eingeblendeten Dialogfeld auf die Schaltfläche „Yes“ 
(Ja). Das neu ausgestellte Zertifikat wird in der Liste der verfügbaren 
Zertifikate angezeigt.

5.6.2	 Konfiguration der Hardware
Als Nächstes muss die Hardware ausgewählt werden. Die Registerkarte 
„Hardware“ enthält Einstellungen für die allgemeinen 
Hardwarekonfigurationen. Die gängigste Kombination umfasst sowohl ein 
Datenerfassungsgerät (DAQ), einen Kühler als auch einen Schüttler. In den 
meisten Fällen wird die Hardware automatisch erkannt.

Wenn Sie keine Prozesse ausführen und Cryopilot nur zur Darstellung von 
Dateien verwenden, wählen Sie in allen Feldern, „Data Acquisition“ 
(Datenerfassung), „Chiller“ (Kühler) und „Shaker“ (Schüttler) die Option 
„None“ (Kein).

Zum Speichern der Optionen klicken Sie auf „OK“.
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5.6.3	 Programmfluss
Nach dem Starten der Cryopilot-Software wird kurzzeitig ein Ladebild-
schirm (Splash Screen) eingeblendet, dann wird das Hauptfenster 
angezeigt. 

An diesem Punkt ist die Software untätig und bleibt auch in diesem Status, 
bis der Benutzer einen Prozess startet. 

Zum Starten eines Prozesses wählen Sie die Menüoption „Process“ 
(Prozess) > „Start“ (Starten) oder klicken Sie in der Symbolleiste auf die 
Schaltfläche „Start Process“ (Prozess starten). Das Dialogfeld „Start 
Process“ (Prozess starten) wird angezeigt. Nachdem der Benutzer auf „OK“ 
geklickt hat, versucht die Software, eine Verbindung zum Datenerfassungs-
gerät, zum Schüttler und zum Kühler herzustellen, sofern konfiguriert. 
Wenn eines dieser Geräte konfiguriert, jedoch nicht angeschlossen ist, wird 
der Benutzer aufgefordert, die Anschlüsse zu überprüfen und den Vorgang 
erneut auszuführen oder abzubrechen. 

Wenn ein Prozess gestartet wurde, werden das Temperaturdiagramm und 
die Legende neu auf die Darstellung der entsprechenden Kurven 
konfiguriert, mit dem Kühler werden Kommunikationen eingeleitet und das 
Datenerfassungsgerät (DAQ) wird initialisiert. Wenn die Initialisierung 
abgeschlossen ist, verschwindet die Initialisierungsmeldung und der erste 
Satz Datenpunkte wird angezeigt. Die nachfolgenden Datenpunkte werden 
in demselben Sampling-Intervall - einem festen Intervall von 15 Sekunden 
- angezeigt.

Bei einer Konfiguration zur Verwendung eines Kühlers nutzt die Cryopilot-
Software die serielle Schnittstelle zum Versenden und Empfangen von 
Befehlen an den bzw. vom Kühler.

Während eines Prozesses wird der Verbindungsstatus in der unteren linken 
Ecke des Hauptfensters angezeigt. Eine grüne „Online“-Meldung zeigt an, 
dass eine gute Verbindung zwischen dem Datenerfassungsgerät und dem 
Kühler besteht. Eine rote „Offline“-Meldung zeigt eine fehlerhafte Verbin-
dung zwischen Datenerfassungsgerät und Kühler an. 

Mit der Schaltfläche „Stop Process“ (Prozess stoppen) wird die Daten-
erfassung beendet und der Kühler und der Mischer werden deaktiviert. 
Der Benutzer kann sich die Daten dann anzeigen lassen. Bevor der Benutzer 
einen anderen Prozess starten kann, muss die Datenanzeige geschlossen 
sein.
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5.6.4	 Darstellung von Daten
Cryopilot kann in Cryopilot 4 und Cryopilot 5 gespeicherte Dateien öffnen 
und darstellen. Beachten Sie, dass mit Cryopilot 4 erstellte Dateien nur zu 
Darstellungszwecken unterstützt werden. Alle neuen Dateien werden im 
Cryopilot 5-Format gespeichert, sodass sich die Datenintegrität und 
-authentizität über die digitale Signatur verifizieren lässt.

Es kann jeweils nur eine Datei geöffnet sein.

Zum Öffnen einer Datei gehen Sie folgendermaßen vor:
	t Klicken Sie in der Symbolleiste auf die Schaltfläche „Open“ (Öffnen)
	t Öffnen Sie das Menü „File“ (Datei) und klicken Sie auf „Open“ (Öffnen)
	t Verwenden Sie das Tastenkürzel Ctrl+O (Strg+O)

Wählen Sie im Dialogfeld „Open Data File“ (Datei öffnen) die Datei, die 
geöffnet werden soll. Wählen Sie den Dateityp aus der Dropdown-Liste 
„Files of type“ (Dateien vom Typ) aus. 

Cryopilot 5 nutzt digitale Signaturen als Nachweis, dass die Daten seit der 
ursprünglichen Speicherung nicht mehr modifiziert wurden. Lassen sich die 
Integrität und Authentizität der Datei nicht anhand einer digitalen Signatur 
verifizieren, werden Sie darüber informiert. Sie müssen dann wählen, ob Sie 
fortfahren oder den Vorgang abbrechen wollen. Es gibt zwei gängige Fälle, 
wann diese Meldung angezeigt wird:

	— Beim Öffnen einer Cryopilot 4-Datei. Cryopilot 4-Dateien umfassen 
keine digitale Signatur.

	— Wenn das zur Signierung der Datei verwendete Zertifikat nicht 
vertrauenswürdig ist. 

Nachdem die Datei geladen ist, wird das Diagramm mit den Daten der Datei 
gefüllt. Die Daten im Diagramm können so ausgewertet werden, als kämen 
sie aus einem Live-Prozess.

Wenn Sie mit der rechten Maustaste auf das Diagramm klicken und dann 
auf die Option „Review“ (Darstellen) klicken, können Sie im Diagramm nach 
links und rechts scrollen und die Werte für jede Kurve zu einem beliebigen 
Zeitpunkt verifizieren. Wenn die Darstellungslinie nach rechts oder links 
gescrollt wird, wird die Legende aktualisiert und zeigt somit den Zeitstempel 
und die Kurvenwerte für den jeweiligen Zeitpunkt an.
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5.6.5	 Verwendung des Diagramms
Das Diagramm ist eine grafische Darstellung der Temperatur-Zeit-Kurve zur 
verstrichenen Zeit für einen Zyklus (Durchgang). Die verstrichene Zeit wird 
auf der X-Achse in der Einheit Stunden angezeigt; die Temperatur wird auf 
der Y-Achse in der Einheit Grad Celsius angezeigt. Es ist eine Legende zur 
Identifizierung und Darstellung des aktuellen Wertes für jede Kurve 
vorhanden. 

Verschieben und Zoomen

Standardmäßig werden die Diagrammskalen automatisch an die 
verfügbaren Daten angepasst. Diese automatische Skalierfunktion lässt sich 
mithilfe der Optionen „Autoscale X“ (X automatisch skalieren) und 
„Autoscale Y“ (Y automatisch skalieren) aus dem Pop-up Menü aktivieren 
bzw. deaktivieren. Das Pop-up Menü wird durch klicken der rechten 
Maustaste auf das Diagramm aufgerufen. 

Die Skalenbreite lässt sich direkt durch das Ziehen der X- und Y-Achsen 
ändern. Die Diagrammanzeige lässt sich durch Ziehen des Diagramms mit 
der gedrückten linken Maustaste verschieben. Beim Ändern oder 
Verschieben der Skala wird die Funktion „Auto Scale“ (Automatisch 
skalieren) deaktiviert. Doppelklicken Sie auf das Diagramm, um die 
Funktion „Auto Scale“ (Automatisch skalieren) zu reaktivieren.

Legende

Die Legende identifiziert jede der Kurven im Diagramm. Jede Kurve verfügt 
über eine Legendenoption mit Name, Farbe, Einheiten und dem aktuellen 
Wert. Zum Ausblenden einer Kurve doppelklicken Sie auf ihre Legen-
denoption; diese wird dann gedimmt dargestellt. Zum Anzeigen der Kurve 
doppelklicken Sie erneut auf die Legendenoption. Dies kann hilfreich sein, 
wenn Dateien mit vielen Plots, die einander überlagern, betrachtet werden 
sollen.

„Review Mode“ - Darstellungsmodus

Im Darstellungsmodus kann der Benutzer die Daten an einem beliebigen 
Punkt während des Prozesses darstellen und prüfen. Der Darstellungs-
modus wird über das in Abbildung 19 dargestellte Popup-Menü aktiviert 
bzw. deaktiviert. Im Darstellungsmodus wird eine vertikale Linie im 
Diagramm dargestellt und die abgelaufene Zeit und die Legenden zeigen 
die Werte an, die dieser Diagrammposition entsprechen. 

5.6.6	 Datenexport
Cryopilot bietet zwei verschiedene Methoden zum Exportieren von Daten. 
Es kann ein Bild der aktuellen Diagrammansicht exportiert werden oder es 
können die Rohdaten zur Darstellung in einer Tabellenkalkulationsanwen-
dung exportiert werden.

Abb. 18:  Kontextmenü „Chart“ (Diagramm)
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Diagrammexport

Zum Exportieren des Diagramms wählen Sie die Menüoption „Edit“ (Bear-
beiten) > „Copy“ (Kopieren) > „Chart“ (Diagramm). Das Diagramm wird als 
Bitmap-Bild in die Zwischenablage von Windows kopiert. Das Diagramm 
kann durch die Auswahl von Edit (Bearbeiten) > Paste (Einfügen) oder 
durch Drücken des Tastenkürzels „Ctrl+V“ (Strg+V) in andere Anwendungen 
eingefügt werden. Diese Option ist hilfreich, wenn eine Momentaufnahme 
der Daten benötigt wird, beispielsweise in einer Folienpräsentation. Ver-
wenden Sie die Option Copy (Kopieren) > Data (Daten), wenn die Daten 
weiter analysiert werden sollen.

Datenexport

Zum Exportieren von Daten wählen Sie die Menüoption „Edit“ (Bearbeiten) 
> „Copy“ (Kopieren) > „Data“ (Daten). Die Rohdaten werden in einem 
tabulatorgetrennten Format in die Zwischenablage von Windows kopiert. 
Die Daten lassen sich durch Auswahl der Zielzelle und Wahl der Option Edit 
(Bearbeiten) > Paste (Einfügen) oder Drücken des Tastenkürzels „Ctrl+V“ 
(Strg+V) in Tabellenkalkulationsanwendungen wie Microsoft Excel oder 
OpenOffice Calc einfügen.

5.6.7	 Drucken
Cryopilot kann für die geöffnete Datei einen Bericht erstellen. Der Bericht 
ist eine Momentaufnahme der aktuellen Diagrammansicht, einschließlich 
Titel und Legende. Der Bericht kann in einer Vorschau am Bildschirm 
angezeigt oder an einen Drucker gesendet werden. Wenn Sie einen PDF-
Druckertreiber wie Adobe Acrobat auf Ihrem Computer installiert haben, 
können Sie den Bericht als PDF-Datei auf der Festplatte speichern.

Zum Drucken eines Berichts nutzen Sie eine der folgenden Möglichkeiten:
	t Klicken Sie in der Symbolleiste auf die Schaltfläche „Print“ (Drucken) 
	t Öffnen Sie das Menü „File“ (Datei) und klicken Sie auf „Print“ (Drucken)
	t Verwenden Sie das Tastenkürzel Ctrl+P (Strg+P)

Das Dialogfeld „Print“ (Drucken) wird aufgerufen. Darin werden Sie aufge-
fordert, den Zieldrucker und die Anzahl der Druckexemplare auszuwählen. 
Andere Einstellungen, wie Ränder („Margins“) und Papierformat („Paper 
Size“) können unter „Page Setup“ (Seite einrichten) konfiguriert werden. 
Klicken Sie auf OK, um den Bericht an den ausgewählten Drucker zu 
senden.
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5.6.8	 Profile
Die Cryopilot-Software steuert den Kühler und den Mischer nach der 
Vorgabe durch das Profil. Ein Profil ist ein Rezept mit Anweisungen zur 
Änderung des Kühler-Temperatursollwerts und des Mischermodus-
Sollwerts (ein | aus) als Funktion der Zeit. Die Cryopilot-Software verfügt 
über einen Satz Standardprofile, die für viele S3-Modul- und Cryowedge-
Anwendungen geeignet sind. 

Möglicherweise muss für eine bestimmte Anwendung ein neues Profil 
erstellt werden. Bei der Erstellung eines neuen Profils müssen einige 
Faktoren berücksichtigt werden:

	— Welche Aktionen sollen ausgeführt werden – Einfrieren, Auftauen oder 
beides?

	— Sind mehrere Einfrier- und Auftauzyklen erforderlich?
	— Wie ist die Anfangstemperatur des einzufrierenden oder aufzutauenden 

Materials? Wenn diese variabel ist, kann ein Äquilibrierungsschritt zum 
Start des Profils die Reproduzierbarkeit verbessern.

	— Sollen die Geräte nach Abschluss des Einfrier- | Auftauvorgangs 
weiterhin laufen? 

Die Einstellung der Gefrier- und Auftauraten erfolgt empirisch. Wenn ein 
tieferer Endpunkt für einen Gefriervorgang gewünscht wird, ist es ggf. 
erforderlich, die Dauer des endgültigen Sollwertes zu erhöhen oder die 
eingestellte Temperatur zu verringern. Verwenden Sie zum schnellen 
Auftauen ohne Überschreiten der Zieltemperatur („Overshoot“) einen 
hohen Temperatursollwert für eine kurze Dauer und senken Sie den 
Temperatursollwert dann ab, bevor die Zieltemperatur überschritten wird.

Profilbearbeitung

Profile lassen sich manuell mit Texteditoren (z. B. Microsoft Notepad) oder 
Tabellenkalkulationsprogrammen (z. B. Microsoft Excel) erstellen und 
bearbeiten. Verwenden Sie bei Verwendung eines Texteditors stets die 
Tabulatortaste zum Trennen der Spalten, nicht die Leertaste. Verwenden Sie 
nach der Eingabe des Mischerstatus für eine neue Zeile die Return- oder 
Eingabetaste (Enter).

Wenn Sie ein Standardprofil als Ausgangsprofil verwenden wollen, 
speichern Sie es unter einem neuen Dateinamen und nehmen erst dann 
Änderungen vor. 

Abb. 19:  Ein Profil in Microsoft Notepad
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Anlagenstatus nach dem letzten Schritt

Nachdem die Cryopilot-Software den letzten Schritt eines Profils 
ausgeführt hat, lässt sie Kühler und Mischer standardmäßig im Istzustand, 
bis der Benutzer das Profil durch Drücken der Taste „STOP“ (Stopp) stoppt. 
In einigen Fällen ist es hilfreich, Kühler und Mischer nach einiger Zeit zu 
deaktivieren. Dazu wird nach der Anweisung „STOP“ (Stopp) eine 
Anweisung „TURN CHILLER OFF“ (Kühler deaktivieren) gesetzt. Beachten 
Sie, dass dies nicht mit dem Cryopilot-Profileditor erfolgen kann; es muss 
manuell mit einem Texteditor oder einer Tabellenkalkulationsanwendung 
vorgenommen werden. Das folgende Profil schaltet den Kühler und den 
Mischer beispielsweise nach 311 Minuten aus:

0	 –40	 OFF
310.00	 –60	 OFF
STOP
311.00	 TURN CHILLER OFF

Die Anweisung „TURN CHILLER OFF“ (Kühler ausschalten) ist im 
Cryopilot-Profileditor sichtbar, es ist ihr jedoch keine Temperatur 
zugewiesen.

Dateiformat

Profile werden als tabulatorgetrennte Dateien auf der Festplatte gespei-
chert. Die Zeichenverschlüsselung ist ASCII und beim Dateiformat wird 
nicht zwischen Groß- und Kleinschreibung unterschieden. Alle Zeilen, die 
vor dem Eintrag „START“ stehen, sind eine Beschreibung der Datei. Das 
bedeutet, dass die Beschreibung den Begriff „Start“ nicht enthalten darf. 
Zwischen dem Eintrag „START“ und dem optionalen Eintrag „STOP“ (Stopp) 
stellt jede Zeile einen Schritt im Profil dar. ntifiziert, wann der Schritt 
beginnen soll; sie wird in der Einheit Minuten (abgelaufende Minuten) 
angegeben und wird als Dezimalwert ausgedrückt. Die Startzeit des ersten 
Schrittes muss 0 sein; die Startzeiten nachfolgender Schritte muss sich 
monotonisch erhöhen. Zu beachten ist, dass sich die Startzeit für jeden 
Schritt auf die Profilstartzeit bezieht. Drei 30-Minuten-Schritte hätten als 
Startzeiten 0, 30 und 60. Der Kühlersollwert wird in der Einheit °C und als 
Dezimalwert ausgedrückt. Wenn ein Eintrag „STOP“ (Stopp) vorhanden ist, 
kann die nächste Zeile ein Eintrag „TURN CHILLER OFF“ (Kühler aus-
schalten) sein. 
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Die folgende Syntax wird zur Beschreibung des Dateiformats verwendet:
\n	� Zeichen für eine neue Zeile, hier als CRLF definiert
\s	� Null oder mehr Whitespace-Zeichen
\t	 Tabulatorzeichen
<variable>	 Variables Element
[FOO]	 Optionales Element
OFF|ON	� Aufzählungswert, das Element muss eins von beiden sein
...	� Zeigt eine Wiederholungsstruktur an

Format:
[<description>\n]
START\s\n
<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n
.
.
.
[STOP\n
[<start time>\tTURN CHILLER OFF]]

Beispiel (implizierte \n):
Dies ist ein Testprofil bestehend aus drei Schritten:
START
0	 –20	 OFF
30	 –60	ON
200	 10	 OFF

5.6.9	 Dateien
Während eines Zyklus | Vorgangs überwacht die Cryopilot-Software die 
Komponenten des Benchtop-Systems und erfasst die Hauptprozesswerte 
in einer Datei auf dem Computer.

Die Cryopilot 5-Software kann Dateien öffnen, die mit Cryopilot 4 erstellt 
wurden, sowie Dateien, die mit Cryopilot 5 erstellt wurden. Alle neuen 
Dateien, die mit Cryopilot 5 gespeichert werden, werden jedoch im 
Cryopilot 5-Format gespeichert. Die Datei enthält folgende Prozesswerte:

	— Den Temperatursollwert und die Isttemperatur des Wärmeübertragungs-
mediums für das Kühler-Wärmeübertragungsmedium

	— Den Kühlermodus (On | Off (Ein | Aus))
	— Den Mischermodus (On | Off (Ein | Aus)) 
	— Die Temperatur von bis zu 14 Typ T Temperatursensoren 

Standardmäßig haben Cryopilot 5-Dateien die Dateierweiterung .cpd. Eine 
Cryopilot-Datei ist eine ZIP-Datei, die zwei Dateien enthält:

	— data.txt, eine tabulatorgetrennte Datei 
	— data.txt.p7s, eine digitale Signatur im PKCS7-Format 

Tabellenkalkulationsprogramme wie Microsoft Excel können die tabulator-
getrennte Datei importieren, es ist jedoch einfacher, die Daten mit der 
Menüoption „File“ (Datei) > „Copy“ (Kopieren) > „Data“ (Daten) zu übertra-
gen. Versuchen Sie nicht, die Datei für einen laufenden Zyklus | Vorgang zu 
öffnen, da die Tabellenkalkulationsanwendung die Datei schließen und 
somit verhindern kann, dass die Cryopilot-Software weitere Daten in die 
Datei schreibt.
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Dateiformat

Die Datei data.txt und die Ergebnisse des Befehls File (Datei) > Copy 
(Kopieren) > Data (Daten) enthalten beide tabulatorgetrennten Text. Die 
Zeichenverschlüsselung ist ASCII und beim Dateiformat wird nicht zwischen 
Groß- und Kleinschreibung unterschieden. Die erste Zeile muss, wie nach-
folgend dargestellt, den Ersteller und die Version enthalten. Alle Tempera-
turwerte sind in der Einheit °C angegeben.

Die folgende Syntax wird zur Beschreibung des Dateiformats verwendet:
\n	� Zeichen für eine neue Zeile, hier als CRLF definiert
\s	� Null oder mehr Whitespace-Zeichen
\t	 Tabulatorzeichen
<variable>	 Variables Element
[FOO]	 Optionales Element
OFF|ON	� Aufzählungswert, das Element muss eins von beiden sein
...	� Zeigt eine Wiederholungsstruktur an

Beachten Sie, dass die Zeiten als UCT (Universal Coordinated Time) 
angegeben sind; diese kann sich je nach Ihrer Zeitzone von der Lokalzeit 
unterscheiden. 

Wenn keine Daten verfügbar sind, enthält die Datei das Symbol „NaN“ 
(Not a Number; Keine Zahl).

Format:
Cryopilot 5.0\n
METADATA\n
Title\t<title>\n
Process Start\t<timestamp format=yyyy-MM-dd HH:mm:ssZ>\n
Computer\t<computer name>\n
User\t<user name>\n
Description\t<description>\n
START\n
Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply Tempera-
ture Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\tProduct Tem-
perature 1(C)\tProduct Temperature 2(C)\t...Product Temperature n(C)\n

<timestamp format=yyyy-MM-dd HH:mm:ssZ>\t<elapsedhours 
format=0.000000>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n
.
.
.
.
.
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Beispiel mit vier Temperatursensoren (implizierte \n):

Cryopilot 5.0
METADATA
Title	 Temperature vs. Elapsed Time
Process Start	 2009-03-03 21:49:22Z
Computer	 DEMO_LAPTOP
User	 DEMO_LAPTOP\Administrator
Description	
START
Date/Time(UTC)	 Elapsed Time(h)	 Chiller Status	 HTF Supply Temperature  
Setpoint(C)	 HTF Supply Temperature(C)	 Mixer Status	Product 1  
Temperature(C)	 Product 2 Temperature(C)	 Product 3 Temperature(C)	  
Product 4 Temperature(C)
2009-03-03 21:49:31Z	 0.002500	 On	 0.0	 21.0	 On	 22.8	 25.4	 NaN	 NaN
2009-03-03 21:49:46Z	 0.006667	 On	 0.0	 20.7	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:01Z	 0.010833	 On	 0.0	 20.3	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:16Z	 0.015000	 On	 0.0	 20.0	 On	 22.8	 25.2	 NaN	 NaN
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5.6.10	 Diagnostik | Fehlersuche
Fehler- und Statusmeldungen werden im Meldungsbereich in der unteren 
rechten Ecke des Hauptfensters angezeigt. Dieser Abschnitt beschreibt 
gängige Fehler und mögliche Gegenmaßnahmen.

Kühler

Bei Problemen mit dem Kühler können folgende Schritte hilfreich sein:

	t Überprüfen Sie beide Enden des seriellen Kabels zwischen Computer 
und Kühler.

	t Überprüfen Sie das Fehlerprotokoll des Kühlers. Weitere Informationen 
finden Sie in der Gebrauchsanweisung zum Huber Unistat 705.

	t Stellen Sie sicher, dass die Kommunikationseinstellungen des Kühlers 
korrekt konfiguriert sind. Der Cryopilot A sollte für die Nutzung der 
Baud-Rate (Übertragungsgeschwindigkeit) 9600 und des Protokolls 
RS-232 konfiguriert sein. Weitere Informationen finden Sie in der 
Gebrauchsanweisung zum Huber Unistat 705.

	t Als letzte Maßnahme beenden Sie die Cryopilot-Software, schalten den 
Kühler aus und wieder ein und starten die Cryopilot-Software neu. 
Versuchen Sie, die Ursache für das Problem herauszufinden, bevor Sie 
einen weiteren Zyklus | Vorgang starten. Stellen Sie sicher, dass die 
Einstellungen im Dialogfeld „Options“ (Optionen) korrekt sind.

Wenn es während eines Zyklus | Vorgangs zu einem Stromausfall kommt, 
kann der Kühler von der Netzversorgung getrennt werden oder die Daten 
des Kühlers können beschädigt werden. Das Vorhandensein von NaN (Not 
a Number; Keine Zahl) in den Temperaturfeldern der Datei ist ein weiteres 
Anzeichen für einen Kühlerfehler. 

Schüttler

Wenn sich der Schüttler nicht bewegt, wenn er es sollte, können folgende 
Maßnahmen Abhilfe schaffen:

	t Überprüfen Sie das Kabel zwischen Computer und Schüttler.
	t Stellen Sie sicher, dass der Modusschalter auf der Mischerrückseite in 

der Stellung „Auto“ steht.
	t Stellen Sie sicher, dass die Hubzahleinstellung korrekt ist.
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Datenerfassungsgerät | Temperatursensoren

Nachfolgend finden Sie gängige Fehler der Datenerfassungshardware oder 
der Temperatursensoren:

	— Ein Sensor reagiert nicht auf Temperaturänderungen, wie es die anderen 
Sensoren tun.

Wenn das oben genannte Problem auftritt, können folgende Maßnahmen 
möglicherweise Abhilfe schaffen:
	t Stellen Sie sicher, dass der fragliche Sensor an der korrekten Buchse an 

der Kabelpeitsche des Thermoelements, die mit dem 
Datenerfassungsgerät verbunden ist, angeschlossen ist. 

	t Stellen Sie sicher, dass jeder Sensor korrekt positioniert und fixiert ist. Ein 
kleiner Positionsfehler kann im Vergleich mit anderen Sensoren zu 
großen Abweichungen führen. 

	t Überprüfen Sie die Verbindungen und Anschlüsse zwischen dem 
Computer und dem Datenerfassungsgerät.

	t Möglicherweise ist ein Sensor beschädigt. Überprüfen Sie den Sensor 
mit einem kalibrierten Messgerät (z. B. Fluke 725), mit dem sich 
Thermoelemente vom Typ T messen lassen.

5.6.11	 21 CFR, Teil 11
Die Cryopilot 5-Software wurde in Anlehnung an die Anforderungen des 
Kodex 21 CFR, Teil 11 entwickelt.

Für den Nachweis der Authentizität und der Integrität von Cryopilot 
5-Dateien, selbst bei offenen (d. h. nicht vertrauenswürdigen) Systemen, 
werden digitale Signaturen verwendet. Die Begriffe „digitale Signatur“ und 
„elektronische Signatur“ sollten nicht verwechselt werden. Eine digitale 
Signatur ist ein Verschlüsselungsverfahren, wohingegen eine elektronische 
Signatur das elektronische Äquivalent einer handgeschriebenen Signatur 
mit rechtlichen Implikationen ist. Die Verweise auf elektronische Signaturen 
im Kodex 21 CFR, Teil 11 gelten nicht für die digitalen Signaturen, die in 
Cryopilot 5-Dateien verwendet werden.

Einige allgemeine Hinweise zur Implementierung:
	— Cryopilot 5 nutzt die Kontoverwaltungs-, Authentifizierungs- und 

Autorisierungsfunktionen des jeweiligen Betriebssystems. 
	— Der von Cryopilot 5 verwendete digitale Signaturalgorithmus ist SHA-1 

mit RSA; geschrieben im PKCS#7-Format.
	— Das Dateisystem wird als nicht vertrauenswürdiges System behandelt. 
	— Wenn ein Prozess gestoppt wird, wird die Datei geschlossen und sie lässt 

sich nicht mehr öffnen und ändern. Jede Veränderung der Daten durch 
andere Mittel, ungeachtet dessen, ob diese versehentlich oder 
vorsätzlich erfolgt, wird vom digitalen Signaturmechanismus erkannt.

	— Wenn die Daten aus Cryopilot (beispielsweise in eine Tabelle) exportiert 
werden, kann ihre Authentizität und Integrität nicht mehr länger 
gewährleistet werden.
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6	 Systembetrieb

6.1	 Vorbereitung für einen Zyklus

6.1.1	 Cryowedge
So bereiten Sie den Cryowedge vor:
	t Entfernen Sie die obere Hälfte der isolierten Cryowedge-Abdeckung.
	t Entfernen Sie die Flügelmuttern, mit denen die transparente Abdeckung 

fixiert ist, und legen Sie sie zur Seite.
	t Entfernen Sie die transparente Abdeckung. Befüllen Sie den Cryowedge 

mithilfe eines Messzylinders mit der Testlösung. Die Standardvolumen 
für die jeweiligen Cryowedge-Größen sind wie folgt:

Cryowedge-Größe Volumen (mL)

CW20 (12“) 350

CW125 (20“) 650

CW300 (30“) 3000

CW300 (34“) 4000

	t Setzen Sie die transparente Abdeckung wieder auf.
	t Bringen Sie die Flügelmuttern wieder an und ziehen Sie sie von Hand an. 

Ziehen Sie sie nicht zu stark an und überdrehen Sie die Gewinde nicht.
	t Setzen Sie die obere Hälfte der isolierten Cryowedge-Abdeckung 

wieder auf.
	t Stellen Sie sicher, dass das Kabel des Cryomixer Jr. am Cryomixer Jr. und 

am Computer angeschlossen ist.
	t Stellen Sie sicher, dass wenigstens sechs Thermoelemente auf der 

Rückseite des Datenerfassungsgeräts angeschlossen sind, beginnend 
mit der Position 1.

	t Setzen Sie fünf der Temperatursensoren durch die vorgebohrten Löcher 
in die transparente Abdeckung ein. Fixieren Sie die Temperatursensoren 
mit Kunststoffabstandshaltern oder mit abgetrennten Silikonrohr
materialstücken unterhalb der Testlösungsoberfläche.

	t Platzieren Sie den sechsten Temperatursensor als Referenztemperatur 
an den Außenflächen des Cryowedges oben auf die transparente 
Abdeckung.

	t Dokumentieren Sie die Nummer und die Position eines jeden 
Temperatursensoren zur späteren Bezugnahme.
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6.1.2	 S3-Modul
Celsius® Paks werden durch Gammastrahlung vorsterilisiert geliefert. Sie 
verfügen über Luer-Anschlussbuchsen und Kappen an 2 Befüll- | 
Ablassanschlüssen. Auch eine Ausführung mit C-Flex®-Rohrverlängerungs
elementen ist für ein steriles Befüllen erhältlich. Alle Celsius® Paks verfügen 
über ein geschlossenes Silikon- | EVA-Schutzrohr zur Einführung einer 
Temperatursonde. 

Um einheitliche Ergebnisse zu erhalten, bestücken Sie das S3-Modul stets 
mit derselben Anzahl an Celsius® Paks. Stellen Sie sicher, dass jedes 
Celsius® Pak auf dasselbe Volumen befüllt ist. Der Temperatursensor sollte 
jedes Mal in derselben Tiefe platziert werden.

Die Standard-Gefrierprofile, die die Cryopilot-Software bietet, sind auf 
10 Celsius® Paks mit einem Fassungsvermögen von entweder 30 oder 
100 mL ausgelegt, die auf das Nennvolumen befüllt sind. Platzieren Sie die 
Temperatursensoren in einer Mindesttiefe von 1 cm unter der Flüssigkeits-
oberfläche der Celsius® Paks. Leere Celsius® Paks sollten mit Musterpuffer 
befüllt werden. Verwenden Sie in den ansonsten leeren Füllkörpern kein 
entionisiertes Wasser, da dieses üblicherweise unterkühlt wird. Wenn Sie 
weniger als 10 Celsius® Paks verwenden, erfolgt das Gefrieren schneller und 
das Profil lässt sich nicht direkt auf größere Einheiten | Mengen übertragen.

Schritt-für-Schritt-Verfahren zur Vorbereitung, Befüllung und Bestückung 
der Celsius® Paks:

	t Bereiten Sie die Probe und | oder den Puffer für das Befüllen der 
Celsius® Paks vor.

	t Schieben Sie das Etikett in den Etikettenhalter unten am Celsius® Pak. 
Ein Etikett mit den Maßen ~2 x 5 cm passt vollständig in den Etiketten-
halter. Es wird empfohlen, wasserfestes Material und wasserfeste Tinte 
für die Etikettbeschriftung zu verwenden. Schreiben Sie nicht auf die 
Celsius® Paks, da die in der Tinte verwendeten Lösungsmittel das 
Celsius® Pak penetrieren und das Produkt kontaminieren können.

	t Verwenden Sie zum Befüllen der Celsius® Paks mit der Probe oder dem 
Puffer durch einen der Befüllungs- | Ablassanschlüsse eine Spritze oder 
eine Peristaltikpumpe. Schließen Sie die Spritze oder Pumpe über einen 
Luer®-Anschlussnippel oder per Schweißverbindung an der optionalen 
C-Flex®-Leitung an.

	t Befüllen Sie die Celsius® Paks mit einem maximalen Volumen von 30 mL 
(30-mL-Celsius® Pak) oder 100 mL (100-mL-Celsius® Pak). 

 VORSICHT
Befüllen Sie die Celsius® Paks nicht zu sehr und entfernen Sie nicht jegliche 
Luft im oberen Teil des Celsius® Paks, da dies eine Ausdehnung von Probe 
und Eis in die Anschlussleitungen bewirkt.

	t Verschließen Sie die Füllleitung mit der im Lieferumfang enthaltenen 
Luer®- Kappe oder einer Klemme.

	t Wischen Sie vor einem Gefriervorgang überschüssige Feuchtigkeit von 
allen Oberflächen im S3-Modul ab.
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Celsius® Paks werden über einen Federklemmenmechanismus im S3-Modul 
gehalten. Dieser fungiert als aktive Wärmeleitungsoberfläche. Führen Sie 
die folgenden Schritte zur Bestückung des S3-Moduls durch:

	t Befestigen Sie den Temperatursensorhalter am Celsius® Pak. Dazu 
richten Sie die Luer-Lock-Anschlussbuchse am Temperatursensorhalter 
mit dem Luer-Lock-Anschlussnippel oben an der Thermometerhülse 
aus. Nach der Befestigung des Luer-Locks an die Thermometerhülse 
muss die Vorderseite des Temperatursensorhalters in dieselbe Richtung 
zeigen wie das vordere Etikett des Celsius® Paks.

	t Messen Sie 1 cm vom Ende des Temperatursensors ab und setzen Sie an 
dieser Stelle eine Markierung für die Platzierung des Temperatursensors 
im Celsius® Pak. 

	t Schrauben Sie die Sicherungsmanschette des Temperatursensors 
langsam ab. Achten Sie dabei darauf, die beiden kleinen O-Ringe aus der 
Sicherungsmanschette einzusammeln. Schieben Sie die Sicherungs-
manschette und die beiden O-Ringe über das Ende des Temperatursen-
sors und drehen Sie die Sicherungsmutter gerade so weit herunter, dass 
sie nicht vom Temperatursensorhalter abfällt.

	t Führen Sie den Temperatursensor in die Thermometerhülse ein. 
Drücken Sie nie so stark, dass der Sensor durch das Ende der Hülse hin-
durchdrückt. Für eine präzise Wärmeüberwachung platzieren Sie die 
Temperatursensoren stets 1 cm unter der Oberfläche der Flüssigkeit im 
Celsius® Pak. Dies erreichen Sie, wenn die Markierung am Temperatur-
sensor mit der Flüssigkeitsoberfläche übereinstimmt. 

	t Ziehen Sie die Sicherungsmanschette an, um den Temperatursensor in 
der Hülse zu fixieren.

	t Stellen Sie sich mit Blick auf die linke Seite des S3-Moduls. Setzen Sie ein 
Celsius® Pak in den Klemmmechanismus ein, beginnen Sie hierbei am 
Steckplatz 10; dem Steckplatz, der sich am weitesten von der HTF-Zu- 
und Rückleitung entfernt befindet. Öffnen Sie die Klemmen, indem Sie 
den Klemmenwerkzeugschlüssel über die 2 Führungsstifte an den 
2 Edelstahl-Klemmblöcken des Steckplatzes führen und es dann nach 
unten drücken.

Abb. 20:  Am Celsius® Pak befestigter Thermoele-
menthalter

Abb. 21:  Thermoelement 1 cm unter der 
Flüssigkeitsoberfläche
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	t Schieben Sie beim Herunterdrücken des Klemmenwerkzeugschlüssels 
jede Seite des Celsius® Pak zwischen einem schwarzen Block und einem 
Edelstahl-Klemmblock des Klemmmechanismus hinunter. Richten Sie 
die Oberseite des Celsius® Paks so aus, dass es bündig mit der Oberseite 
der schwarzen Metallstange des Klemmmechanismus abschließt. Be-
achten Sie, dass das Celsius® Pak nach links weisen muss, um korrekt in 
das S3-Modul eingesetzt werden zu können.

	t Ziehen Sie den Klemmenwerkzeugschlüssel zurück. Das Celsius® Pak 
wird auf jeder Seite fest zwischen zwei Metallblöcken gehalten – einem 
schwarzen und einem aus Edelstahl. Schließen Sie die Temperatur
sensorenstecker an der entsprechenden Temperatursensoren-
Anschlussleiste an.

Abb. 22:  Öffnung des Klemmmechanismus

Abb. 23:  Montage des Thermoelementhalters 
und des Celsius® Paks
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Abb. 24:  Platzierung der Celsius® Paks und Anschluss der Thermoelemente

	t Wiederholen Sie diesen Vorgang von Steckplatz 9 bis Steckplatz 1. 
Die Abbildung zeigt ein Diagramm mit der endgültigen Platzierung aller 
Celsius® Paks und Temperatursensoren.

HINWEIS
Bestücken Sie das S3-Modul aus Gründen der Reproduzierbarkeit stets 
mit derselben Anzahl an Celsius® Paks, befüllen Sie jedes Celsius® Pak stets 
mit derselben Menge an Probe oder Puffer und platzieren Sie die 
Temperatursensoren in den Temperaturfühlerhülsen jeweils 1 cm unter der 
Flüssigkeitsoberfläche. Alle bei Sartorius entwickelten Gefrierprofile lassen 
sich nur mit einem vollständig bestückten System (10 Celsius® Paks) korrekt 
ausführen. Daher sind Ergebnisse, die mit den Gefrierprofilen der 
Installationssoftware gewonnen werden, direkt auf 16,6 Liter skalierbar. 
Eine Änderung der Anzahl an Celsius® Paks beeinträchtigt die Skalierbarkeit 
dieser Profile.

	t Vermerken Sie die Position und die Nummer eines jeden 
Temperatursensors in einem Labornotizbuch bzw. gemäß der 
Unternehmensrichtlinie.

	t Schließen und verriegeln Sie die Abdeckung des S3-Moduls.

Temperatursensor-Anschlussleiste

Steckplatzposition des befüllten Celsius® Paks
HTF- 
Einlass

HTF- 
Auslass

Abb. 25:  Platzierung der Heizelemente und Celsius® Paks im S3-Modul
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6.2	 Ausführung eines Profils

HINWEIS
Stellen Sie beim Abtauen mit dem S3-Modul sicher, dass die 4 Montage-
knöpfe des S3-Moduls fest angezogen sind und dass das Modul fest auf der 
Cryomixer Jr.-Platte fixiert ist.

 VORSICHT
Überschreiten Sie beim Cryomixer Jr. nie den Wert von 120 U/Min.

	t Doppelklicken Sie zur Initialisierung der Cryopilot-Software auf das 
Cryopilot-Softwaresymbol.

	t Wählen Sie zum Aufrufen des Dialogfeldes „Start Process“ (Prozess 
starten) die Menüoption „Process“ (Prozess) > „Start“.

	t Geben Sie der Datei, in der die Zeit und die Temperaturdaten für den 
neuen Prozess gespeichert werden, einen Namen. 

	t Wählen Sie den Standard-Profiltyp sowie Ihre Anwendung und Ihre 
gewünschte Aktion aus (Gefrieren, Abtauen oder Gefrieren und 
Abtauen). Wählen Sie alternativ ein benutzerdefiniertes Profil aus.

	t Klicken Sie auf die Schaltfläche „OK“ um den Prozess zu starten.
	t Stellen Sie sicher, dass das Kühlaggregat auf die Software-Befehle 

reagiert. Die Statusanzeige in der unteren linken Ecke sollte „Online“ 
zeigen. Bevor der Kompressor startet und die Temperaturregelung 
aktiviert wird, kommt es zu einer 2- bis 5‑minütigen Verzögerung.

	t Lassen Sie das Profil bis zum Ende der programmierten Dauer 
durchlaufen.

	t Wählen Sie die Menüoption „Process“ (Prozess) > „Stop“ (Stopp), um 
den Prozess zu stoppen. 
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6.3	 Entnahme der gefrorenen Celsius® Paks aus 
dem S3-Modul

In einigen Fällen ist es wünschenswert, Celsius® Paks im gefrorenen Zustand 
aus dem S3-Modul zu entnehmen.

	t Entfernen Sie die transparente Abdeckung des S3-Moduls. 

HINWEIS
Wenn das Gerät über einen längeren Zeitraum bei kalten Temperaturen 
offen gelassen wird, bildet sich Reif auf den Klemmen, den Celsius® Paks 
und den Temperatursensorhaltern, wodurch eine Entnahme der 
Celsius® Paks erschwert wird. Entnehmen Sie die gefrorenen Celsius® Paks 
schnell, sobald das Gerät geöffnet ist, und setzen Sie die Abdeckung dann 
wieder auf.

	t Entnehmen Sie die Temperatursensoren aus den Celsius® Paks. Wenn 
sich ein Temperatursensor nicht leicht herausziehen lässt, drehen Sie ihn 
vorsichtig, bis er sich löst. Entfernen Sie den Temperatursensorhalter aus 
jedem Steckplatz. Wenn sich Kondensation auf den Klemmenoberflä-
chen niederschlägt, bildet sich eine „Eisbrücke“ zwischen den 
Temperatursensorhaltern und den Kühlblöcken aus schwarzem Metall. 
Dadurch wird eine Entnahme der Temperatursensorhalter fast unmög-
lich. Wischen Sie vor Beginn eines Gefriervorgangs die überschüssige 
Feuchtigkeit von allen Oberflächen ab. 

	t Entnehmen Sie die gefrorenen Celsius® Paks mithilfe des Klemmen-
werkzeugschlüssels aus dem S3-Modul, indem Sie die Celsius® Paks nach 
oben herausschieben. Legen Sie sie in einen isolierten Transportbehälter.

	t Lagern Sie die gefrorenen Celsius® Paks im Gefrierschrank in einem 
Schutzbehälter bei Solltemperatur. Wenn Sie Stabilitätsprüfungen oder 
Rezepturstudien durchführen, ist die Verwendung eines geregelten 
Gefrierschranks mit Wärmeüberwachung die optimale Lösung.

6.4	 Lösen von aufgetauten Proben aus dem 
S3-Modul

	t Entnehmen Sie die Temperatursensoren und die Temperatursensorhal-
ter. 

	t Entnehmen Sie die aufgetauten Celsius® Paks aus dem S3-Modul.
	t Drehen Sie jedes Celsius® Pak drei Mal um, um ein homogenes 

Produktgemisch zu gewährleisten.
	t Entnehmen Sie die gewünschte Probenmenge aus dem Celsius® Pak. 

Verwenden Sie dazu den bisher nicht verwendeten 
Befüllungs- | Ablassanschluss. Die Entnahme kann mithilfe einer Spritze, 
einer Pumpe oder durch Ablassen per Schwerkraft erfolgen.

	t Entsorgen Sie gebrauchte Celsius® Paks. Die Celsius®s-Paks verformen 
sich während des Gefrier- und Auftauvorgangs gelegentlich und lassen 
sich dann beim Wiederverwenden nicht gut in den Klemmmechanismus 
einspannen. Dies kann eine schlechte Wärmeleitung bedingen und zu 
einer längeren Gefrier- und Auftaudauer führen.
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7	 Systemwartung
Die Wartung kann vom Endbenutzer oder von Sartorius vorgenommen 
werden. Wenden Sie sich zur Einrichtung eines Präventiven 
Wartungsvertrages an die Service-Abteilung von Sartorius.

Wenn ein Problem auftritt, lesen Sie bitte zunächst den Abschnitt zu den 
Fehlercodes in der Gebrauchsanweisung zum Huber Unistat 705. Wenn Sie 
das Problem nicht beheben können, wenden Sie sich an den Kundendienst 
(siehe Seite 93).

7.1	 Reinigung
Freiliegende Geräteoberflächen können generell mit Isopropylalkohol ein-
gesprüht und abgewischt werden. Edelstahloberflächen können optional 
mit einer Edelstahlpolitur gereinigt werden.

Der Schrankinnenraum des S3-Moduls enthält viele Komponenten aus 
eloxiertem Aluminium, die nicht mit basischen Lösungen wie Natronlauge 
(NaOH) oder Oxidationsmitteln kompatibel sind. Diese Stoffe sollten nicht 
für eine Reinigung des Schrankinnenraums verwendet werden. Statt dessen 
werden Isopropylalkohol oder andere nicht oxidierende Reinigungs
lösungen empfohlen, wenn eine Reinigung erforderlich ist.

7.2	 Wechsel des Wärmeträgermediums HTF
Wechseln Sie das Wärmeträgermedium HTF, wenn es sichtbar durch 
Wasser oder Partikel kontaminiert ist oder wenn Sie einen Abfall der 
Wärmeübertragungsleistung feststellen (d. h. wenn das Gerät die 
Sollwerttemperatur nicht mehr erreicht oder halten kann). Wechseln Sie 
stets die gesamte HTF-Menge. Wenn nach dem HTF-Wechsel keine 
Verbesserung der Wärmeübertragungsleistung festgestellt wird, wenden 
Sie sich an den Kundendienst (siehe Seite 93).
Gehen Sie zum Wechsel des HTF folgendermaßen vor:
	t Stellen Sie sicher, dass das HTF-Ablassventil des Systems an der 

Gerätevorderseite geschlossen ist. Der Schlitz im Schraubdeckel ist im 
geschlossenen Zustand vertikal ausgerichtet. Siehe „Abb. 10 HTF-
Ablassventil und Dichtschrauben des Cryopilot A“, Seite 62.

	t Entfernen Sie die Dichtschraube der vorstehenden Edelstahlleitung links 
am Gerät und schließen Sie einen Flexischlauch am Leitungsende an. 
Fixieren Sie ihn fest mit einer Schlauchschelle.

	t Hängen Sie das entfernte Leitungsende in einen Behälter, der 
wenigstens 12 L HTF fasst.

	t Öffnen Sie das HTF-Ablassventil, indem Sie es entgegen dem Uhr
zeigersinn drehen, bis der Schlitz horizontal ausgerichtet ist.

	t Versuchen Sie nach Möglichkeit, den Cryowedge oder das S3-Modul 
anzuheben, um restliches HTF aus dem Anlagenmodul zurück in den 
Cryopilot A fließen zu lassen.

	t Wenn kein HTF mehr fließt, schließen Sie das HTF-Ablassventil, 
entfernen den Schlauch von der Dichtschrauben-Leitung und bringen 
die Dichtschraube wieder an.  

	t Befüllen Sie das Cryopilot A-System gemäß dem im Kapitel „4.7 
Befüllung mit Wärmeträgermedium HTF”, Seite 61 beschriebenen 
Verfahren mit neuem HTF.
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8	 Informationen und 
Anweisungen zur Entsorgung 
und Reparatur

Wird die Verpackung nicht mehr benötigt, ist diese der örtlichen Müllent-
sorgung zuzuführen. Die Verpackung besteht aus umweltfreundlichen 
Materialien, die als Sekundärrohstoffe dienen können.

Das Gerät inklusive Zubehör und Batterien gehört nicht in den Hausmüll. 
Die EU-Gesetzgebung fordert in ihren Mitgliedsstaaten, elektrische und 
elektronische Geräte vom unsortierten Siedlungsabfall getrennt zu 
erfassen, um sie anschließend wiederzuverwerten.

In Deutschland und einigen anderen Ländern führt die Sartorius die 
Rücknahme und gesetzeskonforme Entsorgung ihrer elektrischen und 
elektronischen Produkte selbst durch. Diese Produkte dürfen nicht – auch 
nicht von Kleingewerbetreibenden – in den Hausmüll oder an Sammel
stellen der örtlichen öffentlichen Entsorgungsbetriebe abgegeben werden.

Hinsichtlich der Entsorgung wenden Sie sich daher in Deutschland wie auch 
in den Mitgliedsstaaten des Europäischen Wirtschaftsraumes bitte an unsere 
Service-Mitarbeiter vor Ort oder an unsere Service-Zentrale in Göttingen:

Sartorius Stedim Biotech GmbH 
August-Spindler-Strasse 11 
37079 Goettingen, Deutschland

In Ländern, die keine Mitglieder des Europäischen Wirtschaftsraumes sind 
oder in denen es keine Sartorius-Filialen gibt, sprechen Sie bitte die 
örtlichen Behörden oder Ihr Entsorgungsunternehmen an. 

Vor der Entsorgung bzw. Verschrottung des Gerätes sollten die Batterien 
entfernt und einer Sammelstelle übergeben werden.

Mit gefährlichen Stoffen kontaminierte Geräte (ABC-Kontamination) 
werden weder zur Reparatur noch zur Entsorgung zurückgenommen. 
Ausführliche Informationen mit Service-Adressen zur Reparaturannahme 
oder Entsorgung Ihres Gerätes können Sie auf unserer Internetseite 
(www.sartorius.com) finden oder über den Sartorius Service anfordern.

Kontaktdaten

Sartorius Stedim Biotech GmbH
August-Spindler-Strasse 11
37079 Göttingen, Deutschland

Telefon +49 551 308 0
Fax +49 551 308 3289

www.sartorius-stedim.com
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Is the certificate 
up to date? 
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1	 Introduction
Sartorius propose des solutions de congélation | décongélation basées sur 
des technologies brevetées pour la manipulation, le stockage et le transport 
de produits biopharmaceutiques, ainsi que des outils pour le développe
ment de processus, garantissant un changement lineaire de l’échelle 
laboratoire à l’échelle commerciale. Les configurations du système de 
laboratoire sont conçues pour reproduire les processus de congélation | 
décongélation contrôlés qui sont effectués en production dans les 
processus de grand volume Celsius® et Cryovessel. Cryovessel est une 
gamme de produit en acier inoxydable et Celsius® est une ligne de produit à 
usage unique. Ces deux systèmes utilisent le refroidisseur Cryopilot A et le 
mélangeur Cryomixer Jr.

1.1	 Cryovessel
Le système correspondant à Cryovessel à l’échelle du laboratoire s’appelle 
Cryowedge. Le module Cryowedge reproduit une petite partie du 
Cryovessel en faisant correspondre la géométrie de la surface d’échange 
thermique, la longueur du trajet de congélation et la matière de la 
construction. 

Pour réaliser des études de faisabilité, il est possible de réduire encore 
davantage les exigences en matière de volume du produit en utilisant une 
Cryocassette. Il s’agit de récipients de 30 mL et de 100 mL en acier inoxydable 
qui peuvent être installés dans le Cryowedge dans des gaines en polymère. 

1.2	 Celsius®

Le système correspondant à Celsius® à l’échelle du laboratoire est le 
module S3 ; S3 signifie « Scale-down » (réduction d’échelle) et « Stability 
Studies » (études de stabilité). Le module S3 permet ‘imiter les modules de 
congélation|décongélation FT16 et FT100 en faisant correspondre la 
longueur du trajet de congélation.

Le système de congélation|décongélation Celsius® S3 offre des temps de 
congélation | décongélation identiques en permettant des tests de congéla-
tion | décongélation permettant des changements d’echelle lineaires et des 
études de stabilité.

1.3	 Références
Veuillez consulter les documents suivants pour obtenir davantage de 
renseignements sur les composants de votre système de 
congélation|décongélation pour laboratoire :

	— Manuel d’utilisation Huber Unistat 705
	— Schémas électriques Huber Unistat 705
	— Informations sur le produit Dow Syltherm HF
	— Fiche technique sur la sécurité des substances (FTSS) Dow Syltherm HF
	— Fiche technique sur la sécurité des substances (FTSS) DuPont Suva 507
	— Fiche technique sur la sécurité des substances (FTSS) DuPont Suva 23

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   97_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   97 01.04.2022   09:52:2901.04.2022   09:52:29



98	 Mode d’emploi Celsius® S3 Benchtop System

	 Sécurité

2	 Sécurité
Suivez scrupuleusement toutes les instructions de ce manuel afin d’éviter 
tout risque de blessure grave ou de mort pour le personnel et de dommage 
pour l’équipement. Toute utilisation des composants du système dans des 
applications pour lesquelles ils ne sont pas prévus annule la garantie de 
l’appareil et retire toute responsabilité à Sartorius.

Les symboles suivants signalent des informations importantes :

 DANGER 
Situations potentiellement dangereuses qui, si elles ne sont pas évitées, 
peuvent entraîner la mort ou de graves blessures.

 ATTENTION
Risques potentiels mineurs pour la sécurité du personnel ou de dommages 
potentiels pour l’équipement ou les biens.

REMARQUE
Information importante mais ne concernant pas la sécurité.

2.1	 Précautions générales
	t Assurez-vous de respecter en permanence les règles de sécurité en 

vigueur dans l’entreprise. 
	t Coupez l’alimentation électrique et suivez les procédures appropriées 

de Lock-Out|Tag-Out lorsque vous effectuez des opérations de 
maintenance à l’intérieur des composants du système.

	t Ne tirez pas sur les Cryohoses pour les fixer au refroidisseur ou à 
l’application. Il est préférable de déplacer le refroidisseur ou l’application 
afin que les tuyaux ne soient pas tendus. Laissez du mou pour éviter que 
les tuyaux ne soient coudés.

	t Les composants du système sont lourds. Respectez les techniques 
de levage et de manipulation adéquates. 
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2.2	 Fluide caloporteur
Le système fonctionne avec du fluide caloporteur silicone Dow Syltherm 
HF. N’utilisez pas un autre type de fluide caloporteur.

L’utilisation de fluide caloporteur comporte plusieurs risques :
	— Des températures de –75°C et de 250°C peuvent entraîner des blessures 

graves sur la peau, les yeux et d’autres tissus mous. Utilisez des 
équipements de protection individuelle adaptés lorsque vous travaillez 
avec du fluide caloporteur ou que vous êtes exposé de près aux surfaces 
chaudes ou froides du système.

	— Syltherm HF a un point d’inflammation en vase clos de 63°C 
conformément à ASTM D92. Conformément à NFPA et OSHA, il est 
classifié en tant que liquide combustible de la classe IIIA. Veuillez 
respecter les procédures de manipulation et de stockage appropriées.

	— Syltherm HF a une faible tension superficielle et peut etre facilement en 
renverser lors du remplissage du systeme le système. Une fois renversé, 
le fluide est extrêmement glissant. Utilisez des matières absorbantes tels 
que des serviettes en polypropylène pour essuyer le fluide caloporteur 
éventuellement renversé sur la paillasse et le sol.

	— Le fluide caloporteur usagé et les matières absorbantes doivent être 
éliminés en tant que déchets dangereux. Pour plus de renseignements, 
veuillez vous reporter aux informations sur le produit et à la FTSS. 

2.3	 Cryopilot A
Seuls des membres du personnel qualifiés sont autorisés à entretenir le 
système de réfrigération. Le Cryopilot A utilise les réfrigérants hydrofluoro-
carbones (HFC) R-507 et R-23. Ces réfrigérants sont sujets à des réglemen-
tations environnementales et ne doivent pas s’évacuer dans l’atmosphère. 

	t Pour plus de renseignements, veuillez vous reporter aux FTSS.

2.4	 Cryomixer Jr.
	t Pendant le fonctionnement, gardez les mains éloignées de la plaque 

supérieure.
	t Ne dépassez pas la vitesse d’agitation maximale recommandée qui est 

indiquée dans la partie « Installation du système ».
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3	 Composants du système

3.1	 Cryopilot A
Le Cryopilot A est un refroidisseur à recirculation qui règle la température 
d’un fluide caloporteur en fonction d’une valeur de consigne. .

Un système de réfrigération en cascade refroidit le fluide caloporteur 
quand sa température réelle est supérieure à la température de consigne. 
Le système de réfrigération est principalement composé d’un compresseur 
de température élevée, d’un compresseur de basse température, d’un 
condenseur, d’un détendeur automatisé et d’un évaporateur. Les réfrigé-
rants utilisés au cours des stades élevés et faibles sont respectivement R23 
et R507. Le condenseur réfrigérant est refroidi à l’air.

Deux radiateurs à résistance électrique chauffent le fluide caloporteur 
quand sa température réelle est inférieure à la température de consigne. 
Un grand radiateur de 1500 W est utilisé pour de grandes variations de 
température et un plus petit radiateur de 100 W est utilisé pour de petites 
variations. Ce double dispositif de chauffage permet de régler avec 
précision la température de l’alimentation en fluide caloporteur.

Une pompe à vitesse variable fait circuler le fluide caloporteur à travers 
l’évaporateur, les radiateurs et l’application externe. Pour des applications 
Cryowedge, le fluide caloporteur s’écoule à travers la jaquette et l’échangeur 
de chaleur central. Pour des applications du module S3, le fluide caloporteur 
s’écoule à travers les parois adjacentes aux systemes de gestion fluidique 
Celsius® Pak. Un réservoir d’expansion simplifie l’amorçage du système et 
permet au fluide caloporteur de se dilater et de se contracter.

Le Cryopilot A est commandé par microprocesseur. L’interface utilisateur du 
contrôleur est dotée de plusieurs boutons poussoirs, d’un codeur rotatif, 
d’un écran LCD tactile et d’un schéma de système avec des LED d’état. 

Principales caractéristiques du Cryopilot A :

Alimentation électrique 

Remarque : Le Cryopilot A est fourni sans fiche. En raison des différents 
types de prises de courant utilisés selon les pays, le client doit se procurer 
lui-même la fiche.

Amérique du Nord 208 VAC, 60 Hz, 1~, 20 A

Europe 230 VAC, 50 Hz, 1~, 15,6 A

Gamme de température du fluide –75°C à 250°C

Dimensions (L x l x h) 425 x 400 x 720 mm

Poids 90 kg
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3.2	 Ordinateur
Le Cryopilot A est commandé et contrôlé par le logiciel Cryopilot installé sur 
un ordinateur. Le logiciel Cryopilot commande et contrôle les composants 
du système de laboratoire, y compris le refroidisseur a recirculation, le 
mélangeur et les thermocouples. Reportez-vous à la partie intitulée 
chapitre « 5 Logiciel Cryopilot », page 113 pour connaître les exigences 
minimales du système et obtenir des renseignements supplémentaires.

Les ordinateurs achetés chez Sartorius en tant qu’élément d’un système de 
laboratoire ont les spécifications suivantes :

	— Facteur de forme ordinateur portable
	— Système d’exploitation : Microsoft Windows 10 Professional, 64 bits
	— Microsoft Word et Excel
	— Adobe Acrobat
	— Logiciel Cryopilot préinstallé

3.3	 Module Cryowedge
Le nom des modules Cryowedge correspond au volume des Cryovessels 
utilisés à l’échelle de la production. Par exemple, un Cryowedge 125 est 
destiné à simuler un Cryovessel de 125 L.

Volume de travail 350 – 4 000 mL, en fonction de la taille 
du Cryowedge.

Matériaux de construction

Corps acier inoxydable AISI 316L

Joints silicone

Couvercle polycarbonate transparent

Connexions HTF in (entrée du fluide caloporteur), 
HTF out (sortie du fluide) avec 
déconnexion rapide

Poids, vide

Cryowedge 20 15 kg 

Cryowedge 125 21 kg 

Cryowedge 300 44 kg 

Cryowedge 300 49 kg 

Equivalence des tailles

Cryowedge 20 Cryovessel 20 L – 40 L

Cryowedge 125 Cryovessel 60 L – 150 L

�Cryowedge 300 Cryovessel 200 L – 300 L

Cryowedge 300 Cryovessel 300 L
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3.4	 Cryocassette
La Cryocassette diminue la quantité de produit utilisé à l’intérieur du 
Cryowedge. Le Cryowedge peut alors être rempli de tampon tandis que la 
Cryocassette est remplie de produit. La conception de la Cryocassette 
conserve les caractéristiques de congélation et de décongélation du 
Cryowedge afin d’assurer le changement d’echelle lineaire vers les 
Cryovessels utilisés en la production. La Cryocassette sert également pour 
des etudes de stabilite. 

Volume de travail 	— 10 – 4 000 mL, en fonction de la taille 
de la cassette

	— Disponible en 30 mL et 100 mL

Matériaux de construction

Corps acier inoxydable AISI 316L

Nacelle 	— polypropylène (30 mL) ou
	— polyéthylène (100 mL)

Stérilisation autoclavable par le client

Finition 10 µ-in Ra, EP

3.5	 Celsius® Module S³
Le module S3 de congélation | décongélation permet de reproduire les 
processus obtenus avec les systèmes Celsius® FT100 et FT16 avec seulement 
20 mL de produit. La configuration des surfaces de transfert de la chaleur à 
l’intérieur du module fournit le même flux de chaleur bidirectionnel que dans 
le système FT100 en utilisant des Celsius® Pak de matiere identique.

Capacité 1 – 10 échantillons de produit

Volume de travail 20 mL à 1 L, en fonction de la taille 
des Celsius® Paks

Matériaux de construction

Boitier acier inoxydable AISI 302-304

Socle aluminium 6061-T6

Revêtement du châssis du boitier aluminium 5052

Plaques d’extrémité plaque en mousse PVC rigide

�Isolation intérieure du boitier caoutchouc mousse en silicone

Cache de la connexion de fluide 
caloporteur

Delrin

Couvercle PVC transparent

Pression de calcul maximum de la 
tuyauterie de fluide caloporteur

4,1 bar

Connexions HTF in (entrée du fluide caloporteur), 
HTF out (sortie du fluide) avec 
connecteur rapide installée ; purge

Poids environ 18 kg

Ill. 1 :  Cryocassettes en acier inoxydable

Ill. 2 :  Module de congélation | décongélation S3
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3.6	 Celsius® Paks
Tous les Celsius® Paks, quelle que soit leur taille, sont construits avec le 
même matériau et ont la même longueur de trajet de congélation et de 
décongélation que celle représentée sur la photo 3. 

Les Celsius® Paks étant des produits à usage unique, il n'est pas nécessaire 
de les nettoyer.

	— Disponibles en 30 mL et 100 mL
	— Prêts à l'emploi et à usage unique
	— Pré-stérilisés (rayons Gamma 25–45 kGy)
	— Compatibles avec soudeuse a radio-frequence (RF)
	— Conçus pour permettre une mesure stérile de la température
	— Des surpoches pour Celsius® Paks sont disponibles. Il est recommandé 

d'enutiliser dans le cadre d'études de stabilite effectuées à (température 
ambiante et supérieure).

Matériaux de construction des Celsius® Pak de 30 mL et 100 mL

Couche de contact avec le 
produit

copolymère d'éthylène et d'acétate de 
vinyle (monomatière)

Couche barrière au gaz et à 
l'humidité

EVA | EVOH | EVA

Couche de manipulation 
externe robuste

EVA

Raccords de remplissage et 
de vidange

EVA

Tube d'extension C-Flex®

LuerLock® polycarbonate ou polypropylène 
(option C-Flex®)

Coude ou raccord double olive polypropylène (option C-Flex®)

Doigt de gant permettant la 
mesure de temperature

EVA

* �C-Flex® is a registered trademark of Saint-Gobain Performance 
Plastics Corporation.

Ill. 3 :  Comparaison entre les Celsius® Paks 
30 mL et 16,6 L

Frozen 16.6 L 
Celsius® Pak

8.4 cm
8.4 cm
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3.7	 Cryomixer Jr.
Le Cryomixer Jr. est un mélangeur à mouvement alternatif qui est placé 
sous le Cryowedge ou le module S3 afin d'assurer l'homogénéité du produit 
décongelé. Le mouvement alternatif démarre automatiquement dès que le 
logiciel Cryopilot active le Cryomixer Jr. Le Cryomixer Jr. est utilisé pour des 
applications d'agitation du Cryowedge et du module S3.

Caractéristiques

Course 25 mm, alternative

Alimentation électrique

Amérique du Nord 115 V, 60 Hz, 1~

�Europe 230 V, 50 Hz, 1~

Dimensions (L x I x h) 505 x 585 x 120 mm

Poids 24 kg 

3.8	 Cryohose
Tous les systèmes utilisent deux tuyaux Cryohoses pour l'alimentation et le 
retour de fluide caloporteur de l'unité Cryopilot A. Ces tuyaux sont en acier 
inoxydable avec une protection isolante.

3.9	 Cryowrap
Cryowrap est une gaine en néoprène qui, lorsqu'elle est enroulée autour 
des connexions Cryohose, évite la formation de gel pendant la congélation 
de Cryowedge ou du module S3.

3.10	 Système d’acquisition des données
Le système d’acquisition des données est un module compact qui sert à 
numériser les signaux de thermocouples pour permettre un contrôle par 
l’ordinateur. Le système d’acquisition des données est doté d’un câble avec 
des prises pour jusqu’à 16 thermocouples de type T.

Ill. 4 :  Cryomixer Jr.
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4	 Installation du système
Ce chapitre est destiné à vous guider pour l’installation du système.

4.1	 Outils|équipement nécessaires pour 
l’installation

Les outils suivants sont nécessaires pour installer le système de 
congélation|décongélation :

	— Différents tournevis pour vis cruciformes et à tête plate
	— Pince étau avec une poignée d’au minimum 15 cm
	— Différentes clés polygonales ou à molette
	— Matière absorbante telle que des serviettes en polypropylène pour 

essuyer le fluide caloporteur renversé
	— Multimètre adapté pour mesurer la tension d’alimentation

4.2	 Inventaire des composants du système
Quand tous les composants du système sont déballés, assurez-vous que les 
éléments suivants sont disponibles pour l’installation :

	— Cryopilot A
	— Cryowedge ou module S³
	— Cryomixer Jr.
	— (2) Cryohoses
	— (4) Cryowraps
	— Thermocouples de type T (jusqu’à 10 selon le système)
	— USB vers câble Cryomixer Jr.
	— Ordinateur avec le logiciel Cryopilot
	— Système d’acquisition des données National Instruments USB-9213
	— USB vers câble Unistat
	— Fluide caloporteur Dow Syltherm HF (env. 19 L)
	— Siphon de sécurité
	— Protection isolante de Cryowedge (seulement Cryowedge)
	— Trois Cryocassettes (seulement Cryowedge)
	— (10) Celsius® Paks (seulement avec module S3)
	— (10) Supports de thermocouples (seulement avec module S3)
	— Outil de desserrage de bride (seulement avec module S3)
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4.3	 Choix du lieu d’installation
Installez le système sur une surface plane et sèche telle qu’une paillasse ou 
une table de laboratoire capable de supporter un poids total d’environ 
180 kg. Un système sur paillasse typique nécessite de disposer d’un espace 
d’environ 188 cm de largeur et 76 cm de profondeur. Voir le schéma 5 pour 
la disposition convenable et l’espace libre nécessaire. Le Cryopilot A est 
refroidi à l’air et nécessite une ventilation adaptée. Etant donné que le 
Cryomixer Jr. oscille vers l’avant et vers l’arrière, évitez d’utiliser des chariots 
mobiles.

Espace libre min. de 8 cm

Es
pa

ce
 li

br
e 

m
in

.
de

 15
 c

m

 Module S3 ou
Cryowedge 

Cryomixer Jr.

Cryopilot A

Ordinatuer
portable

Profondeur nécessaire 76 cm (réf)

188 cm (réf)

71
 c

m

Boîtier
de connexion

46 cm min.

Ill. 5 :  Espace nécessaire

4.4	 Installation du Cryowedge et du Cryohose

 ATTENTION
Ne tirez pas ou ne pliez pas les Cryohoses pour les fixer au Cryowedge. Cela 
peut provoquer des fuites. Laissez du jeu.

 ATTENTION
Pour éviter d’endommager l’intérieur de la tuyauterie, appliquez un couple 
antagoniste adéquat lorsque vous serrez les raccords unions Cryopilot A.

	t Placez le Cryowedge dans la protection isolante fournie en vous 
assurant que les raccords d’entrée et de sortie du fluide caloporteur ne 
sont pas recouverts.

	t Placez le Cryowedge isolé sur le Cryomixer Jr. Positionnez le Cryowedge 
de manière à ce que le mouvement du Cryomixer Jr. permette de 
mélanger sur la longueur d’une Cryocassette ou bien de l’emplacement 
du Cryowedge (équivalent à la position de l’échangeur de chaleur 
central d’un Cryovessel) vers la paroi extérieure (équivalent à la position 
de la jaquette d’un Cryovessel).

	t Enfilez deux Cryowraps sur chaque tuyau. 
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REMARQUE
Les raccords rapides sont assemblés en usine sur les adaptateurs et sur les 
tuyaux. S’il s’avère nécessaire de défaire et ensuite de refaire les connexions 
en taillant des raccords filetés en biseau, utilisez un produit d’étanchéité 
pour filetage tel que du Loctite 567.

Cryowedge Cryopilot A

_”raccord sanitaire*

Raccord 16 Mx1

Raccord rapide
femelle ⅜”

Raccord rapide
mâle ⅜”

Adaptateur*

Tuyau isolant
de 1,5 m

Raccord M24x1,5

Adaptateur

Raccord M16x1

Adaptateur

Ill. 6 :  Installation du Cryohose pour Cryowedge

	t Connectez le raccord « Thermofluid out » du Cryopilot A au raccord 
d’entrée du Cryowedge comme indiqué sur le schéma 6. Le raccord 
d’entrée du Cryowedge se trouve sur la paroi extérieure qui équivaut à la 
position de la jaquette sur un Cryovessel.

	t Connectez le raccord « Thermofluid in » du Cryopilot A au raccord de 
sortie du Cryowedge comme indiqué sur le schéma 6. Le raccord de 
sortie du Cryowedge se trouve à l’endroit qui équivaut à l’échangeur de 
chaleur central sur un Cryovessel.

	t Vérifiez que tous les tuyaux sont parfaitement raccordés.

4.5	 Installation du module S3 et du Cryohose
 

 ATTENTION
Ne tirez pas ou ne pliez pas les Cryohoses pour les fixer au module S3. Cela 
peut provoquer des fuites. Laissez du jeu.

 ATTENTION
Pour éviter d’endommager l’intérieur de la tuyauterie, appliquez un couple 
antagoniste adéquat lorsque vous serrez les raccords unions Cryopilot A.
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	t Placez le module S3 sur le Cryomixer Jr. comme indiqué sur la photo 7 de 
manière à ce que le mouvement du Cryomixer Jr. permette de mélanger 
sur la longueur d’un Celsius® Pak.

Pos. Description

1 Port sortie

2 Port entrée

3 Boutons de montage

	t Fixez le module S3 à la plaque du Cryomixer Jr. en serrant les quatre 
boutons de montage dans le bas du module. 

	t Enfilez deux Cryowraps sur chaque tuyau.

REMARQUE
Les raccords rapides sont assemblés en usine sur le S3 et sur les tuyaux. S’il 
s’avère nécessaire de défaire et ensuite de refaire les connexions en taillant 
des raccords filetés en biseau, utilisez un produit d’étanchéité pour filetage 
tel que du Loctite 567.

Module S3 Cryopilot A

Adaptateur Raccord 16 Mx1

Raccord M24x1,5Raccord M16x1

Raccord rapide
femelle ⅜”

Raccord rapide
mâle ⅜”

Tuyau isolant
de 1,5 m

Adaptateur

Ill. 8 :   Installation de Cryohose pour le module S3

	t Connectez le raccord « Thermofluid out » du Cryopilot A au raccord 
d’entrée du module S3. Le S3 est équipé de 2 raccords rapides, le raccord 
d’entrée est celui qui se trouve en bas. 

	t Connectez le raccord « Thermofluid in » du Cryopilot A au raccord de 
sortie du module S3. Le S3 est équipé de 2 raccords rapides, le raccord de 
sortie est celui qui se trouve en haut.

	t Vérifiez que tous les tubes sont parfaitement raccordés.

1
2

3

Ill. 7 :  Positionnement du module S3

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   108_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   108 01.04.2022   09:52:3101.04.2022   09:52:31



		  Mode d’emploi Celsius® S3 Benchtop System	 109

		  Installation du système	

4.6	 Installation de Cryopilot A

 DANGER
Toutes les installations électriques doivent être réalisées par un électricien 
qualifié.

	t Assurez-vous que l’interrupteur principal de Cryopilot A est sur la 
position « OFF » ou « 0 ». L’interrupteur est rouge et jaune et se trouve à 
l’arrière de Cryopilot A comme indiqué sur la photo 9.

	t Un électricien qualifié doit installer une fiche (non fournie) sur le cordon 
d’alimentation de Cryopilot A. La fiche doit correspondre au boîtier et 
doit être adaptée à la tension et à l’intensité de votre réseau. Reportez-
vous au chapitre « 3 Composants du système », page 100 pour 
connaître les caractéristiques de l’alimentation électrique.

	t Connectez l’unité Cryopilot A à l’alimentation électrique. 
	t Mettez l’interrupteur principal de Cryopilot A sur la position « ON ».
	t Vérifiez que tous les voyants s’allument brièvement et que l’écran LCD 

rectangulaire est allumé. Si ce n’est pas le cas, vérifiez que l’unité 
Cryopilot A est bien alimentée en courant. Si l’unité Cryopilot A est 
alimentée en courant, mais que le contrôleur n’est pas sous tension, 
veuillez contacter le service après-vente (voir page 139).  

4.7	 Remplissage du fluide caloporteur
Il est recommandé de disposer d’environ 19 L de fluide caloporteur pour 
effectuer l’installation du système. Dow Syltherm HF est utilisé comme 
fluide caloporteur en raison de son point de congélation peu élevé et de sa 
faible viscosité sur une large gamme de température. Pour plus 
d’informations, veuillez vous reporter à la Fiche Technique sur la Sécurité 
des Substances Dow Syltherm HF.

REMARQUE 
Dow Syltherm HF est le seul fluide caloporteur autorisé à être utilisé dans ce 
système.

	t Fermez la vanne de vidange en la tournant dans le sens des aiguilles 
d’une montre pour qu’elle soit en position verticale et en fermant la vis 
d’étanchéité du bas située sur le côté de Cryopilot A comme indiqué sur 
la photo 10.

Ill. 9 :  Interrupteur principal de Cryopilot A
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1 2 3

Ill. 10 :  Vanne de vidange du fluide caloporteur et vis d’étanchéité de Cryopilot A

Pos. Description

1 Vis d‘étanchéité du raccord de vidange principal  
Vanne de purge du fluide caloporteur

2 Vanne de vidange du fluide caloporteur

3 Vitre du regard
Vis d‘étanchéité de lavidange 
Vanne de purge du fluide caloporteur

	t Enlevez le bouchon du reservoir de remplissage de remplissage placé 
dans le haut du Cryopilot A. 

	t Elevez le bidon de Syltherm HF au-dessus du Cryopilot A.
	t Insérez l’extrémité du tuyau du siphon de sécurité dans le Cryopilot A et 

l’extrémité de la vanne dans le bidon de Syltherm HF. Immergez 
l’extrémité de la vanne rouge dans le Syltherm HF et remuez-la de haut 
en bas pour démarrer le siphon. Pour arrêter le flux de fluide caloporteur, 
sortez l’extrémité de la vanne rouge du Syltherm HF. Remplissez l’unité 
Cryopilot A jusqu’à ce que vous atteigniez la marque de 2 L inscrite sur la 
vitre du regard. 

	t Démarrez une purge d’air manuelle (appuyez sur Start, Start air purge, 
30s interval, OK). Ajoutez encore du fluide caloporteur jusqu’à ce que le 
niveau sur la vitre du reservoir se stabilise sur 2 L. 

	t Vérifiez qu’il n’y a pas de fuites au niveau des raccordements de tuyaux.
	t Arrêtez la pompe (appuyez sur Stop, Air purge off).
	t Fixez les Cryowraps au-dessus des surfaces métalliques découvertes à 

chaque extrémité des deux tuyaux.
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4.8	 Installation de Cryomixer Jr. 
	t Connectez le Cryomixer Jr. à l’alimentation électrique.
	t Mettez le bouton de commande manuelle placé sur la face avant du 

Cryomixer Jr. dans la position « O ».
	t Mettez le commutateur Manuel | Automatique qui se trouve à l’arrière du 

Cryomixer Jr. dans la position manuelle (en bas) comme indiqué sur la 
photo 11.

	t Tournez le bouton de réglage de la vitesse complètement dans le sens 
inverse des aiguilles d’une montre (0 t/min.).

	t Tournez le bouton de commande manuelle sur la position « I ».
	t Tournez doucement le bouton de réglage de la vitesse dans le sens des 

aiguilles d’une montre jusqu’à ce que vous atteigniez le nombre de 
tours|minute correct, et enregistrez la vitesse de rotation affichée sur 
l’écran LCD du Cryomixer Jr. Les réglages standard sont les suivants :

	— Cryowedges CW20 et CW125 : 45 t/min.
	— Cryowedges CW300 (30”) et CW300 (34”) : 35 t/min.
	— Module S3 : 120 t/min.

REMARQUE
Les réglages de la vitesse du mélangeur peuvent varier en fonction des 
caractéristiques du produit du client. Veuillez contacter Sartorius si vous 
souhaitez effectuer des modifications par rapport aux recommandations 
indiquées ci-dessus.

	t Mettez le commutateur Manuel | Automatique qui se trouve à l’arrière 
du Cryomixer Jr. dans la position automatique (en haut).

4.9	 Installation de l’ordinateur
	t Connectez l’ordinateur et l’écran à l’alimentation électrique. Il est 

recommandé d’utiliser une protection contre les surtensions (non 
fournie).

	t Mettez l’ordinateur et l’écran sous tension. Répondez aux questions du 
dialogue d’installation Windows. Il peut s’avérer nécessaire de demander 
certaines informations auprès du service informatique de votre 
entreprise. 

 ATTENTION
Aucun programme antivirus n’est installé sur les ordinateurs livrés par 
Sartorius. Il est recommandé d’installer un programme antivirus 
conformément aux directives de votre société.

Ill. 11 :  Face arrière du Cryomixer Jr.
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4.10	 Installation du système d’acquisition de 
données

	t Connectez le National Instruments USB-9213 à l’ordinateur avec un 
câble USB.

	t Connectez une des extrémités du câble USB vers le Cryomixer Jr. à la 
prise située à l’arrière du Cryomixer Jr. Branchez l’autre extrémité à un 
port USB de l’ordinateur.

	t Pour les modules S3, branchez les connecteurs de thermocouples mâles 
du module S3 au câble de thermocouples. Branchez le connecteur 1 dans 
la fiche 1, le connecteur 2 dans la fiche 2, et ainsi de suite. Branchez les 
thermocouples Celsius® Pak dans la réglette de fiches située à l’intérieur 
du boîtier du capot de S3.

	t Connectez l’une des extrémités du câble USB vers Unistat à un port USB 
de l’ordinateur et l’autre extrémité au port série placé sous la ComBox 
comme indiqué sur la photo 12. La ComBox est située à l’arrière du 
Cryopilot A.

Ill. 12 :  Port série de Cryopilot A
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5	 Logiciel Cryopilot

5.1	 Description générale
Le système de laboratoire est commandé et contrôlé par le logiciel 
Cryopilot qui est une application graphique conçue pour des ordinateurs 
équipés de Microsoft Windows. Le logiciel Cryopilot permet aux utilisateurs 
d’effectuer avec souplesse les opérations de congélation et de 
décongélation.

Le schéma ci-dessous illustre la manière dont les composants du système 
sont reliés entre eux. Le logiciel Cryopilot a une interface avec le refroidis-
seur Cryopilot A et le mélangeur Cryomixer Jr. via un USB et avec jusqu’à 
16 thermocouples par l’intermédiaire d’un système d’acquisition des 
données National Instruments.

Ill. 13 :  Système Cryopilot

5.2	 Configuration requise
Le logiciel Cryopilot est installé en usine sur les ordinateurs commandés 
auprès de Sartorius en tant que composant d’un système de laboratoire. Il 
est également disponible sur USB Flash Drive pour les systèmes qui 
répondent aux exigences suivantes : 

	— Système d’exploitation : Microsoft Windows 7 Professional, 32 bits avec 
Service Pack 1 ou Microsoft Windows 10 Professional, 64 bits.

	— Système d’acquisition des données : National Instruments USB-9213. 

Le logiciel Cryopilot est livré avec un programme qui installe automatique-
ment le logiciel Cryopilot et tous les pilotes tiers requis sur votre ordinateur. 
Vous devez avoir les droits administratifs pour installer Cryopilot. 
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5.3	 Composants
Le logiciel Cryopilot est installé par défaut dans C:\Programmes\Sartorius 
Stedim Biotech\Cryopilot 5 pour un système d’exploitation de 32 bits et 
dans C:\Program Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 pour un 
système d’exploitation de 64 bits et que nous allons désormais appeler 
« répertoire d’installation » dans la suite de ce manuel. Vous trouverez 
ci-dessous une description des fichiers et des dossiers que contient le 
répertoire d’installation :

Composant Description

Profiles/ Répertoire des fichiers profils 
standard fournis avec Cryopilot.

BouncyCastle.Crypto.dll Bibliothèque de support

Cryopilot.chm Fichier d’aide

Cryopilot.exe �Fichier exécutable pour le logiciel 
Cryopilot. Les raccourcis vers ce 
fichier se trouvent sur le bureau et 
dans le menu de démarrage.

Cryopilot.exe.config Fichier de réglages

ICSharpCode.SharpZipLib.dll Bibliothèque de support

libftdi.dll Bibliothèque de support

log4net.dll Bibliothèque de support

NationalInstruments.Common.dll Bibliothèque de support

Add NationalInstruments.
NiLmClientDLL.dll 

Bibliothèque de support

Add NationalInstruments.
MStudioCLM.dll 

Bibliothèque de support

NationalInstruments.DAQmx.dll Bibliothèque de support

NPlot.dll Bibliothèque de support

unins000.dat Fichier de support du programme de 
désinstallation

unins000.exe Programme de désinstallation

En plus des fichiers dans le répertoire d’installation, le programme 
d’installation Cryopilot crée un dossier appelé Cryopilot dans le dossier Mes 
documents de chaque utilisateur. Désormais, nous appellerons ce dossier 
« répertoire utilisateur ». Vous trouverez ci-dessous une description des 
fichiers et des dossiers que contient le répertoire utilisateur :
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Composant Description

Data/ �Répertoire par défaut pour les fichiers sauvegardés par 
les utilisateurs. Les utilisateurs peuvent choisir de 
sauvegarder les fichiers ailleurs sur l’ordinateur ou sur un 
lecteur de réseau.

Custom 
Profiles/

�Répertoire par défaut pour les profils personnalisés 
sauvegardés par les utilisateurs. Les utilisateurs peuvent 
choisir de sauvegarder les fichiers ailleurs sur l’ordinateur 
ou sur un lecteur de réseau.

Les fichiers qui sont sujets à des modifications mais qui sont communs à 
tous  sont enregistrés dans C:\ProgramData\Sartorius Stedim Biotech\
Cryopilot 5.

Composant Description

log.txt Fichier utilisé pour le logiciel de dépannage

settings.xml Fichier de réglages

Le programme d’installation Cryopilot installe également plusieurs 
bibliothèques supplémentaires : Microsoft .NET Framework 4.6.1, National 
Instruments NI-DAQmx et des pilotes USB.  

5.4	 Installation
Pour installer le logiciel Cryopilot, insérez l’USB Flash Drive et double-cli-
quez sur mysetup.exe. L’installation exige de disposer de droits d’adminis-
trateur. Contactez l’administrateur de votre système si vous n’avez pas de 
droits suffisants.

En général, les réglages par défaut sont adaptés.

Une fois que la procédure d’installation est terminée, on vous demande de 
redémarrer votre ordinateur.

REMARQUE
Il est important que l’ordinateur soit configuré de manière à ne pas s’arrêter 
ou se mettre hors tension pendant un processus de congélation | décongé-
lation.

Pour Windows 7 ou Windows 10, allez dans le Panneau de configuration > 
Système et sécurité > Options d’alimentation. Sélectionnez le mode 
« Performances élevées ». Cliquez sur « Modifier les paramètres du mode », 
puis sur « Modifier les paramètres d’alimentation avancés ». Réglez « Disque 
dur > Arrêter le disque dur après » sur 0 (jamais). Réglez « Paramètres USB > 
Paramètre de la suspension sélective USB » sur « Désactivé ». Cliquez sur 
OK, puis fermez la fenêtre du Panneau de configuration. 
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5.5	 Interface utilisateur

5.5.1	 Fenêtre principale
La fenêtre principale est l’écran primaire utilisé dans le logiciel Cryopilot. Elle 
contient les options du menu qui permettent d’interagir avec le programme, un 
graphique pour afficher les données du processus et une légende pour 
sélectionner les courbes à représenter sur le graphique.

6

1
2
3

4

5

7

8

9

Ill. 14 :   Fenêtre principale

Pos. Commande Description

1 Barre de titre Affiche le nom de l’application et le nom 
du fichier actuel, s’il y en a un

2 Barre de menu Contient les menus permettant 
d’effectuer les tâches courantes.

3 Barre d’outils Contient les boutons permettant 
d’effectuer les tâches courantes

4 Graphique Affiche une courbe de température par 
rapport au temps écoulé

5 Barre d’état Indique si l’équipement est en ligne ou 
hors ligne.

6 ��Compteur de temps 
écoulé

Indique combien de temps s’est écoulé 
depuis que le processus a été démarré.

7 Légende « HTF Setpoint Affiche la valeur de consigne du fluide 
caloporteur

8 Légende « HTF Supply » Affiche la température réelle du fluide 
caloporteur

9 Légende du produit x Affiche la température du thermocouple 
de type T n° x. 
Selon le matériel, il est possible de 
contrôler jusqu’à 16 thermocouples
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5.5.2	 Dialogue Start Process
Le dialogue Start Process (démarrer le processus) demande à l’utilisateur 
d’entrer des informations qui seront utilisées au cours du processus.

6

1
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4

5

7

8

9

1011

Ill. 15 :  Dialogue Start Process

Pos. Commande Description

1 Chart title �Titre indiqué au-dessus du graphique. Le titre 
par défaut est « Temperature vs. Elapsed Time » 
(Température vs Temps écoulé).

2 Data filename �Nom complet du fichier où les données de ce 
processus seront enregistrées. Le nom par 
défaut est [Répertoire utilisateur]\Data\[code 
date].cpd, [code date] étant une chaîne 
numérique comprenant l’année, le mois, le jour, 
les heures, les minutes et les secondes. 

3 Sélecteur du 
type de profil

�Trois options sont disponibles : None pour 
aucun profil, Standard pour un profil standard 
fourni par Sartorius ou Custom pour un profil 
fourni par l’utilisateur. 

4 Nom de fichier 
du profil

Nom complet du fichier où se trouve le profil 
Custom.

5 Description Zone pour entrer des informations 
supplémentaires sur le processus.
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Pos. Commande Description

6 Bouton de 
sélection du nom 
du fichier

Ouvre un dialogue pour sélectionner un dossier 
et un nom de fichier où les données de ce  
processus seront enregistrées.

7 Liste déroulante 
Application

Propose six options si le profil Standard a été 
sélectionné : 

	—   S3 30mL : pour les systèmes S3 avec dix 
Celsius® Paks de 30 mL

	— S3 100mL : pour les systèmes S3 avec dix 
Celsius® Paks de 100 mLCelsius® Paks

	— Cryowedge 12” 
	— Cryowedge 24” 
	— Cryowedge 30”
	— Cryowedge 34”

8 Liste déroulante 
Process

Propose trois options si le profil Standard a été 
sélectionné :

	— Freeze : pour effectuer uniquement une 
congélation

	— Thaw : pour effectuer uniquement une 
décongélation

	— Freeze and Thaw : pour effectuer une 
congélation suivie d’une décongélation

9 Bouton de 
sélection du nom 
de fichier du profil

Ouvre un dialogue pour sélectionner un dossier 
et un nom de fichier où se trouve le profil  
Custom.

10 Bouton Cancel Pour ignorer les informations et fermer la fenetre 
de dialogue sans démarrer le processus.

11 Bouton OK Pour accepter les informations, fermer la fenetre 
de dialogue et démarrer le processus.
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5.5.3	 Dialogue Options
Le logiciel Cryopilot peut être configuré à l’aide du dialogue de configura-
tion Cryopilot. Dans la fenêtre principale, sélectionnez l’option du menu 
Tools (Outils) > Options.

1

6532 4

7

Ill. 16 :  Dialogue Options – Onglet Certificates

Pos. Commande Description

1 Liste des 
certificats

�Pour afficher une liste de certificats numériques 
disponibles. Pour chaque certificat, la liste 
indique qui a délivré le certificat, à qui il a été 
délivré, le nom convivial et la date d’expiration.

2 Bouton Create ��Pour créer un nouveau certificat auto-signé et 
l’installe dans le dossier Trusted Root 
Certification Authorities. 

3 Bouton View Pour afficher des détails supplémentaires pour 
le certificat sélectionné.

4 Bouton Manage �Pour ouvrir Microsoft Management Console 
pour des tâches supplémentaires de gestion 
des certificats telles que le renouvellement et 
la suppression de certificats.

5 Bouton OK Pour accepter les modifications et fermer le 
dialogue.

6 Bouton Cancel Pour refuser les modifications et fermer le 
dialogue.

7 Onglet Hardware Pour afficher l’onglet Hardware.
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1

65

7
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4

Ill. 17 :  Dialogue Options – Onglet Hardware

Pos. Commande Description

1 Champ de sélec-
tion du système 
d’acquisition de 
données (Data 
Acquisition)

L’option « None » (Aucun) ne configure 
l’application pour aucun système d’acquisition 
de données. Si un système d’acquisition de 
données National Instruments compatible est 
détecté, il sera automatiquement sélectionné.

2 Champ de sélec-
tion du refroidisse-
ment (Chiller)

�L’option « None » (Aucun) ne configure 
l’application pour aucun refroidisseur. Si vous 
sélectionnez l’option « Huber Unistat », 
l’application sera configurée pour collecter les 
données d’un refroidisseur Huber équipé d’un 
contrôleur Unistat, tel qu’un Cryopilot A.

3 Champ de sélec-
tion port COM

Pour afficher une liste de ports (COM) série 
disponibles.

4 Champ de 
sélection Shaker 
(mélangeur)

�L’option « None » (Aucun) ne configure 
l’application pour aucun mélangeur. Si un USB 
vers le  câble Cryomixer Jr. est détecté, il sera 
automatiquement sélectionné.

5 Bouton OK Pour accepter les modifications et fermer le 
dialogue.

6 Bouton Cancel Pour refuser les modifications et fermer le 
dialogue.

7 Onglet Certificates Pour afficher l’onglet Certificates.
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5.6	 Mise en service
Avant de pouvoir démarrer un profil, vous devez configurer le logiciel. 
Assurez-vous que le système d’acquisition de données (DAQ) et le 
refroidisseur sont connectés et sous tension. Ensuite, sélectionnez l’option 
du menu Tools (Outils) > Options pour afficher le dialogue Options.

5.6.1	 Sélection d’un certificat numérique
Tout d’abord, vous devez sélectionner un certificat numérique. Cryopilot 
utilise un certificat numérique pour garantir l’authenticité et l’intégrité des 
fichiers enregistrés. L’onglet Certificates contient une liste de certificats 
disponibles. Il est recommandé d’utiliser un certificat délivré par une 
autorité de certification (AC) reconnue. Si le service informatique de votre 
entreprise a déjà établi une infrastructure de certificat numérique, il peut 
être en mesure de fournir un certificat à utiliser avec Cryopilot.  

Au cas où vous n’auriez pas de certificat à utiliser avec Cryopilot, vous 
pouvez créer ce que l’on appelle un certificat autosigné. « Autosigné » 
signifie que la personne qui crée le certificat se porte également garante de 
sa légitimité. Pour cela, cliquez sur le bouton « Create », puis sur le bouton 
« Yes » dans le dialogue qui apparaît. Le certificat nouvellement créé 
apparaîtra dans la liste des certificats disponibles.

5.6.2	 Configuration du matériel
Vous devez ensuite sélectionner le matériel. L’onglet Hardware (Matériel) 
contient les réglages pour les configurations courantes du matériel. La 
structure la plus courante consiste en un système d’acquisition de données 
(DAQ), en un refroidisseur et en un mélangeur. Dans la plupart des cas, le 
matériel sera détecté automatiquement.

Si vous ne voulez pas démarrer de processus, mais seulement utiliser 
Cryopilot pour revoir des fichiers, sélectionnez « None » (Aucun) pour 
l’acquisition des données, le refroidisseur et le mélangeur.

Pour enregistrer les options, cliquez sur OK.

5.6.3	 Déroulement du programme
Quand le logiciel Cryopilot est lancé, l’écran initial apparaît brièvement, 
puis la fenêtre principale s’affiche.

A ce stade, le logiciel est en attente et ne va rien faire jusqu’à ce que 
l’utilisateur démarre un processus. 

Pour démarrer un processus, sélectionnez l’option du menu Process > Start 
ou cliquez sur le bouton de démarrage d’un processus (Start Process) dans 
la barre d’outils. La boîte de dialogue Start Process apparaît. Une fois que 
l’utilisateur a cliqué sur OK, le logiciel essaie de se connecter au système 
d’acquisition de données, au mélangeur et au refroidisseur, s’ils sont confi-
gurés. Si l’un des systèmes est configuré mais qu’il n’est pas connecté, un 
message demande à l’utilisateur de vérifier les connexions et de réessayer 
ou bien d‘annuler.

Une fois qu’un processus est démarré, le graphique de température et la 
légende sont reconfigurés pour afficher les courbes appropriées ; la 
communication est établie avec le refroidisseur et le système d’acquisition 
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de données (DAQ) est initialisé. Une fois que l’initialisation est terminée, le 
message d’initialisation disparaît et un premier groupe de points de 
données est tracé. Les points de données suivants sont affichés en fonction 
de l’intervalle d’échantillonnage fixé à 15 secondes.

Quand l’utilisation du refroidisseur est configurée, le logiciel Cryopilot 
utilise un lien série pour envoyer des commandes au refroidisseur et pour en 
recevoir des réponses.

Pendant un processus, l’état de connexion est affiché dans le coin inférieur 
gauche de la fenêtre principale. Un message vert « Online » indique que la 
connexion avec le système d’acquisition de données et le refroidisseur est 
correcte. Un message rouge « Offline » indique qu’il y a un problème de 
connexion.  

Le bouton Stop Process arrête l’acquisition de données et éteint le refroidis-
seur et le mélangeur. L’utilisateur peut alors revoir les données. Le fichier de 
données doit être fermé pour que l’utilisateur puisse démarrer un autre 
processus.

5.6.4	 Examen des données
Cryopilot peut ouvrir et afficher des fichiers enregistrés dans Cryopilot 4 et 
Cryopilot 5. Notez que les fichiers créés par Cryopilot 4 peuvent être utilisés 
uniquement à des fins d’examen. Tous les nouveaux fichiers sont enregistrés 
au format Cryopilot 5 de manière à ce que l’intégrité et l’authenticité des 
données puissent être vérifiées à l’aide de la signature numérique.

Il est possible de n’ouvrir qu’un seul fichier à la fois.

Pour ouvrir un fichier, procédez de l’une des façons suivantes :
	t Cliquez sur le bouton Ouvrir dans la barre d’outils
	t Ouvrez le menu File et cliquez sur Open
	t Utilisez le raccourci clavier Ctrl+O

Si vous utilisez le dialogue Open Data File (Ouvrir un fichier), sélectionnez le 
fichier que vous voulez ouvrir. Assurez-vous de sélectionner le type de 
fichier dans la liste déroulante « Files of type » (Type de fichiers). 

Cryopilot 5 utilise des signatures numériques pour attester que les données 
n’ont pas été modifiées depuis qu’elles ont été enregistrées à l’origine. Si 
l’intégrité et l’authenticité du fichier ne peuvent pas être vérifiées au moyen 
d’une signature numérique, un message vous le signale et vous demande de 
continuer ou d’annuler. Ce message apparaît principalement dans deux cas :

	— Quand on ouvre un fichier Cryopilot 4. Les fichiers Cryopilot 4 ne 
contiennent pas de signature numérique.

	— Si le certificat utilisé pour le fichier n’est pas fiable. 

Une fois que le fichier est chargé, les données qu’il contient sont envoyées 
au graphique où elles peuvent être étudiées exactement comme si elles 
provenaient à l’instant d’un processus en cours.

En cliquant sur le graphique avec le bouton droit de la souris et en cliquant 
sur l’option Review, vous pouvez faire défiler le graphique vers la droite et 
vers la gauche et vérifier les valeurs pour chaque courbe à un point précis 
dans le temps. Quand la ligne d’examen défile vers la droite ou vers la 
gauche, la légende est mise à jour pour montrer l’horodatage et les valeurs 
de courbe pour ce point dans le temps.
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5.6.5	 Utilisation du graphique
Le graphique permet d’afficher la température d’un processus par rapport 
au temps écoulé. Le temps écoulé est affiché en heures sur l’axe X et la 
température en degrés Celsius sur l’axe Y. Une légende permet d’identifier 
et d’afficher la valeur actuelle pour chaque courbe.

Panoramique et zoom

L’échelle est ajustée automatiquement par défaut pour adapter le 
graphique aux données disponibles. Cette fonction d’ajustage automatique 
de l’échelle peut être activée ou désactivée à l’aide des options « Auto Scale 
X » et « Auto Scale Y » dans le menu pop-up qui apparaît lorsque l’on clique 
sur le graphique avec le bouton droit de la souris.

Il est possible de modifier l’échelle directement en tirant les axes X et Y. Pour 
afficher le graphique en panoramique, tirez-le tout en maintenant le bouton 
gauche de la souris enfoncé. Quand on change l’échelle ou qu’on affiche le 
graphique en panoramique, Auto Scale (échelle automatique) est désac-
tivé. Double-cliquez sur le graphique pour réactiver Auto Scale.

Légende

La légende identifie chacune des courbes sur le graphique. Chaque courbe 
a sa propre légende indiquant son nom, sa couleur, ses unités et la valeur 
actuelle. Pour cacher une courbe, double-cliquez sur sa légende et elle 
apparaîtra estompée. Pour afficher la courbe, double-cliquez à nouveau sur 
la légende. Cela peut être utile quand on essaie de regarder des fichiers 
avec beaucoup de courbes superposées.

Mode Review

Le mode Review permet à l’utilisateur de revoir les données à n’importe 
quel stade du processus. Le mode Review peut être activé et désactivé dans 
le menu pop-up représenté sur la figure 19. Quand on est en mode Review, 
une ligne verticale est affichée sur le graphique et le temps écoulé et les 
légendes affichent les valeurs qui correspondent à cet endroit sur le 
graphique. 

5.6.6	 Export des données
Cryopilot provides two different methods to export data. It can export an 
image of the current chart view or it can export raw data for viewing in a 
spreadsheet application.

Export du graphique

Pour exporter le graphique, sélectionnez l’option du menu Edit > Copy > 
Chart. Le graphique est copié dans le presse-papiers Windows comme 
image bitmap. Le graphique peut être collé dans d’autres applications en 
sélectionnant Edit > Paste ou en appuyant sur Ctrl+V. Cette option est utile 
lorsque l’on a  besoin rapidement d’un instantané des données, par exemple 
dans une présentation avec des diapositives. Utilisez l’option Copy > Data 
pour analyser davantage les données.

Ill. 18 :  Menu pop-up du graphique 
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Export des données

Pour exporter les données, sélectionnez l’option du menu Edit > Copy > 
Data. Les donnés brutes sont copiées dans le presse-papiers Windows au 
format délimité par les tabulations. Il est possible de coller les donnés dans 
des tableurs tels que Microsoft Excel ou OpenOffice Calc en sélectionnant 
la cellule de destination et en sélectionnant Edit > Paste ou en appuyant sur 
Ctrl+V.

5.6.7	 Impression
Cryopilot peut créer un rapport pour le fichier ouvert. Le rapport est un 
instantané de la représentation actuelle du graphique y compris du titre et 
de la légende. Le rapport peut être affiché sur l’écran sous la forme d’un 
aperçu ou être envoyé à une imprimante. Si un pilote d’impression PDF tel 
qu’Adobe Acrobat est installé sur votre ordinateur, vous pouvez enregistrer 
le rapport au format PDF sur un disque.

Pour imprimer un rapport, procédez de l’une des façons suivantes :
	t Cliquez sur le bouton Impression dans la barre d’outils 
	t Ouvrez le menu File et cliquez sur Print
	t Utilisez le raccourci clavier Ctrl+P Le dialogue Print (Impression) apparaît 

et vous demande de sélectionner l’imprimante de destination et le 
nombre de copies. D’autres réglages tels que les marges et le format du 
papier peuvent être effectués dans Page Setup. Cliquez sur OK pour 
envoyer le rapport à l’imprimante sélectionnée.

5.6.8	 Profils
Le logiciel Cryopilot commande le refroidisseur et le mélangeur en suivant 
un profil. Un profil est une recette qui contient des instructions servant à 
modifier la température de consigne du refroidisseur et le mode de 
consigne du mélangeur (marche|arrêt) selon une fonction de temps. Le 
logiciel Cryopilot est fourni avec un ensemble de profils standard qui sont 
adaptés à de nombreuses applications avec le module S3 et le Cryowedge. 

Il peut s’avérer nécessaire de créer un nouveau profil adapté à une 
application spécifique. Lors de la création d’un nouveau profil, il faut tenir 
compte de plusieurs facteurs :

	— Quelles opérations veut-on effectuer : congélation, décongélation ou les 
deux ?

	— Des cycles multiples de congélation et de décongélation sont-ils 
nécessaires ?

	— Quelle est la température initiale de la matière à congeler ou à 
décongeler ? Si elle est variable, une étape d’équilibrage au début du 
profil peut améliorer la reproductibilité.

	— Le système doit-il rester en marche ou s’arrêter une fois que la 
congélation ou la décongélation est terminée ?

Les taux de congélation et de décongélation sont ajustés de manière 
empirique. Si on souhaite avoir une valeur de consigne plus basse pour une 
congélation, il peut être nécessaire d’augmenter la durée de la valeur de 
consigne finale ou de réduire la température ajustée. Si vous essayez de 
décongeler rapidement sans dépassement, utilisez une température de 
consigne élevée pour une courte durée et ensuite diminuez la température 
de consigne avant que la température cible ne soit dépassée.

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   124_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   124 01.04.2022   09:52:3401.04.2022   09:52:34



		  Mode d’emploi Celsius® S3 Benchtop System	 125

		  Logiciel Cryopilot	

Edition d’un profil

Les profils peuvent être créés et édités manuellement avec des éditeurs de 
texte (par ex. Microsoft Notepad) ou des tableurs (par ex. Microsoft Excel). 
Quand vous utilisez un éditeur de texte, utilisez toujours la touche de 
tabulation pour séparer les colonnes ; n’utilisez pas la touche espace. Pour 
une nouvelle ligne, utilisez la touche Retour ou Entrée après avoir entré 
l’état du mélangeur.

Si vous utilisez un profil standard comme point de départ, assurez-vous de 
l’enregistrer sous un nouveau nom de fichier et ensuite d’effectuer les 
modifications. 

Comportement de la dernière étape

Par défaut, une fois que le logiciel Cryopilot exécute la dernière étape d’un 
profil, il laisse le refroidisseur et le mélangeur tels quels jusqu’à ce que 
l’utilisateur arrête le profil en cliquant sur le bouton STOP. Dans certains cas, 
il est utile d’éteindre le refroidisseur et le mélangeur au bout d’un certain 
temps. Cela est possible en plaçant une instruction TURN CHILLER OFF 
(Arrêter le refroidisseur) après l’instruction STOP. Notez que cela n’est pas 
possible à l’aide de l’éditeur de profil Cryopilot, mais doit être effectué 
manuellement avec un éditeur de texte ou un tableur. Par exemple, le profil 
suivant va arrêter le refroidisseur et le mélangeur à 311 minutes : 

0	 –40	 OFF
310.00	 –60	 OFF
STOP
311.00	 TURN CHILLER OFF

L’instruction TURN CHILLER OFF (Arrêter le refroidisseur) est visible dans 
l’éditeur de profil Cryopilot, mais aucune température n’y est associée.

Format des fichiers

Les profils sont sauvegardés sur disque comme fichiers délimités par les 
tabulations. L’encodage des caractères est ASCII et le format du fichier ne 
fait pas la distinction entre les majuscules et les minuscules. Toutes les 
lignes trouvées avant le signe START sont une description du fichier. Cela 
signifie que la description ne peut pas contenir le mot « start ». Entre le 
signe START et le signe STOP optionnel, chaque ligne représente une étape 
dans le profil. L’heure de démarrage indique quand l’étape doit démarrer ; 
elle a des unités en minutes écoulées et est exprimée en décimales. L’heure 
de démarrage de l’étape doit être 0 et les heures de démarrage des étapes 
successives doivent augmenter de manière constante. Notez que l’heure de 
démarrage pour chaque étape fait référence à l’heure de démarrage du 
profil si bien qu’une étape de 30 minutes doit avoir les heures de démarrage 
0, 30 et 60. La valeur de consigne du refroidisseur est indiquée en degrés 
Celsius et elle est exprimée en décimales. 

Si un signe STOP est présent, la ligne suivante peut être un signe TURN 
CHILLER OFF (Arrêter le refroidisseur). 

Ill. 19 :  Un profil dans Microsoft Notepad.
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La syntaxe suivante est utilisée pour décrire le format du fichier :
\n	 Caractère de nouvelle ligne, défini comme CRLF
\s	�� Zéro ou plus de caractères blancs
\t	 Caractère de tabulation
<variable>	 Elément variable
[FOO]	 Elément optionnel
OFF|ON	 Valeur énumérée, élément doit être l’un ou l’autre
...	� Indique une structure qui se répète

Format:
[<description>\n]
START\s\n
<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n
.
.
.
[STOP\n
[<start time>\tTURN CHILLER OFF]]

Exemple (\n implicite) :
Il s’agit d’un profil de test avec trois étapes.
START
0	 –20	 OFF
30	 –60	 ON
200	 10	 OFF

5.6.9	 Fichiers de données
Pendant un processus, le logiciel Cryopilot contrôle les composants du 
système et enregistre les valeurs importantes dans un fichier sur 
l’ordinateur. 

Le logiciel Cryopilot 5 peut ouvrir des fichiers créés par Cryopilot 4 ou des 
fichiers créés par Cryopilot 5. Toutefois, tous les nouveaux fichiers enregis-
trés par Cryopilot 5 sont enregistrés au format Cryopilot 5. Le fichier 
contient les valeurs de processus suivantes :

	— Température de consigne du fluide caloporteur du refroidisseur et 
température réelle du fluide caloporteur 

	— Valeur de consigne du mode du refroidisseur (marche|arrêt)
	— Valeur de consigne du mode du mélangeur (marche|arrêt) 
	— Jusqu’à 14 température mesurée par thermocouples de type T

L’extension par défaut des fichiers Cryopilot 5 est .cpd.

Un fichier Cryopilot est un fichier ZIP contenant deux fichiers :
	— data.txt qui est un fichier délimité par les tabulations 
	— data.txt.p7s qui est une signature numérique au format PCKS#7. 

Des tableurs tels que Microsoft Excel peuvent importer le fichier délimité 
par les tabulations, mais il est plus facile de transférer les données en 
utilisant l’option du menu File > Copy > Data. N’essayez pas d’ouvrir le 
fichier pour un processus en cours car le tableur peut condamner le fichier 
pour empêcher le logiciel Cryopilot d’écrire des données supplémentaires.
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Format des fichiers

Le fichier data.txt et les résultats de la commande File > Copy > Data 
contiennent tous les deux un texte délimité par les tabulations. L’encodage 
des caractères est ASCII et le format du fichier ne fait pas la distinction 
entre les majuscules et les minuscules. La première ligne doit contenir le 
créateur et la version comme spécifié ci-dessous. Toutes les valeurs de 
température sont indiquées en degrés Celsius.

La syntaxe suivante est utilisée pour décrire le format du fichier :
\n	 Caractère de nouvelle ligne, défini comme CRLF
\s	 Zéro ou plus de caractères blancs
\t	 Caractère de tabulation
<variable>	 Elément variable
[FOO]	 Elément optionnel
OFF|ON	 Valeur énumérée, élément doit être l’un ou l’autre
...	� Indique une structure qui se répète

Notez que les heures sont spécifiées comme Universal Coordinated Time 
(UCT) qui peut différer de l’heure locale en fonction de votre fuseau horaire. 

Là où aucune donnée n’est disponible, le fichier contient le symbole « NaN » 
(Not a Number).

Format :
Cryopilot 5.0\n
METADATA\n
Title\t<title>\n
Process Start\t<timestamp format=yyyy-MM-dd HH :mm :ssZ>\n
Computer\t<computer name>\n
User\t<user name>\n
Description\t<description>\n
START\n
Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply 
Temperature Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\
tProduct Temperature 1(C)\tProduct Temperature 2(C)\t...Product 
Temperature n(C)\n
<timestamp format=yyyy-MM-dd HH :mm :ssZ>\t<elapsedhours 
format=0.000000>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n
.
.
.
.
.

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   127_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   127 01.04.2022   09:52:3401.04.2022   09:52:34



128	 Mode d’emploi Celsius® S3 Benchtop System

	 Logiciel Cryopilot

Exemple avec quatre thermocouples (\n implicite) :

Cryopilot 5.0
METADATA
Title		  Température vs temps écoulé
Démarrage du processus	 2009-03-03 21:49:22Z
Ordinateur		  DEMO_LAPTOP
Utilisateur		  DEMO_LAPTOP\Administrator
Description	
DEMARRAGE
Date/Heure(UTC)	 Temps écoulé(h)			   Etat du refroidisseur	 Température de  
consigne de l’alimentation en fluide caloporteur(C)	 Température de l’alimentation en fluide caloporteur(C)
Etat du mélangeur	 Température (C) 
produit 1	 Température (C) produit 2	 Température (C) produit 3
Température (C) produit 4
2009-03-03 21:49:31Z	 0.002500	 On	 0.0	 21.0	 On	 22.8	 25.4	 NaN	 NaN
2009-03-03 21:49:46Z	 0.006667	 On	 0.0	 20.7	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:01Z	 0.010833	 On	 0.0	 20.3	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:16Z	 0.015000	 On	 0.0	 20.0	 On	 22.8	 25.2	 NaN	 NaN
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5.6.10	 Diagnostics | Dépistage des erreurs
Des messages d’erreur et d’état sont affichés dans la zone de message en 
bas à droite de la fenêtre principale. Cette partie décrit les erreurs courantes 
et ce que l’on peut faire pour y remédier.

Refroidisseur

Si un problème se produit au niveau du refroidisseur, procédez de la 
manière suivante :
	t Vérifiez les deux extrémités du câble entre l’ordinateur et le refroidisseur. 
	t Vérifiez le journal des erreurs du refroidisseur. Pour plus de détails, 

consultez le mode d’emploi Huber Unistat 705.
	t Vérifiez que les réglages de communication du refroidisseur sont correc-

tement configurés. Le Cryopilot A devrait être réglé de manière à utiliser 
une vitesse de transmission de 9 600 bauds et le protocole RS232. Pour 
plus de détails, consultez le mode d’emploi Huber Unistat 705.

	t En dernier recours, quittez le programme Cryopilot, éteignez puis 
rallumez le refroidisseur et redémarrez le programme Cryopilot. Essayez 
de déterminer l’origine du problème avant de redémarrer un autre 
processus. Assurez-vous que les réglages effectués dans le dialogue 
Options sont corrects.

Si une coupure de courant se produit pendant un processus, il se peut que 
le refroidisseur se déconnecte ou que les données provenant du refroidis-
seur soient endommagées. La présence de NaN (not a number) dans les 
zones de température du fichier indique également une erreur au niveau du 
refroidisseur. 

Mélangeur

Si le mélangeur ne fonctionne pas comme il devrait, procédez de la manière 
suivante :
	t Vérifiez le câble entre l’ordinateur et le mélangeur.
	t Vérifiez que le commutateur de mode situé à l’arrière du mélangeur est 

en position Auto.
	t Vérifiez que la vitesse est correctement réglée.
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Système d’acquisition de données | Thermocouples

Les erreurs suivantes sont des erreurs courantes concernant le système 
d’acquisition de données ou les thermocouples :

	— Un capteur ne répond pas aux changements de température comme les 
autres capteurs.

Si cela se produit, procédez de la manière suivante :

	t Vérifiez que le capteur en question est connecté à la bonne fiche du câble 
de thermocouples raccordé au système d’acquisition des données.

	t Assurez-vous que chaque capteur est placé et fixé correctement. Une 
petite erreur dans l’emplacement peut entraîner de grands écarts par 
rapport aux autres capteurs. 

	t Vérifiez les connexions entre l’ordinateur et le système d’acquisition des 
données.

	t Il se peut qu’un capteur soit endommagé. Vérifiez le capteur avec un 
calibrateur de process (par ex. Fluke 725) capable de mesurer des 
thermocouples de type T.

5.6.11	 21 CFR Part 11
Le logiciel Cryopilot 5 est conçu pour faciliter la conformité avec les 
exigences de 21 CFR Part 11. 

Les signatures numériques sont utilisées pour prouver l’authenticité et l’in-
tégrité des fichiers de Cryopilot 5, même sur des systèmes ouverts (c’est-à-
dire non fiables). Il ne faut pas confondre les termes « signature numérique » 
et « signature électronique ». Une signature numérique est une méthode 
cryptographique tandis qu’une signature électronique est l’équivalent élec-
tronique d’une signature manuscrite avec des implications légales. Les réfé-
rences aux signatures électroniques dans 21 CFR Part 11 ne s’appliquent pas 
aux signatures numériques utilisées dans les fichiers de Cryopilot 5.

Quelques remarques générales concernant la mise en oeuvre :
	— Cryopilot 5 repose sur le système d’exploitation pour des fonctions de 

gestion des comptes, d’authentification et d’autorisation. 
	— L’algorithme de signature numérique utilisé par Cryopilot 5 est 

SHA-1 avec RSA ; il est écrit au format PKCS#7.
	— Le système de fichiers est traité comme un système non fiable. 
	— Quand un processus est arrêté, le fichier est fermé et ne peut pas être 

rouvert pour effectuer des modifications. Toute modification des 
données par d’autres moyens, qu’elle soit accidentelle ou intentionnelle, 
est détectée par le mécanisme de signature numérique.

	— Une fois que les données ont été exportées hors du Cryopilot (par ex. 
vers un tableur), leur authenticité et leur intégrité ne peuvent plus être 
assurées.
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6	 Fonctionnement du système

6.1	 Préparation d’un processus

6.1.1	 Cryowedge
Pour préparer le Cryowedge :
	t Enlevez la moitié supérieure de la protection isolante du Cryowedge.
	t Enlevez les écrous-papillons qui maintiennent le couvercle transparent 

et mettez-les de côté.
	t Enlevez le couvercle transparent. Remplissez le Cryowedge avec la 

solution de test à l’aide d’une éprouvette graduée. Les volumes standard 
pour chaque taille de Cryowedge sont les suivants :

Taille du Cryowedge Volume (mL)

CW20 (12 pouces 350

CW125 (20 pouces) 650

CW300 (30 pouces) 3000

CW300 (34 pouces) 4000

	t Remettez le couvercle transparent.
	t Remettez les écrous-papillons et serrez-les à la main. Ne serrez pas trop 

les filetages ou ne les laissez pas apparents.
	t Remettez la moitié supérieure de la protection isolante du Cryowedge.
	t Assurez-vous que le câble du Cryomixer Jr. est connecté au Cryomixer 

Jr. et à l’ordinateur.
	t Assurez-vous qu’au moins six thermocouples sont connectés au système 

d’acquisition des données, en partant de la position 1.
	t Placez cinq des thermocouples à travers les trous pré-percés dans le 

couvercle transparent. Fixez les thermocouples sous la surface de 
la solution de test à l’aide de pièces d’écartement en plastique ou de 
morceaux de tube en silicone.

	t Placez le thermocouple restant en haut du couvercle transparent pour 
qu’il serve de température de référence à la surface extérieure du 
Cryowedge.

	t Pour votre information, notez le numéro et la position de chaque 
thermocouple.

6.1.2	 Module S3

Les Celsius® Paks sont livrés préstérilisés aux rayons Gamma. Ils sont fournis 
avec des raccords Luer femelles et des capuchons sur 2 raccords de 
remplissage|de vidange. Une variante avec des rallonges de tube C-Flex® 
est également disponible pour effectuer un remplissage stérile. Tous les 
Celsius® Paks sont dotés d’un capteur thermométrique fermé en 
silicone|EVA pour insérer une sonde de température.

Pour obtenir des résultats réguliers, chargez toujours le module S3 avec le 
même nombre de Celsius® Paks. Assurez-vous que chaque Celsius® Pak 
contient le même volume. Le thermocouple doit être placé à chaque fois à 
la même profondeur.
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Les profils de congélation standard fournis avec le logiciel Cryopilot sont 
conçus pour 10 Celsius® Paks, soit de 30 ou de 100 mL, remplis jusqu’au 
volume nominal. Placez des thermocouples à au moins un 1 cm de 
profondeur sous la surface du liquide des Celsius® Paks. Les Celsius® Paks 
vides doivent être remplis de tampon échantillon. N’utilisez pas d’eau 
désionisée dans des Celsius® Paks vides car elle surrefroidit. Si vous utilisez 
moins de 10 Celsius® Paks, la congélation est plus rapide et le profil ne 
transfère pas directement à une plus grande échelle.

Différentes étapes de la procédure destinée à préparer, remplir et charger le 
Celsius® Pak :

	t Préparez l’échantillon et|ou le tampon pour remplir les Celsius® Paks.
	t Insérez une étiquette dans le support à étiquette dans le bas du Celsius® 

Pak. Une étiquette mesurant environ 2 x 5 cm passe entièrement dans le 
support. Il est recommandé d’utiliser une étiquette et de l’encre résistant 
à l’eau. N’écrivez pas sur les Celsius® Paks car les solvants utilisés dans 
l’encre peuvent pénétrer dans le Celsius® Pak et contaminer le produit.

	t Utilisez une seringue ou une pompe péristaltique pour remplir les 
Celsius®- Paks d’échantillon ou de tampon par un des raccords de 
remplissage|vidange. Raccordez la seringue ou la pompe à la ligne 
optionnelle C-Flex® via un raccord Luer® mâle ou en les soudant.

	t Remplissez les Celsius® Paks de 30 mL avec au maximum 30 mL et les 
Celsius® Paks de 100 mL avec au maximum 100 mL. 

 ATTENTION
Ne remplissez pas trop les Celsius® Paks ou videz tout l’air par le haut des 
Celsius® Paks car il provoquera une expansion du liquide et de la glace dans 
le tuyau du raccord.

	t Fermez le tube de remplissage avec le bouchon Luer® fourni ou avec un 
collier de serrage.

	t Avant de commencer la congélation, essuyez l’humidité de toutes les 
surfaces se trouvant à l’intérieur du module S3.

Les Celsius® Paks sont maintenus dans le module S3 par un mécanisme de 
pince à ressort qui sert de surface active de transfert de la chaleur. Effec-
tuez les étapes suivantes pour charger le module S3 :

	t Fixez le support de thermocouple au Celsius® Pak en alignant le raccord 
Luer lock® femelle placé sur le support de thermocouple avec le raccord 
Luer lock® mâle se trouvant en haut du capteur thermométrique. Après 
avoir serré le raccord Luer lock® au capteur thermométrique, notez que 
l’avant du support de thermocouple doit se trouver dans la même direc-
tion que l’étiquette avant du Celsius® Pak.

	t Mesurez 1 cm à partir de l’extrémité du thermocouple et faites une 
marque à cet endroit pour placer le thermocouple dans le Celsius® Pak. 

	t Dévissez doucement le circlip du thermocouple en veillant à conserver 
les deux petits joints toriques qui se trouvent dans le circlip. Placez le 
circlip et deux joints toriques sur l’extrémité du thermocouple et vissez 
l’écrou de sécurité juste assez pour l’empêcher de tomber du support du 
thermocouple.

Ill. 20 :  Support de thermocouple fixé au 
Celsius®- Pak
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	t Abaissez le thermocouple dans le capteur thermométrique. Ne poussez 
jamais trop fort pour ne pas transpercer l’extrémité du capteur thermo-
métrique. Pour un contrôle thermique précis, mettez toujours les ther-
mocouples à 1 cm sous la surface du liquide dans le Celsius® Pak en vous 
assurant que la marque sur le thermocouple correspond à la surface du 
liquide.  

	t Serrez le circlip pour maintenir le thermocouple en place à l’intérieur du 
capteur thermométrique.

	t Placez-vous à gauche du module S3 ; insérez un Celsius® Pak entre les 
mécanismes de pinces en commençant par l’emplacement 10, l’empla-
cement le plus éloigné de l’alimentation et du renvoi en fluide calopor-
teur. Ouvrez le mécanisme en mettant l’outil de déclenchement de la 
pince au-dessus des 2 chevilles de guidage sur les 2 blocs de serrage en 
acier inoxydable pour l’emplacement et en appuyant dessus.

	t Tout en appuyant sur l’outil de déclenchement de la pince, glissez 
chaque côté du Celsius® Pak vers le bas entre un bloc noir et un bloc de 
serrage en acier inoxydable du mécanisme de serrage. Placez le haut du 
Celsius® Pak de manière à ce qu’il soit au même niveau que la partie 
supérieure de la barre fixe en métal noir du mécanisme de la pince. 
Notez que le Celsius® Pak doit être tourné vers la gauche pour passer 
correctement dans le module S3.

	t Retirez l’outil de déclenchement de la pince. Le Celsius® Pak est main-
tenu fermement de chaque côté entre deux blocs en métal, l’un noir et 
l’autre en acier inoxydable. Connectez les fiches mâles du thermocouple 
à la réglette de fiches pour thermocouples correspondante.

Ill. 21 :  Thermocouple à 1 cm sous la surface du 
liquide

Ill. 22 :  Ouverture du mécanisme de la pince de 
serrage

Ill. 23 :  Installation du support de thermocouple 
et de Celsius® Pak
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Ill. 24 :  Mise en place du Celsius® Pak et connexion du thermocouple

	t Recommencez cette procédure pour les emplacements 9 à 1. La schéma 
26 présente l’emplacement final de tous les Celsius® Paks et de tous les 
thermocouples.

REMARQUE 
Pour assurer la reproductibilité, chargez le module S3 avec le même nombre 
de Celsius® Paks, remplissez chaque Celsius® Pak avec la même quantité 
d’échantillon ou de tampon et placez les thermocouples dans les capteurs 
thermométriques à 1 cm sous la surface du liquide. Tous les profils de congéla-
tion développés par Sartorius ne fonctionnent correctement que si le système 
est entièrement chargé (10 Celsius® Paks). Les résultats obtenus permettent un 
changement d’echelle lineaire vers 16,6 litres. Si l’on change le nombre de 
Celsius® Paks, la linearite du changement d’echelle de ces profils s’en trouve 
affectée.

	t Dessinez un schéma avec la position et le numéro de chaque 
thermocouple dans un carnet de laboratoire ou en conformité avec les 
réglementations de votre entreprise.

	t Fermez et verrouillez le couvercle du module S3.

Réglette de fiches de thermocouples

Emplacement des Celsius® Paks remplis
Entrée  
de fluide
caloporteur

Sortie  
de fluide
caloporteur

Ill. 25 :  Emplacement des thermocouples et des Celsius® Paks dans le module S3
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6.2	 Fonctionnement d’un profil

REMARQUE
Lorsque vous décongelez avec le module S3, assurez-vous que les 4 
boutons de montage du module S3 sont serrés et que le module est 
maintenu de manière sûre sur la plaque du Cryomixer Jr.

 ATTENTION
Ne dépassez jamais une valeur de 120 t/min. pour le Cryomixer Jr.

	t Double-cliquez sur l’icône du logiciel Cryopilot pour initialiser le logiciel 
Cryopilot.

	t Sélectionnez l’option du menu Process > Start pour afficher le dialogue 
Start Process.

	t Donnez un nom au fichier où les données de l’heure et de la température 
du nouveau processus seront enregistrées. 

	t Sélectionnez le type de profil Standard et sélectionnez votre application 
et l’opération souhaitée (congélation, décongélation ou congélation et 
décongélation). Ou bien sélectionnez un profil personnalisé.

	t Cliquez sur le bouton OK pour démarrer le processus.
	t Vérifiez que le refroidisseur répond aux commandes du logiciel. 

« Online » doit être affiché en bas à gauche de l’écran. Un délai de 
2 à 5 minutes est nécessaire avant que le compresseur ne démarre et 
que le réglage de température ne commence.

	t Laissez le profil fonctionner jusqu’à la fin du temps programmé.
	t Sélectionnez l’option du menu Process > Stop pour arrêter le processus. 
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6.3	 Enlever des Celsius® Paks congelés du 
module S3

Dans certains cas, il est souhaitable d’enlever les Celsius® Paks du module S3 
alors qu’ils sont encore congelés.

	t Enlevez le couvercle transparent du module S3. 

REMARQUE
Si l’appareil reste ouvert pendant une période prolongée pendant qu’il est 
maintenu à faible température, du gel se forme sur les pinces, les 
Celsius®- Paks et les supports de thermocouples et il est difficile d’enlever 
les Celsius® Paks. Une fois que l’appareil est ouvert, enlevez rapidement les 
Celsius® Paks congelés et remettez le capot en place.

	t Enlevez les thermocouples des Celsius® Paks. Si un thermocouple ne 
s’enlève pas facilement, tordez-le doucement jusqu’à ce qu’il se détache. 
Enlevez le support de thermocouple de chaque emplacement. Si de la 
condensation se forme à la surface des pinces, elle forme une 
« adhérence en glace » entre les supports de thermocouples et les blocs 
de refroidissement en métal noir. Il est alors pratiquement impossible de 
retirer les supports de thermocouples. Essuyez l’humidité sur toutes les 
surfaces avant de commencer une congélation. 

	t Enlevez les Celsius® Paks congelés du module S3 à l’aide de l’outil de 
déclenchement de la pince pour remonter et sortir les Celsius® Paks. 
Placez-les dans un récipient de transport isolant.

	t Conservez les Celsius® Paks congelés dans un récipient de protection 
placé dans un congélateur à la température souhaitée. Si vous réalisez 
des tests de stabilité ou des études de formulation, il est préférable 
d’utiliser un congélateur commandé avec un contrôle thermique.

6.4	 Retrait d’échantillons décongelés du 
module S3

	t Enlevez les thermocouples et les supports de thermocouples. 
	t Enlevez les Celsius® Paks décongelés du module S3.
	t Retournez chaque Celsius® Pak trois fois pour mélanger le produit de 

manière uniforme.
	t Soutirez la quantité souhaitée d’échantillon du Celsius® Pak par le 

raccord de remplissage | de vidange inutilisé. Vous pouvez utiliser une 
seringue, une pompe ou une évacuation par gravité.

	t Jetez les Celsius® Paks usagés. Comme les Celsius® Paks sont parfois 
déformés pendant la congélation et la décongélation, ils ne s’adaptent 
pas aussi bien entre les mécanismes de serrage si on les réutilise. Cela 
peut provoquer une congélation et une décongélation prolongées en 
raison de la faiblesse du transfert thermique.
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7	 Maintenance du système
Les opérations de maintenance peuvent être effectuées par l’utilisateur 
final ou par Sartorius. Contactez le service après-vente de Sartorius pour 
établir un contrat de maintenance préventive.

En cas de problème, consultez tout d’abord le chapitre sur les codes 
d’erreur qui se trouve dans le mode d’emploi Huber Unistat 705. Si vous ne 
pouvez pas remédier au problème, appelez le service client (voir page 139).

7.1	 Nettoyage
Les surfaces exposées du système sont généralement compatibles avec des 
sprays et des lingettes contenant de l’alcool isopropylique. Les surfaces en 
acier inoxydable peuvent être nettoyées avec un produit à polir l’inox.

Le compartiment interne du S3 contient plusieurs parties en aluminium 
anodisé qui est incompatible avec des solutions basiques telles que 
l’hydroxyde de sodium (NaOH) ou les oxydants. Ces matières ne doivent 
pas être utilisées pour nettoyer le compartiment interne. S’il est nécessaire 
de nettoyer le compartiment interne, il est plutôt recommandé d’utiliser de 
l’alcool isopropylique ou d’autres solutions de nettoyage non-oxydantes.

7.2	 Changement du fluide caloporteur
Changez le fluide caloporteur si vous voyez qu’il est contaminé par de l’eau 
ou des particules ou si vous constatez une baisse d’efficacité du transfert 
de chaleur (c’est-à-dire quand l’appareil n’atteint pas la température de 
consigne ou n’y reste pas). Changez toujours tout le fluide caloporteur. Si 
l’efficacité du transfert de chaleur ne s’améliore pas après que vous avez 
changé le fluide caloporteur, contactez le service clientèle (voir page 139). 

Pour changer le fluide caloporteur, suivez la procédure suivante :
	t Vérifiez que la vanne de purge du fluide caloporteur du système située 

sur l’avant de l’appareil est fermée. La fente du capuchon de la vis est 
verticale quand la vanne de purge est fermée. Voir « Ill. 10 : Vanne de 
vidange du fluide caloporteur et vis d’étanchéité de Cryopilot A », 
page 110.

	t Enlevez la vis d’étanchéité dans le tuyau inoxydable proéminent placé 
sur le côté gauche de l’appareil et connectez un morceau de tuyau 
flexible sur l’extrémité du tuyau. Fixez-le fermement avec un collier de 
serrage pour tuyau.

	t Mettez l’autre extrémité du tuyau dans un bidon qui contient au moins 
12 L de fluide caloporteur.

	t Ouvrez la vanne de purge du fluide caloporteur en la tournant dans le 
sens inverse des aiguilles d’une montre jusqu’à ce que la fente soit 
horizontale.

t	Si possible, essayez de soulever le Cryowedge ou le module S3 pour 
vider le reste de fluide caloporteur du module d’application relié au 
Cryopilot A.
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	t Quand le fluide caloporteur ne s’écoule plus, fermez la vanne de purge 
du fluide caloporteur, enlevez le tuyau flexible du tuyau de la vis 
d’étanchéité et replacez la vis d’étanchéité.  

	t Remplissez le système Cryopilot A avec du nouveau fluide caloporteur 
en suivant la procédure expliquée dans le chapitre « 4.7 Remplissage du 
fluide caloporteur », page 109.
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8	 Instructions d’élimination des 
déchets et de réparation

Si vous n’avez plus besoin de l’emballage de votre appareil, veuillez l’ap-
porter au service local de retraitement des déchets. Cet emballage se 
compose entièrement de matériaux écologiques pouvant être recyclés. 

L’appareil, y compris les accessoires, les piles et les batteries, ne doit pas être 
jeté dans les ordures ménagères normales. La législation de l’Union euro-
péenne prescrit aux Etats membres de collecter les équipements élec-
triques et électroniques séparément des déchets municipaux non triés afin 
de permettre ensuite de les récupérer, de les valoriser et de les recycler.

En Allemagne et dans quelques autres pays, la société Sartorius se charge 
elle-même de reprendre et d’éliminer ses équipements électriques et 
électroniques conformément à la loi. Ces appareils ne doivent pas être jetés 
(même par de petites entreprises) dans les ordures ménagères ni apportés 
dans les points de collecte des services locaux d’élimination des déchets.

Pour obtenir de plus amples renseignements sur l’élimination des déchets, 
veuillez vous adresser en Allemagne, tout comme dans les Etats membres 
de l’Espace Economique Européen, à notre responsable local du service 
après-vente ou à notre centre de service après-vente à Goettingen en 
Allemagne :

Sartorius Stedim Biotech GmbH
August-Spindler-Strasse 11
37079 Goettingen, Allemagne

Dans les pays qui ne font pas partie de l’Espace Economique Européen ou 
dans lesquels Sartorius n’est représenté par aucune filiale, succursale, ni 
aucun revendeur ou distributeur, veuillez vous adresser aux autorités locales 
ou à une entreprise d’élimination des déchets. 

Les piles, batteries et accumulateurs rechargeables ou non doivent être 
enlevés avant de jeter l’appareil ou de le mettre au rebut et ils doivent être 
jetés dans les boîtes de collecte locales prévues à cet effet.

Les appareils contaminés par des substances dangereuses (contaminations 
NBC) ne sont pas repris par Sartorius, ses filiales, ses succursales ni par ses 
revendeurs pour être réparés ou éliminés. Veuillez visiter notre site Internet 
(www.sartorius.com) pour obtenir davantage de renseignements ainsi que 
les adresses des centres de service après-vente à contacter si vous envi-
sagez le renvoi en réparation, l’élimination ou le recyclage de votre appareil.

Contact

Sartorius Stedim FMT S.A.S.
ZI des Paluds
Avenue de Jouques – CS 91051
13781 Aubagne Cedex

Tél. +33 442 845600
Fax +33 442 845619
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Is the certificate 
up to date? 
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1	 Introduzione
Sartorius offre delle soluzioni di congelamento-scongelamento scalabili 
utilizzando tecnologie brevettate per manipolazione, stoccaggio e trasporto 
di prodotti biofarmaceutici, nonché gli strumenti per lo sviluppo di processi, 
l’esecuzione su scala pilota e la produzione su scala commerciale. Le 
configurazioni del sistema benchtop sono concepite per riprodurre i 
processi di congelamento-scongelamento controllati che hanno luogo nei 
processi Celsius® e Cryovessel di grande volume su scala produttiva. 
Cryovessel è una linea di prodotto in acciaio inox e Celsius® è una linea di 
prodotto monouso. Entrambi i sistemi utilizzano il refrigeratore Cryopilot A 
e l’agitatore Cryomixer Jr.

1.1	 Cryovessel
Il sistema su piccola scala per Cryovessel è chiamato Cryowedge. Il modulo 
Cryowedge riproduce una piccola sezione del Cryovessel facendo corri-
spondere la geometria della superficie di scambio termico, la lunghezza del 
tratto di congelamento e il materiale di costruzione. 

Per gli studi di fattibilità è possibile ridurre i requisti in materia di volume di 
prodotto utilizzando una Cryocassette. Si tratta di recipienti da 30 mL e 
100 mL in acciaio inox che possono essere installati nel Cryowedge in 
guaine polimeriche. 

1.2	 Celsius®

Il sistema su piccola scala per Celsius® è chiamato modulo S3; S3 significa 
“Scale-down” (riduzione di scala) e “Stability Studies” (studi di stabilità).

Il modulo S3 permette di imitare i moduli di congelamento-scongelamento 
FT16 e FT100 facendo corrispondere la lunghezza del tratto di 
congelamento. Il sistema di congelamento-scongelamento Celsius® S3 
genera dei tempi di congelamento-scongelamento simili, consentendo 
quindi dei test di congelamento-scongelamento scalabili e degli studi di 
stabilità.

1.3	 Referenze
Ulteriori informazioni sui componenti del vostro sistema benchtop di 
congelamento-scongelamento sono contenute nei seguenti documenti:

	— Manuale d’uso Huber Unistat 705 
	— Schemi elettrici Huber Unistat 705
	— Informazioni sul prodotto Dow Syltherm HF
	— Scheda tecnica sulla sicurezza del materiale (MSDS) Dow Syltherm HF
	— Scheda tecnica sulla sicurezza del materiale (MSDS) DuPont Suva 507
	— Scheda tecnica sulla sicurezza del materiale (MSDS) DuPont Suva 23
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2	 Sicurezza
Osservare con attenzione tutte le istruzioni per evitare lesioni gravi o mortali 
per il personale e danni alle apparecchiature. Qualsiasi uso dei componenti 
del sistema in applicazioni per le quali non sono destinati annulla le garanzie 
dell’apparecchio e solleva Sartorius da ogni e qualsiasi responsabilità.

I seguenti simboli segnalano informazioni importanti:

 AVVISO 
Situazioni potenzialmente pericolose che potrebbero causare lesioni 
mortali o gravi se non fossero evitate.

 ATTENZIONE
Rischi potenziali minori per la sicurezza del personale o danni potenziali per 
apparecchiature o beni.

NOTA
Informazioni che sono importanti ma che non riguardano la sicurezza.

2.1	 Precauzioni generali
	t Assicurarsi che vengano sempre rispettate le regole di sicurezza 

dell’azienda. 
	t Scollegare l’alimentazione elettrica e seguire le procedure appropriate 

di bloccaggio e sbloccaggio (lock-out|tag-out) quando si eseguono 
interventi di manutenzione all’interno dei componenti del sistema.

	t Non tendere i Cryohose per collegarli al refrigeratore o all’impianto. A 
tale scopo è preferibile spostare il refrigeratore o l’impianto per poter 
collegare i tubi flessibili senza che siano tesi. Lasciare che ci sia gioco 
sufficiente in modo che non si formino delle pieghe.

	t I componenti del sistema sono pesanti. Osservare le tecniche adeguate 
per il sollevamento e montaggio. 
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2.2	 Fluido di scambio termico
Il sistema utilizza il fluido siliconico per scambio termico Dow Syltherm HF 
(HTF). Non usare un altro tipo di fluido di scambio termico.

L’utilizzo del fluido di scambio termico comporta diversi rischi:
	— Le temperature di –75°C e di 250°C possono causare lesioni gravi a 

pelle, occhi e altri tessuti morbidi. Usare attrezzature di protezione 
individuale adatte quando si lavora con il fluido di scambio termico o 
vicino alle superfici esposte calde o fredde dell’apparecchio.

	— Syltherm HF ha un punto di infiammabilità in vaso chiuso di 63°C (145°F) 
secondo ASTM D92. In conformità con NFPA e OSHA esso è classificato 
come liquido combustibile di classe IIIA. Osservare le procedure 
adeguate per la manipolazione e lo stoccaggio.

	— Syltherm HF ha una tensione superficiale bassa e può essere difficile 
evitare degli spruzzi durante il riempimento o lo svuotamento del 
sistema. Il liquido fuoriuscito è estremamente scivoloso. Usare materiale 
assorbente come dei pad in polipropilene per asciugare il fluido di 
scambio termico versato sul banco o sul pavimento.

	— Il fluido di scambio termico usato e il materiale assorbente devono 
essere smaltiti come rifiuti pericolosi. Per maggiori informazioni si 
rimanda alle informazioni sul prodotto e alla scheda tecnica sulla 
sicurezza dei materiali (MSDS).

2.3	 Cryopilot A
La manutenzione del sistema di raffreddamento deve essere eseguita solo 
da personale qualificato. Il Cryopilot A utilizza i refrigeranti idrofluorocarburi 
(HFC) R-507 e R-23. Questi refrigeranti sono soggetti a normative 
ambientali e non devono essere dispersi nell’atmosfera. 

	t Per maggiori informazioni si rimanda alla scheda tecnica sulla sicurezza 
dei materiali (MSDS).

2.4	 Cryomixer Jr.
	t Durante il funzionamento tenere le mani distanti dalla piastra di 

copertura superiore.
	t Non superare la velocità di agitazione massima consigliata che è indicata 

nel capitolo “Installazione del sistema”.
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3	 Componenti del sistema

3.1	 Cryopilot A
Il Cryopilot A è un refrigeratore a ricircolo che regola la temperatura del 
fluido di scambio termico in funzione di un valore nominale di temperatura. 

Un sistema di refrigerazione in cascata raffredda il fluido di scambio termico 
quando la sua temperatura reale supera la temperatura nominale. I 
componenti principali del sistema di refrigerazione sono un compressore ad 
alta temperatura, un compressore a bassa temperatura, un condensatore, 
una valvola di espansione automatica e un evaporatore. I refrigeranti 
impiegati negli stadi elevati e bassi sono rispettivamente R23 e R507. Il 
condensatore refrigerante è raffreddato ad aria.

Due radiatori a resistenza elettrica riscaldano il fluido di scambio termico 
quando la sua temperatura reale scende al di sotto della temperatura 
nominale. Per forti variazioni di temperatura si usa un grande radiatore di 
1500W, mentre per piccole variazioni della temperatura si usa un piccolo 
radiatore di 100W. Questa configurazione a due radiatori fornisce un 
controllo preciso della temperatura di alimentazione del fluido di scambio 
termico.

Una pompa a velocità variabile fa circolare il fluido attraverso l’evaporatore, i 
radiatori e l’impianto esterno. Per le applicazioni con Cryowedge il fluido 
scorre attraverso la camicia e nell’area dello scambiatore di calore interno. 
Per le applicazioni con il modulo S3 il fluido scorre attraverso le pareti 
adiacenti ai morsetti di serraggio dei Celsius® Pak. Un vaso di espansione 
semplifica l’adescamento del sistema e permette l’espansione e la 
contrazione del fluido di scambio termico.

Il Cryopilot A è controllato da un microprocessore. L’interfaccia utente del 
controller è dotata di diversi pulsanti, un encoder rotativo, un display LCD 
con touch screen e un diagramma di sistema con LED di stato. 

Qui di seguito sono elencate le specifiche principali di Cryopilot A:

Alimentazione elettrica

NOTA: il Cryopilot A è fornito senza spina. Essendoci diversi tipi di presa 
elettrica, a seconda del paese di utilizzo, il cliente deve procurarsi la propria 
spina.

North America 208 VAC, 60 Hz, 1~, 20 A

Europe 230 VAC, 50 Hz, 1~, 15,6 A

Campo di temperature del fluido –75°C fino a 250°C 

Dimensioni (L x P x A) 425 x 400 x 720 mm
(16,7” x 15,7” x 28,3”)

Peso 90 kg 
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3.2	 Computer
Il Cryopilot A è comandato e controllato per mezzo del software Cryopilot 
installato su un computer. Il software Cryopilot comanda e controlla i 
componenti del sistema benchtop, compresi il refrigeratore, il miscelatore e 
le termocoppie. Si rimanda al capitolo “5 Software Cryopilot”, pagina 159 
per conoscere i requisiti minimi del sistema e per maggiori informazioni. 

I computer acquistati presso Sartorius come parte di un sistema benchtop 
hanno le seguenti specifiche:

	— Fattore di forma computer portatile
	— Sistema operativo: 
	— Microsoft Windows 10 Professional, 64 bit
	— Microsoft Excel
	— Adobe Acrobat
	— Software Cryopilot preinstallato

3.3	 Modulo Cryowedge
I nomi dei moduli Cryowedge corrispondono al volume di Cryovessel usati 
su scala produttiva. Per esempio, un Cryowedge 125 (20”) simula un 
Cryovessel 125 L.

Volume di lavoro 350 – 4000 mL, in base alla misura del 
Cryowedge

Materiali di costruzione

Corpo acciaio inox 316L

Guarnizioni silicone

Copertura policarbonato trasparente

Connessioni HTF in (ingresso del fluido di scambio 
termico), HTF out (uscita del fluido di 
scambio termico) con raccordi a 
disinnesto rapido

Peso, vuoto

Cryowedge 20 (12”) 15 kg 

Cryowedge 125 (20”) 21 kg 

Cryowedge 300 (30”) 44 kg 

Cryowedge 300 (34”) 49 kg

Equivalenza delle misure

Cryowedge 20 (12”) Cryovessel 20 L – 40 L

Cryowedge 125 (20”) Cryovessel 60 L – 150 L

�Cryowedge 300 (30”) Cryovessel 200 L – 300 L

Cryowedge 300 (34”) Cryovessel 300 L
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3.4	 Cryocassette
La Cryocassette diminuisce la quantità di prodotto usata all’interno del 
Cryowedge. Il Cryowedge può essere riempito con soluzione tampone, 
mentre la Cryocassette viene riempita con il prodotto. Il design della 
Cryocassette mantiene le caratteristiche di congelamento e scongelamento 
del Cryowedge per garantire la scalabilità verso i Cryovessel utilizzati nella 
produzione. La Cryocassette serve anche come contenitore con stabilità 
scalabile.

Volume di lavoro 	— 10 – 100 mL, in base alla misura della cassetta
	— Disponibile in misure da 30 mL e 100 mL

Materiali di costruzione

Corpo acciaio inox 316L

Navicella 	— polipropilene (30 mL) 
	— o polietilene (100 mL)

Sterilizzazione Sterilizzabile in autoclave da parte del cliente

Finitura 10 µ-in Ra, EP

3.5	 Celsius® Modulo S³
Il modulo S3 di congelamento-scongelamento consente la modellazione dei 
sistemi Celsius® FT100 e FT16 con soltanto 20 mL di prodotto. La 
configurazione delle superfici di scambio termico all’interno del modulo 
fornisce lo stesso flusso di calore bidirezionale come nel sistema FT100 
utilizzando la struttura e i design dei Celsius® Pak. 

Capacità 1 – 10 campioni di prodotto

Volume di lavoro 20 mL fino a 1 L, in base alla misura dei 
Celsius® Pak

Materiali di costruzione

Involucro acciaio inox 302-304

Base alluminio 6061-T6

Copertura della struttura 
dell’involucro

alluminio 5052

Piastre terminali piastra in schiuma di PVC rigida

Isolamento interno 
dell’involucro

gomma spugna siliconica

Copertura terminale 
dell’attacco per fluido di 
scambio termico

Delrin

Copertura PVC trasparente

Fig. 1:  Cryocassette in acciaio inox

Fig. 2:  Celsius® Modulo S3 di congelamento-
scongelamento
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Pressione di calcolo massima 
della tubazione per fluido di 
scambio termico

4,1 barg (60 psig)

Connessioni HTF in (ingresso del fluido di scambio 
termico), HTF out (uscita del fluido di 
scambio termico) con raccordi a 
disinnesto rapido installati; scarico

Peso ca. 18 kg

3.6	 Celsius® Paks
Tutti i Celsius® Pak, indipendentemente dalla misura, sono costruiti con lo 
stesso materiale e hanno la stessa lunghezza del tratto di congelamento e 
scongelamento come mostrato nella figura 3.

I Celsius® Pak sono monouso e pertanto la pulizia non è necessaria.

	— Disponibili nelle misure di 30 mL e 100 mL
	— Contenitore pieghevole monouso, pronto per l’uso
	— Presterilizzati (raggi gamma 25–45 kGy)
	— Compatibili con saldatura a radiofrequenza (RF)
	— Concepiti per permettere una misurazione sterile della temperatura
	— Sono disponibili degli involucri per i Celsius® Pak. L’uso di un involucro 

è consigliato per studi condotti con temperature più alte (temperatura 
ambiente o superiore).

Materiali di costruzione dei Celsius® Pak da 30 mL e 100 mL

Strato a contatto con il 
prodotto

EVAM (copolimero di etilene acetato 
di vinile, monomateriale)

Strato barriera a gas e umidità EVA | EVOH | EVA

Strato di manipolazione 
esterno robusto

EVA

Raccordi per riempimento e 
scarico

EVA

�Tubi di prolunga C-Flex®

LuerLock® policarbonato o polipropilene 
(opzione C-Flex®)

Gomito di raccordo doppio o 
elemento di raccordo

polipropilene (opzione C-Flex®)

�Pozzetto termometrico silicone vulcanizzato al platino

* �C-Flex® is a registered trademark of Saint-Gobain Performance 
Plastics Corporation.

Fig. 3:  Confronto tra i Celsius® Pak 30 mL 
e 16,6 L

Frozen 16.6 L 
Celsius® Pak

8.4 cm
8.4 cm
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3.7	 Cryomixer Jr.
Il Cryomixer Jr. è un miscelatore a movimento alternativo che è posizionato 
sotto il Cryowedge o il modulo S3 per garantire l’omogeneità del prodotto 
scongelato. Il movimento alternativo si avvia automaticamente quando il 
software Cryopilot attiva il Cryomixer. Il Cryomixer Jr. viene usato per 
applicazioni di agitazione sia di Cryowedge che del modulo S3.  

Specifiche

Corsa 25 mm, a movimento alternativo

Alimentazione elettrica

Nord America 115 V, 60 Hz, 1~

Europa 230 V, 50 Hz, 1~

Dimensioni L x P x A 505 x 585 x 120 mm (20” x 23” x 5”)

Peso 24 kg

3.8	 Cryohose
Tutti i sistemi usano due tubi Cryohose per la mandata e il ritorno del fluido 
di scambio termico dall’apparecchio Cryopilot A. Questi tubi sono in acciaio 
inox avvolti da una guaina isolante.

3.9	 Cryowrap
Cryowrap è una guaina in neoprene che viene avvolta attorno alle connes-
sioni Cryohose per prevenire la formazione di gelo durante l’operazione di 
congelamento di Cryowedge o del modulo S3.

3.10	 Dispositivo di acquisizione dati
Il dispositivo di acquisizione dati è un modulo compatto che serve a digitaliz-
zare i segnali delle termocoppie per permettere il monitoraggio da parte del 
computer. Questo dispositivo è dotato di un cavo breakout con connettori 
femmina per fino a 16 termocoppie del tipo T.

Fig. 4:  Cryomixer Jr.
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4	 Installazione del sistema
Questo capitolo vi guiderà attraverso l’installazione del sistema benchtop.

4.1	 Attrezzi | Apparecchiature richiesti per 
l’installazione

Per l’installazione del sistema di congelamento-scongelamento sono 
richiesti i seguenti utensili:

	— Svariati cacciaviti per viti con testa a croce e con testa piatta
	— Pinza a morsa con impugnatura di almeno 15 cm
	— Svariate chiavi a tubo o chiavi inglesi regolabili
	— Materiale assorbente come dei pad in polipropilene per asciugare il 

fluido di scambio termico eventualmente fuoriuscito
	— Multimetro adatto per misurare la tensione di alimentazione

4.2	 Inventario dei componenti del sistema
Una volta che tutti i componenti sono stati disimballati, verificare che i 
seguenti articoli siano disponibili per l’installazione:

	— Cryopilot A
	— Cryowedge o modulo S³
	— Cryomixer Jr.
	— (2) Cryohose
	— (4) Cryowrap
	— Termocoppie del tipo a T (fino a 10 a seconda del sistema)
	— Cavo USB verso Cryomixer Jr.
	— Computer con software Cryopilot 
	— Dispositivo di acquisizione dati, National Instruments USB-9213
	— Cavo USB verso Unistat
	— Liquido di scambio termico Dow Syltherm HF (ca. 19 L)
	— Sifone di sicurezza
	— Copertura coibentata di Cryowedge (solo per Cryowedge)
	— Tre Cryocassette (solo per Cryowedge)
	— (10) Celsius® Pak (solo per il modulo S3)
	— (10) Supporti delle termocoppie (solo per il modulo S3)
	— Utensile di sblocco dei morsetti di serraggio (solo per il modulo S3)
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4.3	 Scelta del posto di installazione
Installare il sistema su una superficie piana e asciutta, come un banco da 
laboratorio o un tavolo in grado di reggere un peso complessivo di ca. 
180 kg. L’ingombro di un tipico sistema benchtop è all’incirca di 188 cm di 
larghezza e 76 cm di profondità. Si rimanda alla figura 5 per la disposizione 
appropriata e per lo spazio libero richiesto. Il Cryopilot A è raffreddato ad 
aria e richiede una aerazione adeguata. Dato che il Cryomixer Jr. oscilla 
avanti e indietro, evitare di usare dei carrelli mobili.

8 cm di spazio libero

15
 c

m
 m

in
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di
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io

 li
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roModule S3 o
Cryowedge 

Cryomixer Jr.

Cryopilot A

Profondità richiesta 76 cm (rif)

188 cm (rif)

71
 c

m

Dispositivo di
acquisizione dati

46 cm min.Computer
portatile

Fig. 5:  Spazio richiesto

4.4	 Installazione di Cryowedge e dei Cryohose

 ATTENZIONE
Non tendere o piegare i Cryohose per collegarli al Cryowedge. Ciò può 
causare delle perdite. Lasciare che ci sia gioco sufficiente.

 ATTENZIONE
Applicare una controcoppia adeguata quando si serrano gli elementi di 
raccordo di Cryopilot A per evitare che si danneggi l’interno della tubazione.

	t Mettere il Cryowedge nella copertura coibentata fornita facendo 
attenzione che gli attacchi di ingresso e uscita del fluido di scambio 
termico rimangano esposti.

	t Collocare il Cryowedge coibentato sul Cryomixer Jr. Posizionare il 
Cryowedge in modo che il movimento del Cryomixer Jr. consenta di 
miscelare sull’intera lunghezza di una Cryocassette o a partire dal punto 
del Cryowedge (equivalente alla posizione dello scambiatore di calore 
interno di un Cryovessel) fino alla parete esterna (equivalente alla 
posizione della camicia di un Cryovessel).

	t Infilare due Cryowrap su ciascun tubo. 
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NOTA 
I raccordi a disinnesto rapido sono assemblati in fabbrica sugli adattatori e 
sui tubi. Se è necessario scollegare e ricollegare le connessioni con 
filettature coniche, usare un sigillante per filettature come Loctite 567.

Cryowedge Cryopilot A

_“ flangia sanitaria*

Elemento di
raccordo M16x1

Raccordo 
rapido
femmina ⅜” 

Maschio ⅜”
Raccordo 
rapido

Adattatore*

Tubo 
coibentato
1,5 m

Elemento di
raccordo M24x1,5

Adattatore

Elemento di
raccordo M16x1

Adattatore

Fig. 6:  Installazione di Cryohose per Cryowedge

	t Collegare il raccordo “Thermofluid out” del Cryopilot A al raccordo di 
ingresso del Cryowedge come mostrato nella figura 6. Il raccordo di 
ingresso del Cryowedge si trova sulla parete esterna che equivale alla 
posizione della camicia di un Cryovessel.

	t Collegare il raccordo “Thermofluid in” del Cryopilot A al raccordo di 
uscita del Cryowedge come mostrato nella figura 6. Il raccordo di uscita 
del Cryowedge si trova sul punto che equivale alla posizione dello 
scambiatore di calore interno di un Cryovessel.

	t Verificare che tutti i tubi siano connessi correttamente.

4.5	 Installazione del modulo S3 e dei Cryohose
 

 ATTENZIONE 
Non tendere o piegare i Cryohose per collegarli al modulo S3. Ciò può causare 
delle perdite. Lasciare che ci sia gioco sufficiente.

 ATTENZIONE
Applicare una controcoppia adeguata quando si serrano gli elementi di 
raccordo di Cryopilot A per evitare che si danneggi l’interno della tubazione.
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	t Collocare il modulo S3 sul Cryomixer Jr. come mostrato nella figura 7 in 
modo che il movimento del Cryomixer Jr. consenta di miscelare 
sull’intera lunghezza di un Celsius® Pak.

Pos. Descrizione

1 Outlet Port

2 Inlet Port

3 Mounting Knobs

	t Fissare il modulo S3 alla piastra del Cryomixer Jr. serrando i quattro 
pomelli di fissaggio sul fondo del modulo.  

	t Infilare due Cryowrap su ciascun tubo.

NOTA
I raccordi a disinnesto rapido sono assemblati in fabbrica sul S3 e sui tubi. Se 
è necessario scollegare e ricollegare le connessioni con filettature coniche, 
usare un sigillante per filettature come Loctite 567.

Modulo S3 Cryopilot A

Adattatore Elemento di
raccordo M16x1

Elemento di
raccordo M24x1,5

Elemento di
raccordo M16x1

Raccordo 
femmina ⅜”
Raccordo rapido

Raccordo 
maschio ⅜”
Raccordo rapido

Tubo 
coibentato
1,5 m

Adattatore

Fig. 8:  Installazione di Cryowedge per il modulo S3

	t Collegare il raccordo “Thermofluid out” del Cryopilot A al raccordo di 
ingresso del modulo S3. Dei due raccordi a disinnesto rapido presenti sul 
S3, il raccordo di ingresso è quello in basso. 

	t Collegare il raccordo “Thermofluid in” del Cryopilot A al raccordo di 
uscita del modulo S3. Dei due raccordi a disinnesto rapido presenti sul S3, 
il raccordo di uscita è quello in alto.

	t Verificare che tutti i tubi siano connessi correttamente.

1
2

3

Fig. 7:  Posizionamento del Modulo S3
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4.6	 Installazione di Cryopilot A

 AVVISO
Tutti i collegamenti elettrici devono essere eseguiti da un elettricista 
qualificato.

	t Verificare che l’interruttore di alimentazione principale di Cryopilot A sia 
nella posizione “OFF” o “0”. L’interruttore è rosso e giallo e si trova sul 
retro del Cryopilot A come mostrato nella figura 9.

	t Rivolgersi a un elettricista qualificato per installare una spina (non 
fornita) sul cavo di alimentazione del Cryopilot A. La spina deve 
corrispondere alla presa elettrica ed essere conforme alla tensione e alla 
corrente della rete elettrica. Si rimanda al capitolo “3 Componenti del 
sistema”, pagina 146 per le specifiche dell’alimentazione elettrica.

	t Collegare l’apparecchio Cryopilot A all’alimentazione elettrica. 
	t Girare l’interruttore di alimentazione principale di Cryopilot A nella 

posizione “ON”.
	t Verificare che tutti i LED s’illuminino brevemente e che il display LCD 

rettangolare sia illuminato. Se ciò non accade, controllare che ci sia 
alimentazione elettrica sull’apparecchio Cryopilot A. Se c’è 
alimentazione elettrica sul Cryopilot A, ma il controller non si accende, si 
prega di contattare il Servizio Clienti (vedi pagina 184). 

4.7	 Riempimento con il fluido di scambio 
termico

Si consiglia di predisporre circa 19 litri di fluido di scambio termico per 
l’installazione del sistema benchtop. Come fluido viene usato il Dow 
Syltherm HF, poiché presenta un basso punto di congelamento e una bassa 
viscosità su un ampio campo di temperatura. Per maggiori informazioni si 
rimanda alla scheda tecnica sulla sicurezza del materiale Dow Syltherm HF.

NOTA 
Dow Syltherm HF è l’unico fluido di scambio termico autorizzato ad essere 
usato in questo sistema.

Fig. 9:  Interruttore di alimentazione principale di 
Cryopilot A
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	t Assicurarsi che la valvola di scarico sia chiusa girandola in senso orario 
nella posizione verticale e chiudendo la vite di tenuta che si trova in 
basso sul lato del Cryopilot A come mostrato nella figura 10.

1 2 3

Fig. 10:  Valvola di scarico del fluido di scambio termico e viti di tenuta di Cryopilot A

Pos. Descrizione

1 Vite di tenuta del raccordo di scarico principale
Valvola di scarico fluido scambio termico

2 Valvola di scarico fluido scambio termico

3 Vetro spia Vite di tenuta scarico
Valvola di scarico fluido scambio termico

	t Togliere il tappo del raccordo di riempimento che si trova sulla parte 
superiore del Cryopilot A, dietro il vetro spia.

	t Alzare il contenitore di Syltherm HF sopra al Cryopilot A.
	t Inserire l’estremità del tubo del sifone di sicurezza nel Cryopilot A e l’e-

stremità della valvola nel contenitore di Syltherm HF. Immergere l’estre-
mità della valvola rossa nel Syltherm HF e muoverla su e giù per avviare il 
sifone. Per arrestare il flusso del fluido di scambio termico, estrarre l’e-
stremità della valvola rossa dal Syltherm HF. Riempire l’apparecchio 
Cryopilot A fino a raggiungere la tacca di 2 litri sul vetro spia.  

	t Avviare uno spurgo manuale dell’aria (premere Start, Start air purge, 30s 
interval, OK). Aggiungere ancora del fluido di scambio termico fino a 
quando il livello del vetro spia si stabilizza a 2 litri. 

	t Verificare che non ci siano delle perdite nelle connessioni dei tubi.
	t Arrestare la pompa (premere Stop, Air purge off).
	t Fissare i Cryowrap sopra le superfici metalliche scoperte su ciascuna 

estremità dei due tubi.
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4.8	 Installazione di Cryomixer Jr.
	t Collegare il Cryomixer Jr. all’alimentazione elettrica.
	t Mettere il pulsante di comando manuale del pannello frontale del 

Cryomixer Jr. nella posizione “O”.
	t Mettere il pulsante Manuale|Automatico che si trova sul retro del 

Cryomixer Jr. nella posizione manuale (giù) come mostrato nella figura 11.
	t Girare il pulsante della velocità completamente in senso orario 

(0 giri/ min).
	t Girare il pulsante di comando manuale nella posizione “I”.
	t Girare lentamente il pulsante della velocità in senso orario fino a raggiun-

gere il numero di giri al minuto corretti e registrare il numero di giri visua-
lizzato sul display LCD del Cryomixer Jr. Le impostazioni standard sono le 
seguenti:

	— Cryowedge CW20 e CW125: 45 giri/min.
	— Cryowedge CW300 (30”) e CW300 (34”): 35 giri/min.
	— Modulo S3: 120 giri/min.

NOTA 
Le impostazioni della velocità del miscelatore possono variare secondo le 
caratteristiche del prodotto del cliente. Contattare Sartorius se si vogliono 
eseguire delle modifiche rispetto a quelle consigliate sopra.

	t Mettere il pulsante Manuale|Automatico che si trova sul retro del 
Cryomixer Jr. nella posizione automatica (su).

4.9	 Installazione del computer
	t Collegare il computer e il display all’alimentazione elettrica. Si consiglia 

di usare un dispositivo di protezione contro le sovratensioni (non fornito).
	t Accendere il computer e il display. Rispondere alle domande nelle 

finestre di dialogo di configurazione Windows “Primo avvio”. Forse è 
necessario richiedere alcune informazioni presso il vostro servizio 
informatico.

 ATTENZIONE
Sui computer acquistati presso Sartorius non è installato un software 
antivirus. Si consiglia di installare un software antivirus secondo le linee 
guida della vostra azienda.

Fig. 11:  Retro del Cryomixer Jr.
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4.10	 Installazione del dispositivo di acquisizione 
dati

	t Collegare il National Instruments USB-9213 al computer con un cavo 
USB.

	t Collegare un’estremità del cavo USB verso Cryomixer Jr. alla presa posta 
sul retro del Cryomixer Jr. Inserire l’altra estremità in una porta USB del 
computer.

	t Per i moduli S3: inserire il gruppo di connettori maschi delle termocoppie 
del modulo S3 nel cavo breakout delle termocoppie. Inserire il connet
tore 1 nella presa 1, connettore 2 nella presa 2, e così via. Inserire le ter-
mocoppie Celsius® Pak nella striscia di prese che si trova nell’area della 
copertura del S3. 

	t Collegare un’estremità del cavo USB verso Unistat alla porta USB del 
computer e l’altra estremità alla porta seriale posta sotto la ComBox 
come mostrato in figura 12. La ComBox si trova sul retro del Cryopilot A. 

Fig. 12:  Porta seriale Cryopilot A
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5	 Software Cryopilot 

5.1	 Visione d’insieme
Il sistema benchtop è comandato e controllato per mezzo del software 
Cryopilot che è un’applicazione grafica per computer con sistema operativo 
Microsoft Windows. Il software Cryopilot permette agli utenti di eseguire 
con flessibilità le operazioni di congelamento e scongelamento.

Il diagramma sottostante mostra le relazioni tra i componenti del sistema. Le 
interfacce software Cryopilot sono collegate mediante USB al refrigeratore  
Cryopilot A e all’agitatore Cryomixer Jr., nonché fino ad un numero di 16 
termocoppie mediante un dispositivo di acquisizione dati National 
Instruments.

Fig. 13:   Sistema Cryopilot

5.2	 Requisiti minimi del sistema
Il software Cryopilot è installato in fabbrica sui computer ordinati presso 
Sartorius come parte di un sistema benchtop. Altrimenti è disponibile su 
USB Flash Drive per i sistemi che soddisfano i seguenti requisiti: 

	— Sistema operativo: Microsoft Windows 7 Professional, 32 bit con Service 
Pack 1 o Microsoft Windows 10 Professional, 64 bit.  

	— Dispositivo di acquisizione dati: National Instruments USB-9213.  

Il software Cryopilot è dotato di un programma di installazione che installa 
automaticamente il software Cryopilot e tutti i driver di terzi necessari sul 
vostro computer. Per installare Cryopilot è necessario avere diritti di 
amministratore. 
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5.3	 Componenti
Il software Cryopilot è installato di default in C:\Program Files\Sartorius 
Stedim Biotech\Cryopilot 5 per uno sistema operativo di 32-bit e in C:\
Program Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 per uno sistema 
operativo di 64-bit. ,che sarà denominato in seguito directory di 
installazione. Nella tabella sottostante sono descritti i file e le cartelle 
contenuti nella directory di installazione:

Componente Descrizione

Profiles/ Directory per file dei profili standard 
forniti con Cryopilot

BouncyCastle.Crypto.dll Biblioteca di supporto

Cryopilot .chm File di aiuto

Cryopilot .exe File eseguibile per il software 
Cryopilot. Collegamenti (shortcuts) 
per questo file si trovano sul desktop 
e nel menu di avvio

Cryopilot .exe.config File di configurazione

ICSharpCode.SharpZipLib.dll Biblioteca di supporto

libftdi.dll Biblioteca di supporto

log4net.dll Biblioteca di supporto

NationalInstruments.Common.dll Biblioteca di supporto

Add NationalInstruments.
NiLmClientDLL.dll 

Biblioteca di supporto

Add NationalInstruments.
MStudioCLM.dll 

Biblioteca di supporto

NationalInstruments.DAQmx.dll Biblioteca di supporto

NPlot.dll Biblioteca di supporto

unins000.dat �File di aiuto del programma di 
disinstallazione

unins000.exe Programma di disinstallazione

Oltre ai file nella directory di installazione, il programma di installazione 
Cryopilot crea una cartella chiamata “Cryopilot” nella cartella “My 
Documents” di ciascun utente. Questa cartella sarà denominata in seguito 
“directory utente”. Nella tabella sottostante sono descritti i file e le cartelle 
contenuti della directory utente:

Componente Descrizione

Data/ �Directory di default per i file di dati salvati dagli utenti. 
Gli utenti possono scegliere di salvare i file in un’altra 
posizione sul computer o su un’unità di rete.

Custom 
Profiles/

�Directory di default per profili personalizzati salvati dagli 
utenti. Gli utenti possono scegliere di salvare i file in 
un’altra posizione sul computer o su un’unità di rete.

please check this sentence!
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I file che sono soggetti a modifiche ma che sono comuni a tutti gli utenti 
sono salvati in C:\ProgramData\Sartorius Stedim Biotech\Cryopilot 5. 

Componente Descrizione

log.txt File usato per la risoluzione degli errori del software

settings.xml File di configurazione

Il programma di installazione Cryopilot installa inoltre diverse biblioteche 
aggiuntive: Microsoft .NET Framework 4.6.1, National Instruments 
NI-DAQmx e driver USB. 

5.4	 Installazione
Per installare il software Cryopilot, inserire il USB Flash Drive e cliccare due 
volte sul file mysetup.exe. Per il setup è necessario avere i diritti di 
amministratore. Contattare il proprio amministratore di sistema se non 
avete i diritti richiesti.

Le impostazioni di default sono in genere perfettamente adeguate.  

Una volta terminato il setup, vi sarà richiesto di riavviare il computer.

NOTA
È importante che il computer venga configurato in modo che non si arresti o 
non si spenga durante un processo di congelamento | scongelamento.  

Per Windows 7 o Windows 10, accedere a Pannello di controllo > Sistema e 
sicurezza > Opzioni risparmio energia. Selezionare “Prestazioni elevate”. 
Cliccare su “Modifica impostazioni combinazione”, poi su “Cambia imposta-
zioni avanzate risparmio energia”.  Impostare “Disco rigido > Disattiva disco 
rigido dopo” su 0 (mai). Impostare “Impostazioni USB > Impostazione 
sospensione selettiva USB” su “Disabilitata”. Cliccare su “OK” e chiudere la 
finestra Pannello di controllo. 
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5.5	 Interfaccia utente

5.5.1	 Finestra principale
La finestra principale è la schermata primaria usata nel software Cryopilot. 
Questa finestra contiene le voci di menu per interagire con il programma, un 
grafico per visualizzare graficamente i dati di processo e una legenda per 
selezionare le tracce da visualizzare sul grafico.

6

1
2
3

4

5

7

8

9

Fig. 14:  Finestra principale

Pos. Controllo Descrizione

1 Barra del titolo �Visualizza il nome dell’applicazione e il nome 
del file di dati attuale, se disponibile

2 Barra dei menu Contiene i menu per eseguire attività comuni

3 Barra degli 
strumenti

Contiene i pulsanti per eseguire attività 
comuni

4 Grafico Visualizza un tracciato della temperatura in 
relazione al tempo trascorso

5 Barra di stato Mostra lo stato degli apparecchi sia online 
che offline

6 ��Indicatore del 
tempo trascorso

Mostra il tempo trascorso a partire dall’avvio 
del processo

7 Elemento legenda 
“HTF Setpoint”

Visualizza il valore nominale del fluido di 
scambio termico (HTF)

8 Elemento legenda 
“HTF Supply”

Visualizza la temperatura reale del fluido di 
scambio termico

9 Elemento legenda 
“Product N”

Visualizza la temperatura della termocoppia 
di tipo T. A seconda dell’hardware è possibile 
monitorare fino a 16 termocoppie
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5.5.2	 Finestra di dialogo “Start Process”
La finestra di dialogo “Start Process” richiede all’utente di inserire le 
informazioni che saranno usate nel corso del processo.

6

1

2

3

4

5

7

8

9

1011

Fig. 15:  Finestra di dialogo “Start Process”

Pos. Controllo Descrizione

1 Chart title �Il titolo mostrato in cima al grafico. Il titolo di 
default è “Temperature vs. Elapsed Time” 
(Temperatura in funzione del tempo trascorso)

2 Data filename �Il nome completo del file in cui vengono salvati i 
dati per questo processo. Il nome di default è 
[User Directory]\Data\[date code].cpd, dove 
[date code] è una stringa numerica costituita da 
anno, mese, giorno, ora, minuto e secondo. 

3 Selettore “Profile 
type”

�Offre tre opzioni: “None” per nessun profilo; 
“Standard” per un profilo standard fornito da 
Sartorius, “Custom” per un profilo fornito 
dall’utente. 

4 Profile filename Il nome completo del file in cui si trova il profilo 
definito dall’utente

5 Description Un campo per inserire informazioni aggiuntive 
relative al processo.
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Pos. Controllo Descrizione

6 Selettore “Data 
filename”

Apre una finestra di dialogo per selezionare una 
cartella e un nome di file in cui vengono salvati 
i dati per questo processo.

7 Selettore 
“Application”

�Offre sei opzioni se è stato selezionato il tipo di 
profilo “Standard”: 

	— S³ 30mL – er sistemi S3 con dieci Celsius® Pak 
da 30 mL Celsius® Paks

	— S³ 100mL – per sistemi S3 con dieci 
Celsius®- Pak da 100 mL

	— Cryowedge 12” 
	— Cryowedge 24” 
	— Cryowedge 30”
	— Cryowedge 34”

8 Selettore 
“Process”

Offre tre opzioni se è stato selezionato il tipo di 
profilo “Standard”:

	— Freeze – esegue solo l’operazione di 
congelamento

	— Thaw – esegue solo l’operazione di 
scongelamento

	— Freeze and Thaw – esegue l’operazione di 
congelamento seguita dall’operazione di 
scongelamento

9 Selettore “Profile 
filename”

Apre una finestra di dialogo per selezionare una 
cartella e un nome di file in cui si trova il profilo 
definito dall’utente.

10 Pulsante “Cancel” Ignora le informazioni e chiude la finestra di 
dialogo senza avviare il processo.

11 Pulsante “OK” Accetta le informazioni, chiude la finestra di 
dialogo e avvia il processo.
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5.5.3	 Finestra di dialogo “Options”
Il software Cryopilot può essere configurato usando la finestra di dialogo 
“Cryopilot Configuration”. Selezionare nella finestra principale la voce di 
menu “Tools > Options”.

1

6532 4

7

Fig. 16:  Finestra di dialogo “Options” – Scheda “Certificates”

Pos. Controllo Descrizione

1 Elenco dei 
certificati

�Visualizza un elenco dei certificati digitali 
disponibili. Per ciascun certificato nell’elenco è 
indicato chi ha emesso il certificato, per chi è stato 
emesso, il nome descrittivo e la data di scadenza.

2 Pulsante 
“Create”

�Crea un nuovo certificato autofirmato e lo installa 
nella cartella “Trusted Root Certification 
Authorities”. 

3 Pulsante “View” Visualizza ulteriori dettagli del certificato 
selezionato.

4 Pulsante 
“Manage”

�Apre la Microsoft Management Console per 
ulteriori attività di gestione dei certificati, come il 
rinnovo e l’eliminazione del certificati.

5 Pulsante “OK” Accetta le modifiche e chiude la finestra di dialogo.

6 Pulsante 
“Cancel”

Elimina le modifiche e chiude la finestra di dialogo.

7 Scheda 
“Hardware”

Visualizza la scheda dell’hardware.
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1

65

7

2

3

4

Fig. 17:  Finestra di dialogo “Options” – Scheda “Hardware”

Pos. Controllo Descrizione

1 Selettore 
“Data
acquisition 
device”

L’opzione “None” configura l’applicazione per 
“No data acquisition” (Nessuna acquisizione dati). 
Se viene rilevato un dispositivo di acquisizione dati 
National Instruments compatibile, esso viene 
selezionato automaticamente.

2 Selettore 
“Chiller”

�Selezionando l’opzione “None” si configura l’appli-
cazione per “No chiller” (Nessun refrigeratore). 
Selezionando l’opzione “Huber Unistat” si confi-
gura l’applicazione per acquisire i dati da un refri-
geratore Huber dotato di un controller Unistat, 
come un Cryopilot A.

3 Selettore 
“COM port”

Mostra un elenco delle porte seriali (COM) 
disponibili.

4 Selettore 
“Shaker”

�L’opzione “None” configura l’applicazione per 
“No shaker” (Nessun agitatore). Se viene rilevato 
un cavo USB verso Cryomixer Jr., esso viene 
selezionato automaticamente.

5 Pulsante “OK” Accetta le modifiche e chiude la finestra di dialogo.

6 Pulsante 
“Cancel”

Elimina le modifiche e chiude la finestra di dialogo.

7 Scheda 
“Certificates”

Visualizza la scheda dei certificati.
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5.6	 Attività iniziali
Prima di poter avviare un profilo, si deve configurare il software. Verificare 
che il dispositivo di acquisizione dati (DAQ) e il refrigeratore siano connessi 
e accesi. Poi selezionare la voce di menu “Tools > Options” per visualizzare la 
finestra di dialogo “Options”.

5.6.1	 Selezione di un certificato digitale
Per prima cosa si deve selezionare un certificato digitale. Cryopilot usa un 
certificato digitale per garantire l’autenticità e l’integrità dei file di dati 
salvati. La scheda dei certificati mostra un elenco dei certificati disponibili. Si 
consiglia di usare un certificato emesso da una Autorità Certificativa (CA) di 
fiducia. Se il vostro servizio informatico ha già creato un’infrastruttura di 
certificati digitali, può quindi fornire un certificato da usare con il Cryopilot. 

Nel caso in cui non siate in possesso di un certificato da usare con il 
Cryopilot, potete creare un cosiddetto certificato autofirmato. 
“Autofirmato” significa che la persona che crea il certificato ne garantisce 
anche la legittimità. Cliccare sul pulsante “Create” e poi nella finestra di 
dialogo che appare cliccare sul pulsante “Yes”. Il nuovo certificato creato 
apparirà nell’elenco dei certificati disponibili.

5.6.2	 Configurazione dell’hardware
Si deve poi selezionare l’hardware. La scheda “Hardware” contiene le 
impostazioni per le configurazioni hardware comuni. La combinazione più 
comune è costituita da un dispositivo di acquisizione dati (DAQ), un 
refrigeratore e un agitatore. Nella maggioranza dei casi l’hardware viene 
riconosciuto automaticamente.

Se non s’intende eseguire alcun processo e si vuole usare il Cryopilot solo 
per la revisione dei file di dati, selezionare in tal caso “None” per tutti i campi 
“Data Acquisition”, “Chiller” e “Shaker”.

Cliccare su “OK” per salvare le opzioni. 

5.6.3	 Flusso del programma
Dopo l’avvio del software Cryopilot appare brevemente la schermata iniziale 
e poi viene visualizzata la finestra principale.  

A questo punto il software è inattivo e rimane in questo stato fino a quando 
un utente non avvia un processo.

Per avviare un processo, selezionare la voce “Process > Start” o cliccare sul 
pulsante “Start Process” nella barra degli strumenti. Apparirà la finestra di 
dialogo “Start Process”. Dopo che l’utente ha cliccato su “OK”, il software 
cerca di instaurare una connessione con il dispositivo di acquisizione dati, 
l’agitatore e il refrigeratore, se sono configurati. Se uno di questi apparecchi 
è configurato ma non ancora collegato, all’utente verrà chiesto di 
controllare le connessioni e di eseguire di nuovo l’operazione o di annullarla.

Una volta che un processo è stato avviato, il grafico della temperatura e la 
legenda vengono riconfigurati allo scopo di visualizzare i tracciati 
corrispondenti, le comunicazioni con il refrigeratore vengono instaurate e il 
dispositivo di acquisizione dati (DAQ) viene inizializzato. Terminata 
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l’inizializzazione, scompare il messaggio di inizializzazione e viene tracciato il 
primo gruppo di punti dati. I punti dati successivi sono visualizzati in 
funzione dell’intervallo di campionamento che è fissato a 15 secondi.

Se è stato configurato per l’uso di un refrigeratore, il software Cryopilot 
utilizza un link seriale per inviare comandi e ricevere risposte al e dal 
refrigeratore.

Durante il processo lo stato della connessione è mostrato nell’angolo in 
basso a sinistra della finestra principale. Un messaggio verde “Online” indica 
che la connessione con il dispositivo di acquisizione dati e il refrigeratore è 
corretta. Un messaggio rosso “Offline” indica che c’è un problema di 
connessione. 

Con il pulsante “Stop Process” si può interrompere l’acquisizione dei dati e 
spegnere il refrigeratore e il miscelatore. In seguito l’utente può revisionare i 
dati. Prima di poter avviare un altro processo, l’utente deve chiudere il file di 
dati.

5.6.4	 Revisione dei dati
Cryopilot può aprire e visualizzare i file salvati in Cryopilot 4 e Cryopilot 5. 
Considerare che i file creati da Cryopilot 4 sono supportati solo per scopi di 
revisione. Tutti i nuovi file di dati sono salvati nel formato Cryopilot 5 in 
modo che l’integrità e l’autenticità dei dati possa essere verificata mediante 
firma digitale.

Si può aprire solo un file di dati alla volta.

Per aprire un file di dati procedere come segue:
	t Cliccare sul pulsante “Open” nella barra degli strumenti
	t Aprire il menu “File” e cliccare su “Open”
	t Usare la combinazione di tasti Ctrl+O

Usare la finestra di dialogo “Open Data File” per selezionare il file che si 
desidera aprire. Accertarsi di selezionare il tipo di file nell’elenco a discesa 
“Files of type”. 

Cryopilot 5 usa firme digitali per comprovare che i dati non sono stati 
modificati dal momento in cui sono stati salvati. Se l’integrità e l’autenticità 
del file di dati non possono essere verificate mediante una firma digitale, 
appare un messaggio che richiede di continuare o annullare l’operazione. 
Ci sono due casi in cui compare questo messaggio:

	— Quando si apre un file di dati Cryopilot 4. I file Cryopilot 4 non 
contengono una firma digitale.

	— Se il certificato usato per firmare il file di dati non è affidabile. 

Una volta che il file di dati è caricato, il grafico viene popolato con i dati del 
file ed è possibile analizzare i dati come se provenissero da un processo 
realmente in corso.

Cliccando sul grafico con il tasto destro del mouse e cliccando sulla voce 
“Review”, si può scorrere a destra e a sinistra del grafico per verificare i valori 
di ciascun tracciato in un determinato momento. Quando si scorre la linea di 
revisione a destra o a sinistra, la legenda viene aggiornata per mostrare 
l’indicatore temporale e i valori del tracciato per quel momento specifico.
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5.6.5	 Utilizzo del grafico
Il grafico permette di rappresentare la temperatura di un ciclo in relazione al 
tempo trascorso. Il tempo trascorso è visualizzato in ore sull’asse X e la 
temperatura è visualizzata in gradi Celsius sull’asse Y. È disponibile una 
legenda per identificare e mostrare il valore corrente per ciascun tracciato.  

Panoramica e zoom

Per impostazione predefinita, le scale del grafico vengono adattate 
automaticamente ai dati disponibili. Questa funzione di messa in scala 
automatica può essere attivata o disattivata usando le opzioni “Auto Scale 
X” e “Autoscale Y” nel menu pop-up che appare cliccando sul grafico con il 
tasto destro del mouse. 

La dimensione della scala può essere modificata direttamente trascinando 
gli assi X e Y. Per fare una panoramica del grafico, trascinare il grafico 
tenendo premuto il tasto sinistro del mouse. Quando si modifica la scala o si 
fa una panoramica del grafico, la funzione “Auto Scale” viene disattivata. 
Cliccare due volte sul grafico per riattivare la funzione “Auto Scale”.

Legenda

La legenda identifica ogni tracciato presente sul grafico. Ciascun tracciato 
ha una propria legenda indicante il nome, il colore, le unità e il valore cor-
rente. Per nascondere un tracciato, cliccare due volte sulla sua legenda; essa 
sarà visualizzata in grigio. Per mostrare un tracciato, ricliccare due volte sulla 
sua legenda. Ciò può essere utile quando si analizzano file di dati con molti 
tracciati che si sovrappongono.

Modo “Review”

Il modo “Review” permette all’utente di revisionare i dati in ogni momento 
durante il processo. Questo modo viene attivato e disattivato usando il 
menu pop-up mostrato nella figura 18. Quando si è nel modo “Review”, una 
linea verticale è visualizzata sul grafico e le voci tempo trascorso e legenda 
visualizzano i valori che corrispondono a questa posizione sul grafico.  

5.6.6	 Esportazione dei dati
Cryopilot offre due metodi differenti per esportare i dati. Si può esportare 
un’immagine della rappresentazione attuale del grafico o si può esportare i 
dati grezzi per visualizzarli in un’applicazione foglio di calcolo.

Esportazione del grafico

Per esportare il grafico, selezionare la voce di menu “Edit > Copy > Chart”. Il 
grafico viene copiato come immagine bitmap negli Appunti di Windows. Il 
grafico può essere incollato in altre applicazioni selezionando “Edit>Paste” o 
premendo i tasti Ctrl+V. Questa opzione è utile quando si ha bisogno di 
un’istantanea rapida dei dati, per esempio in una presentazione con slide. 
Usare l’opzione “Copy>Data” se i dati devono essere analizzati 
ulteriormente.

Fig. 18:  Menu pop-up del grafico
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Esportazione dei dati

Per esportare dati, selezionare la voce di menu “Edit > Copy > Data”. I dati 
grezzi vengono copiati in un formato delimitato da tabulazione negli 
Appunti di Windows. I dati possono essere incollati in applicazioni foglio di 
calcolo come Microsoft Excel o OpenOffice Calc selezionando la cella di 
destinazione e selezionando “Edit>Paste” o premendo i tasti Ctrl+V.

5.6.7	 Stampa
Cryopilot può creare un report per il file di dati aperto. Il report è un’istanta-
nea (snapshot) della rappresentazione attuale del grafico comprensivo di 
titolo e legenda. Il report può essere visualizzato come anteprima o inviato 
ad una stampante. Se sul computer è installato un driver di stampante PDF 
come Adobe Acrobat, si può salvare il report come File PDF sul disco rigido.

Per stampare un report procedere come segue:
	t Cliccare sul pulsante “Print” nella barra degli strumenti 
	t Aprire il menu “File” e cliccare su “Print”
	t Usare la combinazione di tasti Ctrl+P

Appare la finestra di dialogo “Print” che richiede di selezionare la stampante 
di destinazione e il numero di copie. Altre impostazioni come i margini e il 
formato della carta possono essere configurate in “Page Setup”. Cliccare su 
“OK” per inviare il report alla stampante selezionata.

5.6.8	 Profili
Il software Cryopilot controlla il refrigeratore e il miscelatore seguendo un 
profilo. Un profilo è una ricetta contente istruzioni per modificare il valore 
nominale della temperatura del refrigeratore e il valore nominale del modo 
del miscelatore (on|off) come una funzione del tempo. Il software Cryopilot 
viene fornito con un set di profili standard che sono adatti per molte 
applicazioni con il modulo S3 e il Cryowedge. 

Potrebbe essere necessario creare un nuovo profilo per rispondere ad 
un’applicazione specifica. Durante la creazione di un nuovo profilo ci sono 
diversi fattori da considerare:

	— Quali operazioni si devono eseguire – congelamento, scongelamento o 
entrambe?

	— Sono richiesti cicli di congelamento e scongelamento multipli?
	— Qual è la temperatura iniziale del materiale da congelare o scongelare? 

Se questa è variabile, una fase di equilibratura all’avvio del profilo può 
migliorare la riproducibilità.

	— Gli apparecchi devono rimanere in funzione o venire spenti al termine 
dell’operazione di congelamento o scongelamento?

La regolazione dei tassi di congelamento e scongelamento viene eseguita 
empiricamente. Se si desidera avere un punto finale più basso per 
un’operazione di congelamento, potrebbe essere necessario aumentare la 
durata del valore nominale finale o ridurre la temperatura impostata. Se si 
vuole scongelare velocemente senza superamento della temperatura target 
(overshoot), usare per una breve durata un valore nominale di temperatura 
più alto e poi abbassarlo prima che la temperatura target venga superata.

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   170_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   170 01.04.2022   09:52:4201.04.2022   09:52:42



		  Manuale d’uso Celsius® S3 Benchtop System	 171

		  Software Cryopilot 	

Modifica di un profilo

I profili possono essere creati e modificati manualmente con editor di testo 
(per es. Microsoft Notepad) o programmi foglio di calcolo (per es. Microsoft 
Excel). Quando si usa un editor di testo, utilizzare sempre un tasto TAB per 
separare le colonne; non usare la barra spaziatrice. Per una nuova riga, usare 
il tasto Ritorno o Invio dopo aver inserito lo stato del miscelatore.

Se si usa un profilo standard come punto di partenza, accertarsi di salvarlo 
con un nuovo nome di file e poi effettuare le modifiche. 

Comportamento dell’ultima fase

Per impostazione predefinita, una volta che il software Cryopilot esegue 
l’ultima fase di un profilo, esso lascia il refrigeratore e il miscelatore nello 
stato in cui si trovano fino a quando l’utente non arresta il profilo premendo 
il pulsante “STOP”. In alcuni casi è utile spegnere il refrigeratore e il 
miscelatore dopo un certo tempo. Ciò si stabilisce impostando un’istruzione 
“TURN CHILLER OFF” dopo l’istruzione “STOP”. Osservare che ciò non è 
possibile usando l’editor di profili Cryopilot, ma deve essere fatto 
manualmente con un editor di testo o un’applicazione foglio di calcolo. Per 
esempio, il profilo seguente spegnerà il refrigeratore e il miscelatore dopo 
311 minuti:

0	 –40	 OFF
310.00	 –60	 OFF
STOP
311.00	 TURN CHILLER OFF

L’istruzione “TURN CHILLER OFF” sarà visibile nell’editor di profili 
Cryopilot, ma a questa non sarà associata alcuna temperatura.

Formato dei file

I profili sono salvati sul disco rigido come file di dati delimitati da 
tabulazione. La codifica caratteri è ASCII e il formato del file non fa 
distinzione tra maiuscole e minuscole. Tutte le righe che si trovano prima del 
token “START” sono una descrizione del file. Ciò significa che la descrizione 
non può contenere la parola “start”. Tra il token “START” e il token opzionale 
“STOP”, ogni riga rappresenta una fase nel profilo. Il tempo di avvio segnala 
quando la fase dovrebbe iniziare; esso è indicato in minuti trascorsi ed è 
espresso con notazione decimale. Il tempo di avvio della prima fase deve 
essere 0 e i tempi di avvio per le fasi successive devono aumentare in 
maniera monotona. Notare che il tempo di avvio per ciascuna fase si 
riferisce al tempo di avvio del profilo. Pertanto tre fasi di 30 minuti avranno 
dei tempi di avvio di 0, 30 e 60. 
Il valore nominale del refrigeratore è indicato in gradi Celsius ed è espresso 
con notazione decimale. 
Se è presente un token “STOP”, la riga successiva può essere un token 
“TURN CHILLER OFF”. 

Fig. 19:  Un profilo in Microsoft Notepad
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La seguente sintassi viene usata per descrivere il formato del file:
\n	� Carattere di una nuova riga, qui definito come CRLF
\s	 Zero o più caratteri di spazio
\t	 Carattere di tabulazione
<variable>	 Elemento variabile
[FOO]	 Elemento opzionale
OFF|ON	� Valore enumerato, l’elemento deve essere l’uno o l’altro
...	� Indica la struttura che si ripete

Formato:
[<description>\n]
START\s\n
<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n
.
.
.
[STOP\n
[<start time>\tTURN CHILLER OFF]]

Esempio (implicito \n):
Questo è un profilo di prova con tre fasi.
START
0	 –20	 OFF
30	 –60	 ON
200	 10	 OFF

5.6.9	 File di dati
Durante un ciclo, il software Cryopilot monitora i componenti del sistema 
benchtop e registra i valori chiave del processo in un file di dati sul 
computer. 

Il software Cryopilot 5 può aprire sia i file di dati creati da Cryopilot 4 sia i file 
creati da Cryopilot 5. Tuttavia, tutti i nuovi file di dati salvati da Cryopilot 5 
saranno salvati nel formato Cryopilot 5. Questo file di dati contiene i 
seguenti valori di processo:

	— Il valore nominale della temperatura del fluido di scambio termico del 
refrigeratore e la temperatura reale del fluido di scambio termico 

	— Valore nominale del modo del refrigeratore (On|Off)
	— Valore nominale del modo del miscelatore (On|Off) 
	— Temperatura misurata da fino a 14 termocoppie di tipo T 

Per impostazione predefinita, i file di dati Cryopilot 5 hanno l’estensione 
.cpd. Un file di dati Cryopilot è un file ZIP contenente due file:

	— data.txt, che è un file di dati delimitato da tabulazione 
	— data.txt.p7s, che è una firma digitale nel formato PCKS#7 

I programmi foglio di calcolo come Microsoft Excel possono importare i file 
di dati delimitati da tabulazione, tuttavia è più facile trasferire i dati usando 
la voce di menu “File > Copy > Data”. Non tentare di aprire il file di dati per 
un ciclo in corso, poiché l’applicazione foglio di calcolo può bloccare il file 
per impedire che il software Cryopilot scriva dati aggiuntivi nel file.
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Formato del file

Il file data.txt e i risultati del comando “File > Copy > Data” contengono 
entrambi un testo delimitato da tabulazione. La codifica caratteri è ASCII e il 
formato del file non fa distinzione tra maiuscole e minuscole. La prima riga 
deve contenere l’autore e la versione come specificato sotto. Tutti i valori 
della temperatura sono indicati in °C.

La seguente sintassi viene usata per descrivere il formato del file:
\n	 Carattere di una nuova riga, qui definito come CRLF
\s	� Zero o più caratteri di spazio
\t	 Carattere di tabulazione
<variable>	 Elemento variabile
[FOO]	 Elemento opzionale
OFF|ON	 Valore enumerato, l’elemento deve essere l’uno o l’altro
...	� Indica la struttura che si ripete

Osservare che gli orari specificati sono espressi come tempo coordinato 
universale (UTC); pertanto questi possono differire dall’ora locale che 
dipende dal vostro fuso orario.

Se non ci sono dati disponibili, il file contiene il simbolo “NaN”
(Not a Number).

Formato:
Cryopilot 5.0\n
METADATA\n
Title\t<title>\n
Process Start\t<timestamp format=yyyy-MM-dd HH:mm:ssZ>\n
Computer\t<computer name>\n
User\t<user name>\n
Description\t<description>\n
START\n
Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply 
Temperature Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\
tProduct Temperature 1(C)\tProduct Temperature 2(C)\t...Product 
Temperature n(C)\n
<timestamp format=yyyy-MM-dd HH:mm:ssZ>\t<elapsedhours 
format=0.000000>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n
.
.
.
.
.
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Esempio per quattro termocoppie (implicito \n):

Cryopilot 5.0
METADATA
Titolo	 Temperatura in funzione del tempo trascorso
Avvio processo	 2009-03-03 21:49:22Z
Computer	 DEMO_LAPTOP
Utente	 DEMO_LAPTOP\Administrator
Descrizione	
AVVIO
Data/Ora(UTC)	 Tempo trascorso(ore)	 Stato refrigeratore	Valore nominale  
temperatura di alimentazione fluido di scambio termico(C)	 Temperatura di  
alimentazione fluido di scambio termico(C)	 Stato miscelatore	 Temperatura(C) 
prodotto 1	 Temperatura(C) prodotto 2	  Temperatura(C) prodotto 3
Temperatura(C) prodotto 4
2009-03-03 21:49:31Z	 0.002500	 On	 0.0	 21.0	 On	 22.8	 25.4	 NaN	 NaN
2009-03-03 21:49:46Z	 0.006667	 On	 0.0	 20.7	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:01Z	 0.010833	 On	 0.0	 20.3	 On	 22.8	 25.3	 NaN	 NaN
2009-03-03 21:50:16Z	 0.015000	 On	 0.0	 20.0	 On	 22.8	 25.2	 NaN	 NaN
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5.6.10	 Diagnostica | Risoluzione degli errori
I messaggi di errore e di stato sono visualizzati nell’area dei messaggi 
nell’angolo in basso a destra della finestra principale. Questa sezione 
descrive gli errori comuni e i possibili rimedi.

Refrigeratore

Se si verificano dei problemi con il refrigeratore, possono essere utili le 
seguenti soluzioni:
	t Controllare le due estremità del cavo tra il computer e il refrigeratore. 
	t Verificare il registro errori del refrigeratore. Per maggiori informazioni si 

rimanda al manuale d’uso Huber Unistat 705.
	t Verificare che le impostazioni di comunicazione del refrigeratore siano 

configurate correttamente. Il Cryopilot A dovrebbe essere configurato 
per usare una velocità di trasmissione (baud rate) 9600 e il protocollo 
RS232. Per maggiori informazioni si rimanda al manuale d’uso Huber 
Unistat 705.

	t Come ultimo rimedio, chiudere il software Cryopilot, spegnere e 
riaccendere il refrigeratore e riavviare il software Cryopilot. Cercare di 
determinare la causa del problema prima di avviare un altro ciclo. 
Assicurarsi che tutte le impostazioni nella finestra di dialogo “Options” 
siano corrette.

Se durante un ciclo vi è un’interruzione di corrente elettrica, il refrigeratore 
potrebbe scollegarsi dall’alimentazione elettrica o i dati provenienti dal 
refrigeratore potrebbero danneggiarsi. La presenza di NaN (not a number) 
nei campi della temperatura del file di dati è un’ulteriore indicazione che c’è 
un errore a livello del refrigeratore. 

Agitatore

Se l’agitatore non si muove quando dovrebbe, possono essere utili le 
seguenti soluzioni:
	t Controllare il cavo tra il computer e l’agitatore.
	t Verificare che il commutatore dei modi posto sul retro del miscelatore sia 

nella posizione “Auto”.
	t Verificare che l’impostazione della velocità sia corretta.
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Dispositivo di acquisizione dati

Qui di seguito sono elencati i comuni errori relativi all’hardware di 
acquisizione dati o alle termocoppie:

	— Un sensore non risponde alle modifiche della temperatura come gli altri 
sensori.

Se si verifica questo problema, possono essere utili le seguenti soluzioni:
	t Verificare che il sensore in questione sia collegato alla presa corretta del 

cavo breakout della termocoppia che è connesso al dispositivo di 
acquisizione dati. 

	t Accertarsi che ogni sensore sia posizionato e fissato correttamente. Un 
piccolo errore di posizione può comportare grandi scostamenti rispetto 
agli altri sensori. 

	t Controllare le connessioni tra il computer e il dispositivo di acquisizione 
dati.

	t Un sensore potrebbe essere danneggiato. Controllare il sensore con uno 
strumento di misurazione calibrato (per es. Fluke 725) capace di misurare 
le termocoppie di tipo T. 

5.6.11	 CFR Part 11
Il software Cryopilot 5 è stato sviluppato per facilitare la conformità ai 
requisiti 21 CFR Part 11.  

Le firme digitali sono usate per provare l’autenticità e l’integrità dei file di 
dati Cryopilot 5, persino su sistemi aperti (cioè inaffidabili “untrusted”). 

Il termine “firma digitale” non va confuso con il termine “firma elettronica”. 
Una firma digitale è un metodo crittografico, mentre una firma elettronica è 
l’equivalente elettronico di una firma autografa con implicazioni legali. I 
riferimenti alle firme elettroniche in 21 CFR Part 11 non si applicano alle firme 
digitali usate nei file di dati Cryopilot 5.

Alcune indicazioni generali riguardanti l’implementazione:
	— Cryopilot 5 si basa sul sistema operativo per le funzioni di gestione degli 

account, autentificazione e autorizzazione. 
	— L’algoritmo di firma digitale utilizzato da Cryopilot 5 è SHA-1 con RSA; 

esso è scritto nel formato PKCS#7.
	— Il sistema di file è considerato come un sistema inaffidabile. 
	— Se un processo viene arrestato, il file di dati viene chiuso e non è più 

apribile per eseguire delle modifiche. Qualsiasi modifica dei dati con altri 
mezzi, sia accidentale che intenzionale, sarà rilevata dal meccanismo di 
firma digitale.

	— Se i dati vengono esportati da Cryopilot (per es. in un foglio di calcolo), 
la loro autenticità e integrità non possono più essere garantite.
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6	 Funzionamento del sistema

6.1	 Preparazione di un ciclo

6.1.1	 Cryowedge
Per preparare il Cryowedge per l’utilizzo:
	t Togliere la metà superiore della copertura coibentata di Cryowedge.
	t Togliere i dadi ad alette che fissano la copertura trasparente e metterli 

da parte.
	t Togliere la copertura trasparente.
	t Riempire il Cryowedge con una soluzione di prova usando un cilindro I 

volumi standard per ciascuna misura di Cryowedge sono i seguenti:

Misura Cryowedge Volume (mL)

CW20 (12”) 350

CW125 (20”) 650

CW300 (30”) 3000

CW300 (34”) 4000

	t Rimettere la copertura trasparente.
	t Rimettere i dadi ad alette e serrarli a mano. Non stringere 

eccessivamente o non rovinare le filettature.
	t Rimettere la metà superiore della copertura coibentata di Cryowedge.
	t Verificare che il cavo di Cryomixer Jr. sia collegato al Cryomixer Jr. e al 

computer.
	t Verificare che almeno sei termocoppie siano collegate al dispositivo di 

acquisizione dati, partendo dalla posizione 1.
	t Inserire cinque termocoppie attraverso i fori predisposti nella copertura 

trasparente. Fissare le termocoppie sotto la superficie della soluzione di 
prova usando distanziatori di plastica o pezzi di tubo di silicone.

	t Mettere la termocoppia restante sopra la copertura trasparente per 
essere usata come temperatura di riferimento sulla superficie esterna di 
Cryowedge.

	t Annotare il numero e la posizione di ogni termocoppia per riferimento 
futuro.

6.1.2	 Modulo S³
I Celsius® Pak sono forniti presterilizzati con raggi gamma. Essi sono dotati 
di raccordi Luer femmina e di tappi sui 2 raccordi di riempimento | scarico. 
È disponibile anche una versione con tubi di prolunga C-Flex® per il 
riempimento sterile. Tutti i Celsius® Pak dispongono di un pozzetto 
termometrico chiuso in silicone/EVA per l’inserimento di una sonda 
termocoppia. 

Per ottenere risultati coerenti, equipaggiare il modulo S3 sempre con 
lo stesso numero di Celsius® Pak. Assicurarsi che ciascun Celsius® Pak sia 
riempito con lo stesso volume. La termocoppia dovrebbe essere messa ogni 
volta alla stessa profondità.
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I profili di congelamento standard forniti con il software  Cryopilot  sono 
concepiti per 10 Celsius® Pak, sia da 30 o da 100 mL, riempiti fino al volume 
nominale. Mettere le termocoppie ad almeno 1 cm di profondità sotto la 
superficie del liquido di Celsius® Pak. I Celsius® Pak vuoti dovrebbero essere 
riempiti con soluzione tampone. Non usare acqua deionizzata per i 
Celsius® Pak vuoti, poiché questa si sottoraffredda. Se si utilizzano meno di 
10 Celsius® Pak, l’operazione di congelamento è più rapida e il profilo non 
trasferisce direttamente su una scala più ampia.

Procedura passo-passo per preparazione, riempimento e caricamento dei 
Celsius® Pak:
	t Preparare il campione e|o la soluzione tampone per il riempimento dei 

Celsius® Pak.
	t Inserire l’etichetta nel porta etichetta sul fondo di Celsius® Pak. 

Un’etichetta che misura ca. 2 + 5 cm passa completamente nel porta 
etichetta. Per l’etichetta si consiglia di usare materiale e inchiostro 
resistenti all’acqua. Non scrivere sui Celsius® Pak, poiché i solventi usati 
nell’inchiostro possono penetrare nei Celsius® Pak e contaminare il 
prodotto.

Usare una siringa o una pompa peristaltica per riempire i Celsius® Pak con il 
campione o la soluzione tampone attraverso uno dei raccordi di riempi-
mento | scarico. Collegare la siringa o la pompa alla linea opzionale C-Flex® 
mediante un raccordo Luer® maschio o mediante saldatura.

Riempire i Celsius® Pak da 30 mL con un volume massimo di 30 mL e il 
Celsius® Pak da 100 mL con un massimo di 100 mL.

 ATTENZIONE 
Non riempire in eccesso i Celsius® Pak o non svuotare tutta l’aria dalla parte 
superiore dei Celsius® Pak, poiché ciò provoca una dilatazione del campione 
e del ghiaccio nel tubo del raccordo.

Chiudere il tubo di riempimento con il tappo Luer® fornito o con un 
morsetto stringitubo.Prima di avviare un’operazione di congelamento, 
rimuovere l’umidità in eccesso da tutte le superfici del modulo S3

I Celsius® Pak vengono sorretti nel modulo S3 da un meccanismo di 
bloccaggio a molla che tiene fermo il Celsius® Pak e che funge da superficie 
di scambio termico attiva. Eseguire i seguenti passaggi per caricare il 
modulo S3:

	t Fissare il supporto delle termocoppie a Celsius® Pak allineando il rac-
cordo Luer lock femmina che si trova sul supporto con il raccordo Luer 
lock maschio che si trova in cima al pozzetto termometrico. Dopo aver 
fissato il raccordo Luer lock al pozzetto termometrico, il lato frontale del 
supporto della termocoppia deve essere rivolto nella stessa direzione 
dell’etichetta frontale del Celsius® Pak.

	t Misurare 1 cm a partire dalla fine della termocoppia e apporre un segno 
in questo punto per posizionare la termocoppia nel Celsius® Pak. 

	t Svitare lentamente la fascetta di bloccaggio della termocoppia, facendo 
attenzione a conservare i due piccoli O-ring posti all’interno della 
fascetta. Mettere la fascetta di bloccaggio e i due O-ring sopra l’estre-
mità della termocoppia e avvitare il dado di bloccaggio di quel tanto in 
modo che non si stacchi dal supporto della termocoppia.

Fig. 20:  Supporto della termocoppia fissato al 
Celsius® Pak
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	t Abbassare la termocoppia nel pozzetto termometrico. Mai premere 
troppo forte per non perforare l’estremità del pozzetto termometrico. 
Per un controllo termico accurato, mettere sempre le termocoppie a 
1 cm sotto la superficie del liquido nel Celsius® Pak, verificando che il 
segno sulla termocoppia corrisponda alla superficie del liquido. 

	t Serrare la fascetta di bloccaggio per fissare la termocoppia nel pozzetto 
termometrico.

	t Mettersi di fronte alla parte sinistra del modulo S3; inserire un Celsius®- 
Pak tra i meccanismi di serraggio partendo dalla sede (slot) 10 che è la 
sede più distante dalla linea di mandata e ritorno del fluido di scambio 
termico. Aprire il meccanismo mettendo l’utensile di sblocco dei morsetti 
sopra i 2 perni di guida dei 2 blocchi di serraggio in acciaio inox della 
sede e premere in giù.

	t Premendo in giù l’utensile di sblocco dei morsetti, spingere ciascun lato 
del Celsius® Pak verso il basso tra un blocco nero e un blocco di serrag-
gio in acciaio inox del meccanismo di serraggio. Posizionare la parte 
superiore del Celsius® Pak in modo che sia allineata con la parte supe-
riore della barra fissa nera in metallo del meccanismo di serraggio. Fare 
attenzione che il Celsius® Pak deve essere rivolto a sinistra per poter 
essere inserito correttamente nel modulo S3.

	t Rimuovere l’utensile di sblocco dei morsetti. Il Celsius® Pak viene tenuto 
fermo da ogni lato tra due blocchi metallici, uno nero e uno in acciaio 
inox. Collegare i connettori maschi della termocoppia alla striscia di 
prese corrispondente per termocoppie.

Fig. 21:  Termocoppia a 1 cm sotto la superficie 
del liquido

Fig. 22:  Apertura del meccanismo di serraggio

Fig. 23:  Installazione del supporto della 
termocoppia e del Celsius® Pak

_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   179_Manual_Benchtop_Freeze_Thaw_System_S--6004-t210308_85034-538-54.indb   179 01.04.2022   09:52:4301.04.2022   09:52:43



180	 Manuale d’uso Celsius® S3 Benchtop System

	 Funzionamento del sistema

Fig. 24:  Posizionamento di Celsius® Pak e connessione della termocoppia

	t Ripetere questa procedura dalla sede 9 alla sede 1. La figura mostra uno 
schema del posizionamento finale di tutti i Celsius® Pak e delle 
termocoppie.

NOTA 
Ai fini della riproducibilità, caricare il modulo S3 con lo stesso numero di Celsius® 
Pak, riempire ogni Celsius® Pak con la stessa quantità di campione o soluzione 
tampone e mettere le termocoppie nei pozzetti termometrici a 1 cm sotto la 
superficie del liquido. Tutti i profili di congelamento sviluppati da Sartorius 
funzionano correttamente solo se il sistema viene caricato completamente 
(10 Celsius® Pak). Pertanto i risultati ottenuti con i profili di congelamento forniti 
con il software di installazione sono scalabili direttamente su 16,6 litri. 
Modificando il numero di Celsius® Pak si influisce sulla scalabilità di questi 
profili.

	t Fare un diagramma della posizione e del numero di ogni termocoppia in 
un quaderno di laboratorio o conformemente ai regolamenti della vostra 
azienda.

	t Chiudere e bloccare la copertura del modulo S3.

Striscia di prese per termocoppie

Posizione della sede del Celsius® Pak riempito
Ingresso fluido
di scambio
termico

Uscita fluido
di scambio
termico

Fig. 25:  Posizionamento delle termocoppie e dei Celsius® Pak nel modulo S3.
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6.2	 Esecuzione di un profilo

NOTA
Quando il modulo S3 viene scongelato, controllare che i 4 pomelli di 
montaggio del modulo S3 siano serrati e che il modulo sia ben fissato sulla 
piastra del Cryomixer Jr.

 ATTENZIONE
Mai superare un valore di 120 giri al minuto per il Cryomixer Jr.

	t Per inizializzare il software  Cryopilot , cliccare due volte sull’icona 
corrispondente.

	t Selezionare la voce di menu “Process > Start” per visualizzare la finestra 
di dialogo “Start Process”.

	t Dare un nome al file in cui saranno salvati i dati di tempo e temperatura 
per il nuovo processo. 

	t Selezionare il tipo di profilo standard nonché la propria applicazione e 
l’operazione che si intende eseguire (congelamento, scongelamento o 
congelamento e scongelamento). Altrimenti selezionare un profilo 
personalizzato.

	t Cliccare sul pulsante “OK” per avviare il processo.
	t Verificare che il refrigeratore risponda ai comandi del software. 

L’indicatore di stato nell’angolo in basso a sinistra dovrebbe indicare 
“Online”. Ci sarà un ritardo di 2-5 minuti prima che il compressore si avvii 
e che abbia inizio la regolazione della temperatura.

	t Lasciare che il profilo venga eseguito fino allo scadere del tempo 
programmato.

	t Selezionare la voce di menu “Process > Stop” per arrestare il processo. 
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6.3	 Rimozione dei Celsius® Pak congelati dal 
modulo S3

In alcuni casi è opportuno rimuovere i Celsius® Pak dal modulo S3 quando 
sono ancora congelati.

	t Togliere la copertura trasparente del modulo S3. 

NOTA
Se l’apparecchio è stato lasciato aperto per un periodo prolungato 
mantenendolo a bassa temperatura, si forma del gelo sui morsetti, sui 
Celsius® Pak e sui supporti delle termocoppie rendendo più difficile la 
rimozione dei Celsius® Pak. Una volta che l’apparecchio è aperto, togliere 
rapidamente i Celsius® Pak congelati e rimettere la copertura.

	t Rimuovere le termocoppie dai Celsius® Pak. Se una termocoppia non si 
toglie facilmente, girarla delicatamente fino a quando si stacca. 
Rimuovere il supporto della termocoppia da ciascuna sede. Se si forma 
della condensa sulle superfici dei morsetti, si crea un “ponte di ghiaccio” 
tra i supporti delle termocoppie e i blocchi di raffreddamento in metallo 
nero. In tal caso è praticamente impossibile rimuovere i supporti delle 
termocoppie. Togliere l’umidità in eccesso da tutte le superfici prima di 
avviare un’operazione di congelamento. 

	t Rimuovere i Celsius® Pak congelati dal modulo S3 per mezzo dell’utensile 
di sblocco dei morsetti che permette di alzare e togliere i Celsius® Pak. 
Metterli in un contenitore termico per il trasporto.

	t Mettere i Celsius® Pak congelati in un contenitore protettivo e 
conservarli nel freezer alla temperatura desiderata. Se si eseguono test di 
stabilità o studi di formulazione, è preferibile usare un freezer controllato 
con monitoraggio termico.

6.4	 Prelievo dei campioni scongelati dal 
modulo S3

	t Rimuovere le termocoppie e i loro supporti. 
	t Rimuovere i Celsius® Pak congelati dal modulo S3.
	t Girare ciascun Celsius® Pak tre volte per garantire una miscelazione 

omogenea del prodotto.
	t Prelevare la quantità desiderata di campione dal Celsius® Pak mediante il 

raccordo di riempimento|scarico non utilizzato. A tale scopo usare una 
siringa o una pompa, o svuotare per gravità.

	t Smaltire i Celsius® Pak usati. Siccome i Celsius®s-Pak si deformano 
qualche volta durante il congelamento e scongelamento, quando 
vengono riutilizzati non si inseriscono perfettamente tra i meccanismi di 
serraggio. Ciò può prolungare l’operazione di congelamento e 
scongelamento a causa di un basso trasferimento termico.
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7	 Manutenzione del sistema
La manutenzione può essere eseguita dall’utente finale o da Sartorius. 
Contattare il Service di Sartorius per concordare un contratto di 
manutenzione preventiva.

Se si verifica un problema, consultare per prima cosa la sezione relativa ai 
codici di errore nel manuale d’uso di Huber Unistat 705. Se non si è in grado 
di risolvere il problema, rivolgersi al Servizio Clienti (vedi pagina 184).

7.1	 Pulizia
In generale le superfici esposte delle apparecchiature possono essere pulite 
spruzzando e passando un panno con alcol isopropilico. Le superfici in 
acciaio inox possono essere pulite opzionalmente con un prodotto per 
acciaio inox.

Lo scomparto interno del modulo S3 contiene molte parti in alluminio ano-
dizzato che non è compatibile con le soluzioni basiche come idrossido di 
sodio (NaOH) o ossidanti. Questi agenti non devono essere usati per pulire 
lo scomparto interno. Se è necessario eseguirne la pulizia, si consiglia di 
usare alcol isopropilico o altre soluzioni detergenti non ossidanti.

7.2	 Sostituzione del fluido di scambio termico
Sostituire il fluido di scambio termico se si vede che è contaminato con 
acqua o particolato, oppure se si constata una diminuzione dell’efficienza 
di scambio termico (vale a dire quando l’apparecchio non raggiunge o 
mantiene la temperatura nominale). Sostituire sempre l’intera quantità di 
fluido di scambio termico. Se l’efficienza di scambio termico non migliora 
dopo la sostituzione del fluido di scambio termico, rivolgersi al Servizio 
Clienti (vedi pagina 184).

Per sostituire il fluido di scambio termico, procedere come segue:
	t Verificare che la valvola di scarico del fluido di scambio termico del 

sistema posta sulla parte frontale dell’apparecchio sia chiusa. La valvola è 
chiusa quando l’intaglio nel cappuccio della vite è in posizione verticale. 
Vedi “Fig. 10: Valvola di scarico del fluido di scambio termico e viti di 
tenuta di Cryopilot A”, page 156.

	t Togliere la vite di tenuta del tubo in acciaio inox sporgente che si trova a 
sinistra dell’apparecchio e collegare un pezzo di tubazione flessibile 
sull’estremità del tubo. Fissare il pezzo con una fascetta stringitubo.

	t Mettere l’altra estremità della tubazione flessibile in un recipiente che 
può contenere almeno 12 litri di fluido di scambio termico.

	t Aprire la valvola di scarico del fluido di scambio termico girando in senso 
antiorario fino a quando l’intaglio è orientato orizzontalmente.

	t Se possibile, provare a sollevare il Cryowedge o il modulo S3 per far 
defluire il fluido residuo dal modulo di applicazione verso il  Cryopilot  A.

	t Quando il fluido smette di defluire, chiudere la valvola di scarico del 
fluido, togliere la tubazione flessibile dal tubo con vite di tenuta 
e rimettere la vite di tenuta.

	t Riempire il sistema  Cryopilot  A con nuovo fluido di scambio termico 
secondo la procedura descritta nella capitolo “4.7 Riempimento con il 
fluido di scambio termico”, pagina 155.
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8	 Informazioni e istruzioni per 
smaltimento e riparazioni

L’imballaggio non più utilizzato deve essere portato al centro locale di riciclo 
e di smaltimento dei rifiuti. L’imballaggio consiste completamente di mate-
rie non inquinanti, riciclabili come materie prime secondarie. 

L’apparecchio, comprensivo di accessori, pile e batterie ricaricabili, non 
appartiene alla categoria dei rifiuti domestici. La legislazione dell’UE 
prescrive nei propri Stati membri la raccolta separata delle apparecchiature 
elettriche ed elettroniche rispetto ai rifiuti municipali misti ai fini di un loro 
successivo recupero, reimpiego e riciclaggio.

In Germania e in alcuni altri paesi, la Sartorius stessa s’incarica del ritiro e 
dello smaltimento delle proprie apparecchiature elettriche ed elettroniche 
secondo le leggi vigenti. Queste apparecchiature non devono essere 
smaltite insieme ai rifiuti domestici o non devono essere portate ai centri di 
raccolta rifiuti locali – ciò vale anche per i piccoli esercenti.

Per maggiori informazioni sulle possibilità di smaltimento, potete rivolgervi 
in Germania e negli Stati membri dello Spazio economico europeo ai nostri 
addetti del Service locale oppure al nostro Service Center di Goettingen, in 
Germania:

Sartorius Stedim Biotech GmbH 
August-Spindler-Strasse 11 
37079 Goettingen, Germania

Nei Paesi che non fanno parte dello Spazio economico europeo o in cui non 
è presente una filiale, una succursale, un rivenditore o distributore Sartorius, 
rivolgersi alle autorità locali o alle aziende incaricate dello smaltimento. 

Prima dello smaltimento e|o della rottamazione delle apparecchiature, 
togliere le pile e le batterie ricaricabili e trasferirle negli appositi contenitori 
di raccolta.

Le apparecchiature contaminate con sostanze nocive (contaminazione 
NBC) non saranno ritirate dalla Sartorius, dalle sue filiali, succursali e dai 
suoi rivenditori e distributori, né per lavori di riparazione né per lo 
smaltimento. Per maggiori informazioni sulle modalità di riparazione e 
smaltimento del proprio apparecchio ed i relativi indirizzi dei centri di 
Service consultare il manuale allegato oppure visitare il nostro sito Internet 
(www.sartorius.com).

Contatto

Servizio Clienti 24 ore su 24  
+1 866 424 5600  
(numero verde solo per il Nord America)) 
+1 707 747 5614  
(nel resto del mondo)
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Last updated:

The information and figures contained in these 
instructions correspond to the version date 
specified below.
Sartorius reserves the right to make changes 
to the technology, features, specifications and 
design of the equipment without notice.
Masculine or feminine forms are used to 
facilitate legibility in these instructions and 
always simultaneously denote all genders.

Copyright notice:
These instructions, including all components, 
are protected by copyright.
Any use beyond the limits of the copyright law 
is not permitted without our approval.
This applies in particular to reprinting, transla-
tion and editing irrespective of the type of 
media used.
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